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Papyrus - Geffing Started 

Welcome 

Thank you for buying Papyrus Gold, the premier document processor for 
the Atari TOS range of computers. Papyrus (Pa-pie-russ) gives you the 
power and flexibility to create all sorts of attractive documents, from a 
simple memo, through a multi-page brochure up to a complete, 400-page 
novel or manual. Its comprehensive range of features and friendly GEM 
interface make Papyrus (we'll omit the Gold from now on) the essential 
purchase for anyone who works with words, from the casual letter writer 
to the professional journalist and author. 

This chapter explains how to install and run Papyrus. It also explains the 
user interface to familiarise you with the various conventions used and 
there is a general discussion on font systems. 

Please read the remainder of this first chapter before attempting to use 
Papyrus. 

Use of the Manual 

The remainder of this manual is split into, essentially, two parts. 

Firstly, we cover Papyrus from a tutorial point of view, explaining many of 
the features and concepts of the program in a 'hands-on' style. If you are 
new to word processing or simply would like to have an overview of 
Papyrus before using it in anger, we recommend that you read through all 
of these Chapters (up to the !Reference chapter) with an installed Papyrus 
to hand. 

There then follows the Papyrus Reference which details all the menu 
entries and related topics in a technical 'look-up' style. Once you are 
familiar with Papyrus or perhaps if you have used many other word 
processing packages before, you will find this section extremely useful. 

However you use this manual, there is no substitute for experience - do 
not be afraid to play around with Papyrus; experimenting with features is 
the best way to see how they work. 
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System Requirements 

Papyrus will run on the following equipment: 

" Atari ST/STe/TT/Falcon030 

" At least 2Mb of memory 

.. A High resolution monitor 

o Two floppy drives or a high density drive 

More memory and a hard disk are highly recommended, especially if you 
intend to use Papyrus for large or heavily illustrated documents. 

Making a Working Copy 

Before using Papyrus you should make a back-up copy of the distribution 
disks and put the originals away in a secure place; safe from extremes of 
temperature, magnetic fields, moisture and children! The disks can be 
backed-up using the Desktop or any back-up utility - before making any 
backup always write-protect the master to prevent accidental erasure. 

The disks are not copy-protected to allow easy back-up and to avoid 
inconvenience; remember though that the software and this manual are 
protected by international copyright laws and you are only permitted to 
copy the software for your own personal use. If this sounds officious, look 
at it another way - if you give away copies of Papyrus to your friends we 
will not receive enough revenue from the sale of the package to improve 
this and other products. We want to help you, please help us in return. 

Registration Card 

Enclosed with this manual is a registration card which you should fill in 
and return to us in order to register your purchase of Papyrus. This will 
entitle you to a free period of technical support and will enable us to keep 
you informed of future developments to our software. 

For details of our technical support services, please refer to Appendix B in 
this manual. 
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You will need to quote your serial number (to be found on the disk label) 
to obtain technical support and you may find it useful to make a note of it 
here: IUS 'I.oo 

vG/l5 ItJ/v' 'J. M 

I Serial No. 00 31.f 3 C;; 13 ] 

Installing Papyrus 

Papyrus is supplied on several double-sided disks which you should 
backup before attempting to use; do this with the Atari Desktop or with 
your favourite copy program. Papyrus is not copy-protected to allow you 
to keep security copies and to install it quickly and easily. 

You must run the installation program to be found on Disk 1 before you 
can use Papyrus - from your backup of Disk 1, open the disk icon by 
double-clicking on it from the Desktop, then find the PAPINST.PRG 
program and double-click on the icon to launch the installation program. 
Now follow the instructions according to which type of disk system you 
own. 

Installing Papyrus on a Hard Disk 

This section describes how to install Papyrus onto a machine with a hard 
disk; read this section if your machine has a hard disk fitted either 
internally or externally. If you only floppy disks, skip to the next section. 

Papyrus may be used with or without Atari's SpeedoGDOS; if you already 
have Speedo installed on your machine, or you intend to use Papyrus 
without Speedo, you can skip this step, otherwise install SpeedoGDOS 
from your Speedo install disks in the manner described in the 
SpeedoGDOS User's Guide. Once you have successfully done this you are 
ready to start installing Papyrus. 

Insert the disk Papyrus Disk 1 in Drive A, open the disk by double-clicking 
on the Drive A icon, locate the I NST ALL. PRG icon and start it by double
clicking on it. 

The program will first ask you if you wish to install on hard disk 
or floppy disk. You should click on the hard disk button. 
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If you wish to change the default configuration that the program 
has chosen for you, use the various controls on the installation 
screen as described in the help display (obtained by clicking on 
the Help button). 

Click on the OK button to proceed with the installation. You can 
also click on Show to see which files will be copied. 

When prompted to swap disks during installation, just insert the 

r 
r 

requested disk and click on OK. f 
After completion, the installation program will show you the READ. ME 
file containing the latest details about your version of Papyrus; please read 
this! 

You are then ready to run the installed Papyrus by double-clicking on its 
icon (PAPYRUSG. APP) as before; normally this icon will be within another 
folder which you will have to open first (by double-clicking on it). If your 
version of the Desktop supports it, you can also run Papyrus by dropping 
picture files on its icon, or install it as an application which runs 
automatically when an image file is double-clicked. See your computer 
manual for details. 

Installing Papyrus on floppy Disks 

This section describes how to install Papyrus onto a machine with only 
floppy disks; read this section if your machine has no hard disk fitted 
either internally or externally. If you have a hard disk, refer to the 
previous section; a floppy disk set is not designed to work on a machine 
which has a hard disk. 

The floppy install is split into two halves, machines pre-Falcon030 and 
Falcon030; refer to the appropriate part for your machine. 

511 Mega-S1 ISlE IMega-STE IStacy ITT 
The standard Papyrus installation for these machines consists of three 
double-density double-sided disks, which you should have to hand before 
starting the installation process. 

By default, floppy disk installation also formats a standard nOK double
sided disk for you. If you wish to use a different disk format (e.g. 800K) 
then you should format a your floppies prior to running the installer and 
you must use the volume names PAP BOOT, PAPPROG, PAP EXTRA. The 
automatic formatting can be switched off from the installation screen. 
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Papyrus may be used with or without Atari's SpeedoGDOS; if you intend 
to use Papyrus with Speedo, you must first build a SpeedoGDOS boot disk 
(on the disk named PAP BOOT) from your Speedo install disks in the 
manner described in the SpeedoGDOS User's Guide. Once you have 
successfully done this you are ready to start installing Papyrus. 

If you intend to use Papyrus without SpeedoGDOS you should copy the 
Signum! and/or GDOS bitmap fonts which you intend to use onto the 
PAPBOOT disk. 

Insert the disk Papyrus Disk 1 in Drive A, open the disk by double-clicking 
on the Drive A icon, locate the INSTALL. PRG icon and start it by double
clicking on it. 

o 

o 

o 

The program will first ask you if you wish to install on hard disk 
or floppy disk. You should click on the floppy disk button. 

If you wish to change the default configuration that the program 
has chosen for you, use the various controls on the installation 
screen as described in the help display (obtained by clicking on 
the Help button). 

Click on the OK button to proceed with the installation. You can 
also click on Show to see which files will be copied. 

When prompted to swap disks during installation, just insert the 
requested disk and click on OK. 

After completion, the installation program will show you the READ. ME 
file containing the latest details about your version of Papyrus; please read 
this! 

You are then ready to run the installed Papyrus; first reboot the machine 
with the PAPBOOT disk in Drive A (the 'boot' disk). 

When the machine has finished rebooting, you are ready to run Papyrus. 
If you have two disk drives fitted, insert the PAPPROG disk in Drive B, 
double-click on the Drive B icon to open it. 

If you have only a single floppy drive fitted double-click on Drive B 
(without removing the disk from Drive A) the machine will ask you to 
insert Disk B in Drive A, remove the PAP BOO T disk and insert the 
PAPPROG disk (and keep swapping the disks as requested by the machine 
- Disk A is PAP BOOT, Disk B is PAPPROG). 
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Once you have the drive B window open (by whichever method), locate 
the PAPYRUS folder and double-click on it to open it, then locate the 
Papyrus program within it (PAPYRUSG. APP) and run it by double-clicking 
on its icon. Note that if you are using a single floppy drive at this point 
you will probably suffer many floppy disk swaps whilst Papyrus starts up. 

After Papyrus has started up, remove the PAPPROG disk and insert the 
PAP EXTRA disk; this disk includes the example files and additional 
Papyrus components such as the spell checker and dictionaries. You can 
also use this disk for your own documents providing they are sufficiently 
small. 

faiconOJO 

The standard Papyrus installation for the Falcon030 without hard disk 
(refer to the hard disk section above if your machine has a hard disk) 
requires a single high-density disk, which you should have to hand before 
starting the installation process. 

For the Falcon030 installation you should format your high-density disk 
first, using the volume name PAPBOOT. 

Papyrus may be used with or without Atari's SpeedoGDOS; if you intend 
to use Papyrus with Speedo, you must first build a SpeedoGDOS boot disk 
(on the disk named PAP BOOT) from your Speedo install disks in the 
manner described in the SpeedoGDOS User's Guide. Once you have 
successfully done this you are ready to start installing Papyrus. 

If you intend to use Papyrus without SpeedoGDOS you should copy the 
Signum! and/or GDOS bitmap fonts which you intend to use onto the 
PAPBOOT disk. 

r 

r 
f 

Following installation of SpeedoGDOS or your Signum/GDOS bitmap w 

fonts onto the disk PAP BOOT you must ensure that you have more than @ 

1Mb of free space remaining on the disk; you may do this from the 
Desktop by single-clicking the Drive A icon on the desktop and selecting M •. 
Show Information ... from the File menu; if the Bytes available l 
shown in the dialog is larger than 1000000 then you have sufficient disk 
space, otherwise you should prune back the disk contents (say removing 
non-essential fonts or printer drivers). I 
Insert the disk Papyrus Disk 1 in Drive A, open the disk by double-clicking 
on the Drive A icon, locate the I NST AL L . P RG icon and start it by double- I. 
clicking on it. IL 
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The program will first ask you if you wish to install on hard disk 
or floppy disk. You should click on the floppy disk button. 
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If you wish to change the default configuration that the program 
has chosen for you, use the various controls on the installation 
screen as described in the help display (obtained by clicking on 
the Help button). 

Click on the OK button to proceed with the installation. You can 
also click on Show to see which files will be copied. 

When prompted to swap disks during installation, just insert the 
requested disk and click on OK. 

After completion, the installation program will show you the READ. ME 
file containing the latest details about your version of Papyrus; please read 
this! 

You are then ready to run the installed Papyrus; first reboot the machine 
with the PAPBOOT disk in Drive A (the 'boot' disk). 

When the machine has finished rebooting, you are ready to run Papyrus. 
Double-click on the Drive A icon to open a window onto the PAPBOOT 
disk. Once you have the drive A window open,locate the PAPYRUS folder 
and double-click on it to open it, then locate the Papyrus program within 
it (PAPYRUSG. APP) and run it by double-clicking on its icon. 

The Papyrus Desktop 
lOa a Guided four 

To help you find your way around Papyrus we have included a quick 
guided tour around the screen display, explaining in turn what each of the 
elements is for and how it is used. The elements are· deliberately not 
described in detail to prevent you becoming confused so early on! 
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When you start Papyrus from the Desktop there will be a short pause 
during which any SpeedoGDOS fonts will be loaded. The file selector will 
then appear. Since we are going to tour around the interface first, click on 
the Cancel button. The following screen will now appear: 

The Papyrus Desktop 

This is the Papyrus Desktop. Its appearance may vary slightly, depending 
upon the current screen resolution. The use of the various objects on the 
Desktop is described in detail throughout this manual, but so that you 
have an overview of the Desktop's function, a brief description is given 
below. 

The Menus 

At the top of the screen you can see the titles of a standard GEM menu bar. 
It allows you access to the many options and dialog boxes as well as any 
Desk Accessories present. Normally the menus themselves are hidden but 
when you move the mouse pointer over one of the titles, a box containing 
a list of menu items drops down. To choose a menu item, simply move the 
mouse over it (a highlighted bar will appear) and press the left mouse 
button once. Alternatively, you can click outside the box to dismiss the 
menu. Menu items are grouped by topic, for instance the File menu 
contains all the functions which deal with disk files. 

Choosing a menu item will normally result in some action being carried 
out, although some produce a dialog box or act as toggle switches for 
various features or settings. 
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Ntems ending with coo 

If a menu item ends with three full stops then this indicates that choosing 
it results in the appearance of a dialog box. These are always safe to choose 
since you can Cancel the dialog box if you wish. Items without ... take 
effect immediately, possibly altering your document. 

Switches 

A number of items in various menus can have a check mark (or tick) next 
to them indicating that the option is currently active. In most case, 
selecting the item simply switches the option on or off. 

KeyboaJrd Shorlcuts 

Most menu items have keyboard shortcuts which provide a quick way of 
accessing them. These are listed to the right of the item text. 

Menu shortcuts often require you to hold down two or more keys at once. 
This is indicated by special symbols. The symbols are as follows: 

Ctrl The Control key. 

Shi ft One of the two Shift keys. 

For instance, a keyboard shortcut indicated by Ct r 1- M means hold down 
the Cont rol key whilst pressing M and Shift Ct r 1- M means hold down 
both the Shi ft key and the Cont rol key whilst pressing M. 

Ghosted Items 

You will see that some menu items are greyed out. This effect is called 
ghosting and indicates that that particular menu item is not available for 
some reason. Different menu items become ghosted at different times 
depending upon what you are currently doing. 

The roolbox 

The Toolbox is the object towards the top left of the Desktop. It is used to 
set the mouse cursor's actions. This is quite a complex concept, but once 
grasped is fairly intuitive. Suffice it to say that its use alters the way that 
Papyrus interprets your mouse clicks. 
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The Toolbox is one of the more important subjects within Papyrus and has 
its own section in this manual devoted to its operation. 

The Toolbox 

The function key bar 

The Function Key Bar serves two purposes: to remind you of the actions 
that the various function keys carry out; and it allows you to use the 
mouse as an alternative way access the function keys. 

The Function Key Bar 

The Function Key Bar can be customised to your own requirements, this is 
detailed later on. 

The Shredderr 

The Shredder is Papyrus' version of the Atari Desktop's Trash Can. It 
works in exactly the same way, except that instead of deleting disk files, it 
is used to delete notional pieces of paper and sections of text. 

Hence its name! 

The Shredder 

We will practice using it later, but for now it's enough to say that you can 
pick up blocks of text (and other objects) with the mouse, drag them to the 
Shredder and drop them in. 
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Customising the Papyrus Desktop 

The Shredder, Toolbox and Function key bar can all be moved to any 
position on the desktop. All you have to do is to pick them up by their 
handle and drag them to a new position. 

The handle for the Toolbox is the grey shaded area at the top. 

The Function key bar has two handles - one at either end. Again they are 
shaded grey. You can use whichever one is convenient. 

The Shredder icon doesn't have any handles. You can pick it up 
anywhere. 

The Papyrus logo cannot be moved. However, it can be removed if you 
don't like it (which is hard to believe!) or if you are short of memory. This 
procedure is explained later on in the manual. 

Summary 

This has been a short tour of the elements of the Papyrus Desktop. You 
should now know: 

o 

o 

The names of each part of the Papyrus Desktop and what their 
function is, but not how to use them. 

How to move the Toolbox, Function key bar and Shredder. 

o How to use the menu bar, but not what each menu item does. 

If you are not sure of any of the above - especially the names of the 
Desktop objects - read through this section again, as the information in it 
will be referred to throughout the rest of this manual. 

How to Use Dialog Boxes 

This section describes the special dialog boxes used by Papyrus, their 
conventions and the objects that they contain. It is important that you read 
this section regardless of your previous experience with computers. 
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Non-Modal Dialog Boxes 

0··_··_··_··-
0··· 

Thickness [C] 1'11'1 

OK I I Cancel I 
I apply II Revert ! 

Using non-modal dialogs 

Dialog boxes are the name given by GEM to graphical forms, which are 
normally used to pass information between you and the program that 
you're currently using. 

In many cases when a dialog box is displayed, nothing else can be done 
except edit it to completion - an example of this choosing Des k top 
Info ... from the Desktop's Desk menu which results in the display of a 
dialog box containing details of the computer's operating system. If you try 
to click the mouse outside the dialog box, the computer sounds what is 
euphemistically called the bell. The only way to carryon using the Desktop 
is to click the mouse on the OK button and make the dialog disappear. 

This type of dialog box is known as a modal dialog and you will already be 
familiar with its conventions - if not, the manual supplied with your 
computer describes dialog boxes quite well and you should read it now. 

Papyrus' dialog boxes differ from standard dialog boxes in two 
fundamental ways: 

They appear within a window which means that you can move them to a 
position where they are not covering some part of a document that you 
wish to see whilst editing the dialog. 
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They are what is generally known as non-modal dialog boxes. What this 
means to you is that you do not need to click on an OK or Cancel button 
to continue working. In fact you can access a dialog, partly edit it and 
continue working with the dialog still displayed. 

Most modal dialog boxes can be left by clicking the mouse on either the OK 
or Cancel buttons. OK usually applies any changes that you've made, 
whereas Cancel resets the dialog to its condition before you started to 
edit it. In both cases the dialog box is closed. 

Papyrus' non-modal dialog boxes usually have a group of four exit 
buttons: OK, Cancel, Apply and Revert. OK and Cancel have the same 
effect as in modal dialogs, i.e. they ultimately result in the closure of the 
dialog. Apply and Reve rt are the non-modal equivalent of OK and 
Cancel respectively. In other words, Apply does exactly what OK does 
and Revert does exactly what Cancel does, except without closing the 
dialog. 

Still confused? Well, this is as simple as it gets. Papyrus' dialog boxes have 
four exit buttons. They are: 

OK applies any edits that you have made to the dialog and then 
closes it. 

Can c e 1 resets the dialog to its state prior to your making any 
alterations and then closes it. 

Apply applies any changes that you've made within the dialog 
and leaves the dialog open. 

Revert resets the dialog to its state prior to your making any 
alterations and leaves the dialog open. 

We have provided non-modal dialogs to give you extra flexibility when 
using Papyrus. The concept is in fact relatively simple and their use 
becomes second nature very quickly. So much so, that there is no option to 
use modal dialogs instead. 

Dialog Box Objects 

Papyrus' dialog boxes contain many different types of object. To help you 
get to grips with these as quickly as possible, here is a description of each 
type of object and how to use it. 
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Keyboard Shortcuts in Dialogs 

As an alternative to just using the mouse to select and de-select the various 
objects available, we have provided keyboard shortcuts in dialogs. Where 
these are available, the text of an object will have one of its letters 
underlined. That is the shortcut for that object and means that the object 
can be accessed by holding down the Alternate key whilst pressing the 
underlined letter on the keyboard. Consider the two buttons shown 
below: 

OK I I Cancel I 
To select OK you could click the mouse anywhere in the box surrounding 
the text or you could press the Al t ern ate key and 0 together. How 
would you select Cancel? 

Sultans 

The buttons that Papyrus uses look and behave just like any normal 
buttons. To select one just position the mouse pointer inside its border and 
click (press and release) the left mouse button. Another click will de-select 
it again. 

A group of exit buttons 

OK I I Cancel I 
Apply I I Revert I 

Note that a ghosted Revert button also has its border greyed out. GEM 
doesn't normally do this, but it makes it clearer that the button is not 
currently available. 
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Radio Buttons 

Radio buttons belong to a group, only one of which may be active at a 
time. The currently active option is denoted by its centre being darkened, 
all the others are shown hollow. 

~
Start 

@-
0 ........... 
0 ............ 

A group of radio buttons 

You can select a radio button by clicking on either the round button itself 
or anywhere on the associated text. 

Check Boxes 

Check boxes behave like normal buttons, i.e. you can select one by clicking 
on it and de-select it by clicking on it once more. They are generally used 
where a series of options can be switched on or off independently of other 
options. Selected check boxes are shown with a cross placed inside them. 

ShOH" , 
[3J RedraH objects above text 
[3J J..eft Margin 
[3J Pictures 
[3J Object Eral'les 
[3J Object anchors, SYl'lbo I s o .spaces, Tabs, Return o ~ase Lines 

Some check boxes 

As with radio buttons, check boxes are selected and de-selected by clicking 
on either the square button or anywhere on the associated text. 
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Pop-Up Menus 

Papyrus makes extensive use of pop-up menus. These are identified by an 
optional label and a shadowed box with some text in it: 

Unit I MilliMetres I 
A pop-up menu 

The pop-up menu can be opened by either clicking on the label text or on 
the boxed text. The shadowed box will expand to show the available 
options for that setting. One of the options will have a check mark to the 
left of its name; this indicates the currently selected option for that setting. 

fanfold paper 
1I.iI€I!1.!)0011 .; Single sheet auto feed 

Single sheet Manual feed 

An expanded pop-up menu 

To select a change the current option, simply move the mouse over the 

r 

J 

entry that you require and click the mouse button. The pop-up menu will 
contract to its original size and the option that you selected will be shown I 
in the shadowed box. To make the pop-up contract without making any 
changes, simply click the left mouse button anywhere outside the menu 
area. 

Editable Fields 

Editable fields are used by Papyrus to allow you to enter your own 
preferences - for instance the name of a file or some such thing. Editable 
fields usually have a descriptive label to their left or right to explain what 
is expected. 

® One entry per line, 
at least ~ lines per re(ord 

An editable field 
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You can place the text cursor on an editable field by clicking the mouse on 
it - the text cursor in dialog boxes is a vertical bar. You can move left and 
right through the field by using the cursor keys, or you can clear the field 
by pressing the Esc key. The cursor up and down keys move the text 
cursor between editable fields. The Tab key moves the cursor to the next 
field. 

The Default Buffon 

Most dialogs have what is called a default button. This is an exit button 
whose border is thicker than the others. If you press the Return (or 
Enter) key the computer will assume that you have clicked the mouse on 
that object. This can be a useful time-saver especially in a dialog with 
many editable fields. . 

Summary 

You should now understand the difference between modal and non
modal dialogs. We have described the different types of objects that you 
can interact with in dialogs and how to use them. So that you can confirm 
that you understand what has been said in this section, you will see an 
example of a Papyrus dialog box below. Try to identify the constituent 
parts of it. 

Data file: DATA.EXP 

Hallie file: 

Data Forlllat -------------------, 
~ One entry per line, 

at 1 east [[] 1 i nes per rec.ord 

() COlllllla ~eparated 

()/ User-defined forlllat ... 

~ Renerate a ne~ page for eac.h rec.ord 

Create !2oc.ulllent ~ I frint... I I D.K II tanc.el 
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We will be using dialog boxes quite often throughout the remainder of the 
manual and you should refer back to this section if you need a reminder at 
any time. 

A Word About Fonts 

This section describes how Papyrus uses fonts and, more importantly, how 
you can use them in your documents. There is a short section which 
describes the different types of fonts available for the Atari series of 
computers. If you are familiar with these, you can move to the next 
section. 

The word font comes from the old printers' term fount and means typeface. 
It has become corrupted and rather presumptuously adopted by the 
computer fraternity. As Papyrus is a WYSIWYG (What You See Is What 
You Get) word processor, fonts are central to its operation. Indeed without 
them you can't use Papyrus at all! 

Computers store fonts as files on disk. These files describe how each font 
looks. Unfortunately, there are as many different types of font file format 
as there are computer types. These can be split into two different type of 
font: bitmapped, where each character in the font is represented by a 
picture; and outline, where each character is described by a set of 
mathematical equations. Both types have advantages and disadvantages. 

Fortunately, the situation on the Atari ST/TT/Falcon series of computers is 
quite simple. There are two types of bitmapped font and two types of 
outline fonts available: 

GEM Bitmap. These fonts are the original type of font available for the 
AtarL They have the file extension .FNT, which quite obviously stands for 
font. As they have been available for many years, there are many different 
fonts available in many different sizes for this format. 

Signum!2 Bitmap. These fonts appeared with the German Signum! 
document processors and, despite their limitations, became popular due to 
their high quality. Papyrus supports the popular Signum!2 font type. The 
filename extensions vary depending on the intended device, but are 
generally logical (300 DPI laser printer fonts have .L30 extensions; 24 pin 
printers, . P24, etc.). 

GEM Outline. GEM outline fonts are actually Bitstream ™ Speedo fonts and 
their files have the extension .SPD (for Speedo). They offer high quality at 
(almost) any size and have the advantage that although the files are quite 
large, only one is required for all sizes and devices. 
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Calamus Outline. These fonts were first supplied with the desktop 
publishing program Calamus. They have similar advantages to GEM 
outline fonts but do not offer such high quality. Papyrus does not support 
them. 

As you can see, Papyrus supports three of the four available font types. 
Both types of bitmapped fonts are supported directly, that is you only 
need the fonts themselves, whereas to use GEM outline fonts you must 
first install SpeedoGOOS. 

A Background to GDOS 

In the beginning the earth cooled, the dinosaurs came and went, humans 
evolved, Atari designed the ST. .. and along came GEM bitmapped fonts. 

Actually this precis of natural history is not quite right; GEM bitmapped 
fonts first appeared for the IBM Pc. However, it is true to say that 
bitmapped fonts have been available for quite some time. When Atari 
decided to supply its ST series of computers with their operating systems 
in ROM there was not enough room for all of it so they left out GOOS. 

GOOS is an extension to your operating system. When installed, it allows 
applications to output text and graphics to printers and other devices 
besides the screen. GOOS also allows you to print with many other 
typefaces other than the standard (build-in) fonts available with your 
printer. 

Instead of supplying COOS with the computer Atari left it up to software 
houses to supply it with their programs that needed it. As if that wasn't 
enough, COOS was slow, bugged and there were very few printer drivers 
supplied. These factors combined to make the whole idea of COOS fairly 
unpopular. Papyrus doesn't need COOS to load CEM bitmapped fonts or 
to print documents that use them. 

Recently, Atari have developed two new versions of GOOS; FontGOOS 
and SpeedoCOOS. 

fontGDOS 

In many ways FontCOOS is simply a bug fix of the original COOS. 
However, other features have been added and there is now support for 
Bezier curves. As with the original COOS, you need not install FontGOOS 
for Papyrus to function. 
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SpeedoGDOS 

SpeedoGDOS is a different concept in font handling. It allows you to load 
and use bitmapped fonts and other graphic objects, but its real difference 
is that it allows you to use GEM Outline fonts. If you want to use GEM 
Outline fonts in your Papyrus documents then you will need to install 
SpeedoGDOS first. The instructions for doing this are supplied with the 
package and you should refer to them, but note that your computer 
should have at least 2Mb RAM and a hard disk is strongly advised. 

Summary 

You should understand that there are two main types of font available and 
that the Atari series of computers uses both types. Be aware of what 
SpeedoGDOS is and what the implications of it are. 

Chapter Summary 

This chapter has explained: 

" How to run Papyrus. 

.. 

.. 

• 

What the constituent parts of the Papyrus Desktop are . 

How to use the menu bar and its various conventions . 

How Papyrus dialog boxes differ from the normal GEM dialog 
boxes, how to recognise the different types of object in the dialogs 
and how they are used. 

.. The background to font systems for the Atari series of computers. 

I 

I 

If you still have any difficulty with any of these subjects, please refer to the I 
relevant section again. 

l 
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Papyrus lIE the Basics 

This chapter explains how to create a document using Papyrus, how the 
basic editing functions work and how to move around a document. If you 
have used any sort of text editor before, you need do no more than skim 
through this section, taking note of the 5pecioD Keys sub-section. 

Your First Document 

Right, here we go! Run Papyrus and when the file selector appears click 
OK or hit Enter to select a new document. 

A window will open looking something like this: 

8 . 11 2 3 4 5 16: 7 8 9 18 11 12 13 14 15 16 9' 
+ ~ 
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The window has all the normal GEM gadgets such as scroll bars, a close 
box and a zoom box. If you are unsure what these are or how to use them, 
refer to the manual supplied with your computer - it's described quite well 
there. 

Underneath the window's name (with Untitled in it) bar you should see 
what is called the Ruler. Don't worry if it's not there, just move the mouse 
cursor to the Options menu title and select Ruler when the menu drops 
down. 

Entering Text 

Below the Ruler is a group of icons and below them there is a large area 
surrounded by a dotted line and a small vertical line in the top left corner 
of this area. That is the text cursor. It shows where text will appear when 
you start to type. Try to type some text now ... 
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You can see that the vertical cursor move ahead of the text that you type. 
If you make mistakes it's easy to go back and correct them. Use the left and 
right cursor keys to move the text cursor to the left of the character that 
you want to correct. .. 

... and press the Delete key. 

The offending character has gone. 

Now you can replace it with the correct one. 

An alternative to using the Delete key is to use the Backspace key. 
Instead of removing the character in front of the text cursor, it removes the 
character prior to the text cursor. This is more useful when you want to 
correct the character that you have just typed. 

The Delete key deletes the character to the right of the cursor. 

The Backspace key deletes the character to the left of the cursor. 

Get to the End of the Line 

Papyrus handles text in paragraphs. That is, you do not need to press the 
Return key as you approach the right margin of the paper to make the 
text appear on the next line. To see this working, just type in some more 
text and watch what happens as you approach the right margin. 

Papyrus takes care of the lines automatically 

Ending Paragraphs 

As mentioned above, Papyrus handles text in paragraphs. When you have 
completed a paragraph, you only need to press the Return key. The text 
cursor will move to the beginning of the next paragraph. 

More Moving Around 

There are many ways of moving around the documents that you'll create. 
We'll now go through these in turn describing how they work and the 
relative advantages and disadvantages of each. 
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The Cursor Keys 

In the previous section we used the left and right cursor keys to go back 
and forth through a line. You can also use the up and down cursor keys to 
move (respectively) to the line above and the line below the current 
position. This method is useful when you only want to move just a few 
lines in either direction to say, correct a mis-spelt word that you failed to 
notice at the time. 

Of course, you can move line-by-line throughout a document in this way, 
but in a large document this could take you some time. 

Note that when to move in a particular direction would mean that the 
cursor would disappear from view, Papyrus will move the view of the text 
such that the text cursor is always visible. This will happen when you are 
typing in text as well. If the window view does not cover the full width of 
the paper between margins then the view will automatically scroll left and 
right so that you can always see what you are editing. 

If you want to move the cursor to a specific position within the current 
window, it is sometimes quicker to move the mouse cursor to the position 
that you want to continue editing and click the left mouse button. The text 
cursor will now be at the new position ready for you to continue. 

Of course you can only position the cursor somewhere within the current 
window view. If you want to move further afield, you will have to use 
some other method. 

fhe Window Gadgets 

As we mentioned earlier, the window scrollbars and arrows behave in the 
normal GEM manner. 

Scroll Arrows. The arrows move the view one line up or down, or one 
character left and right. To use them, move the mouse over the arrow that 
you want and press the left mouse button until the window view is what 
you want. 
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Paging. If you click the mouse in the area either side of the scroll bars then r 
the view will move one window's size in the chosen direction. For 
instance, if you want to see what is immediately below the current view, r, -, 
just click the left mouse button below the vertical scroll bar. If you hold the , 
mouse button down then the view will continue to change until you 
release the mouse button. This is a quick way to change the current 
window view. The term paging is a misnomer - you do not move one r-
paper page up/down or left/right - you move one window view up/down 
or left/righ t. 

Scroll Bars. If you want to move a long way in a document, you can pick f-
up a scroll bar and drag it to the place you want to be. To do this, move the 
mouse cursor over the scroll bar, press and hold the left mouse button 
whilst dragging the scroll bar to its new position. When you release the I 
mouse button the view will change to reflect the position of the scroll bar. 

When you use the window gadgets to change the window view of a I 
document, the text cursor doesn't move at all. If you move to a position 
whereby the text cursor is not visible and decide that you want to edit 
something in the new view, you must first use the mouse to position the 
cursor where you want to start to edit. 

If you don't do that and then press either a cursor key or any other normal 
key, then the view will automatically revert to its original condition before I 
you used the window gadgets. 

This behaviour is not a bug. Nor is it as disadvantageous as it may seem. If 
you have used the gadgets to change the view, then you already have the 
mouse in your hand, so to indicate where you want to edit is a natural 
movement. Furthermore, you can quickly view, say, a previous section of 
a document and then just continue typing to return the view to its original I 
position. 

~eda/~p I 
There are a set of keyboard shortcuts that help you to alter the view 
without taking your hands from the keyboard. These all use the cursor key 
in conjunction with either Shift or the Control keys. 

Shi ft + Cursor Up Changes the view one window's height up. 
The text cursor doesn't move. 

S hi f t + Cursor Down Changes the view one window's height [ 
down. The text cursor doesn't move. -

l 
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Shi ft + Cursor Left Moves the text cursor to the beginning of the 
current line. 

S hi f t + Cursor Right Moves the text cursor to the end of the 
current line. 

Home Move the cursor to the beginning of the 
document. If that is not currently in view 
then the window view will be altered such 
that the cursor can be seen at its new 
position. 

Control + Cursor Up Changes the view one page up. The text 
cursor doesn't move. 

Control + Cursor Down Changes the view one page down. The text 
cursor doesn't move. 

Cont rol + Cursor Left Moves the text cursor one word to the left. If 
the cursor is at the left margin it will move to 
the last word on the previous line. 

Control + Cursor Right Moves the text cursor one word to the right. 
If the cursor is at the right margin it will move 
to the first word on the following line. 

Cont rol + Home Move the cursor to the end of the document. 
If that is not currently in view then the 
window view will be altered such that the 
cursor can be seen at its new position. 

Summary 

We have discussed how to: 

o 

Enter text and how to correct any mistakes using the Backspace 
and Delete keys. 

Move around a document using the special keys. 

Position the text cursor with the mouse. 

Use the window gadgets to alter the window view of a document. 

You should read over any section that you are still unsure of. Try to follow 
what is being said by attempting to carry out the actions discussed. 
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Save, Close and Load Documents 

Now you can open new documents, enter and correct text, move the text 
cursor around and change the window view at will. What is missing is 
how to save your work. This short section explains how to save and close 
your documents. It is important that you read it. 

You may have noticed that after you start to enter text in a new document 
an asterisk appears to the left of the window name. This indicates that the 
document contains work that has not yet been saved to disk. 

Saving Documents 

When you want to save your documents there are two basic options: 

Save the document under its current name. This is done by choosing the 
File menu option Save or using the keyboard shortcut Cont rol S. 

There will be a short pause and the mouse cursor will change to the Busy 
Bee. Once the save operation has been completed, the mouse will return 

r 
r 
r 
f 

to normal and the asterisk in front of the window name will disappear. I 
Save the document under a new name. You can save documents under a 
different name by choosing the Save as ... option of the File menu, or I 
by using the keyboard shortcut Shift Control S. When you do this, the 
system File Selector will appear. At the top you will see the message Save 
document as (PAP / RTF / ASC). Choose the path where you want the 
document file to be kept and then enter a name for it. Make sure that you I 
give it a file extension of PAP - something like FIRSTGO. PAP will do - the 
other extensions will be explained later on. 

If you have specified a different name or path name for the document, 
then when the Save as ... operation has finished an Alert Box will appear 
asking if the new name should be registered. 

~ Register neH na~e? 

Register ~ I No 

Register dialog box 
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If you want to work with the new file, choose Register. Otherwise 
choose No to leave the window name alone. 

Saving Documents fOff the fiffst Time 

When you are saving a new document for the first time the file selector 
will always appear - even if you choose the S a v e option of the F i 1 e 
menu. This is because it doesn't have a name yet and Papyrus is 
prompting you to give it one. 

If there is no asterisk in front of the filename displayed on the window 
title bar, then there is no need to save the document.; Papyrus has worked 
out that you have not changed anything. 

Closing Documents 

When you have finished editing a document and want to close it, you 
have two options: 

Choose the C los e option of the F i 1 e menu (keyboard shortcut 
Control U). 

Use the mouse and click on the window close gadget at the top left of the 
window. 

If the document has been edited and the work has not been saved then 
Papyrus will ask you to confirm that you want to close the document. 

Save thanges to "EXAMPLE, PAP" 
before tlosing? 

Save 

lD.on't savel ,C.antel 

Close document dialog 

If you choose Save then the document will be saved and then closed. 
Don't save closes the document immediately and any unsaved work will 
be lost. Can eel aborts the close operation and returns you to the 
document window. 
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Loading Documents 

So far there's been no need to open a document that already exists. 
However, we now have a document file saved on disk and have closed its 
window. How do we get it back? Easy. Use the mouse to choose Open ... 
from the File menu (keyboard shortcut Control 0). The File Selector 
will appear again. This time the message will say Open Document 
(PAP / RTF / ASCI I) . Use the File Selector to choose the file that you want 
to open (pick the one that you just saved) and click on the OK button. After 
a short pause the document will open in its own window. You can now 
edit it again! 

SummollY 

You should now be able to save your documents both under their original 
name and also under a new name. You should know how to close 
document windows using the File menu and the mouse and you should 
be able to open a document that has been saved on disk. If you are unsure 
of any of this, read through this section again. We will assume that you 
can do this from now on. 

Chapter Summary 

From this chapter you should be able to do the following things: 

o Create new documents. 

o Enter text and carry out basic editing of text. 

o Move around and alter the window view of a document. 

o Save documents. 

o 

Page 2B 

Open documents. 

Close documents. 
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Papyrus - fonts & Styles 

This chapter describes how Papyrus uses fonts and text styles. Regardless 
of your previous experience, it is important that you read this chapter 
thoroughly and understand the concepts that are explained in it. 

Introduction 

When Papyrus starts, it loads any available outline fonts and looks for 
bitmapped fonts. All these are registered, which means that Papyrus makes 
them available for use in your documents. You can use any font anywhere 
in any document, but remember that if you use an outline font in a 
document then you must ensure that SpeedoCDOS is loaded the next 
time that you use Papyrus. 

font families 

Before we go on to show you how to choose a font, you should be aware 
that Papyrus deals with fonts in a slightly different way to most other 
programs. Instead of giving you the choice of all the available fonts, 
Papyrus groups similar fonts into families. For example, the two fonts 
Times 12 Point and Times 24 Point are grouped into the Times family. This 
concept of font families is simple and yet makes font selection much 
simpler and far quicker. 

Speedo fonts are already grouped into families within the Speedo font 
definition - Papyrus understands about this and manages Speedo families 
for you. Papyrus also allows you to manually organise CDOS and 
Signum!2 bitmapped fonts into families. More of this later. 

Choosing a font - The font Panel 

Fonts are all controlled by a single dialog box called the Font Panel. You 
can use this dialog at any time, regardless of whether or not a document 
window is open. To access the Font Panel, choose the Font Pane!. .. 
entry from the Text menu or press Control Z. The dialog that appears 
looks quite complicated. Don't be put off though; it's actually quite simple! 

Fonts and Styles Papyrus Gold Page 29 



r 

r 
Load" , 

I 
the Font Panel 

Remembering the concept of font families described above, you will note fi 
that there is no single list of the fonts. On the left is a list of the available I 
font families or faces, to its right is a list of available text styles or individual 
fonts and below that a list of point sizes. At the top of the dialog is a 
sample of what the selected font looks like at the selected point size and 
style. 

Now we'll describe the various objects in the Font Panel. 

Sample of font 

As you choose different fonts, styles and sizes, the text at the top of the 
dialog alters to show you what the text looks like. There is nothing to edit 
or click on in this object. 

Available fonts I 
The list box on the left of the dialog displays a list of all the currently 
registered font families. This list is independent of the open document. ( 
Families of GEM bitmapped fonts are shown with a solid black dot to the 
left of their name, Signum!2 families have a hollow dot next to them and 
GEM outline families do not have any symbol next to their name. I 
If the list of font families is too long to fit into the box, you can reach the 
hidden ones by using the scroll bar and arrows on the right of the box. If 1 
there are no families listed, read through the rest of this section quickly , 
and then read the Administering font Families section. 

l 
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To choose a particular font family for use in a document, click the mouse 
button on the name of the family. The currently selected font family is 
shown highlighted. As you choose different families note that the text at 
the top of the dialog changes to reflect the new face or family. 

Show checkbox 

Below the list of available font families you can see a checkbox labelled 
Show. When this is selected, the list of font families is shown in the style of 
the font. This option can be useful when you want to be able to choose a 
font family quickly. When it is not selected, the font families are listed 
using the system font and the display will update more swiftly. 

The box to the right of the dialog contains a list of the available text styles 
(fonts) for the selected font family. It is often blank. Don't worry about this, 
it doesn't mean that a particular text style is not available, just that there 
are no separate fonts to represent different styles. 

For instance bitmapped fonts are usually supplied in only one style, Roman 
- or normal. When you want to use bold, underlined, or italic text styles, 
Papyrus works out what the text should look like and displays it. 
However, if a font family has is a special font for, say, italic text, then the 
word Italic would appear in this box. GEM outline fonts are supplied in 
different styles which are built in to the face definition. 

Point smzes 

The box below the style box contains a list of numbers. These are different 
point sizes (1 point is 1/72 inch). By selecting one of the sizes, you can 
choose what size the font will be. The size is also shown in the preview 
box (at extremely large sizes you will only see the bottom of the text). You 
can select any point size for any font type. 

If the size that you choose doesn't exist as a font definition (bitmapped 
fonts only) then Papyrus will calculate what the font should look like at 
that size and display a representation of it. The quality of the resulting font 
is not as good as if there was a specific font available for that size, however 
it does mean that you are not limited to just the sizes in which your fonts 
are supplied. 
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You will note when a bitmapped font family is selected, that some of the 
point sizes are shown in outlined or italic outlined text. This shows that a 
font definition actually exists for that point size and so its quality will be 
higher than if Papyrus has to calculate what the font should look like. 
Outlined font point sizes are only shown in normal text. 

Custom Point Size 

The custom point size box (labelled POints) normally contains the point 
size selected in the list to its left. However, if you want to use a point size 
not listed, just click the mouse in the box, type Esc to clear any existing 
point size and enter the size that you want. 

Width/Height Ratio 

The W / H editable box is normally set to 1 (one) which means that text is 
displayed in the aspect ratio for which it was designed. However, you can 
enter any number that you want. Numbers greater than 1 make the text 
fatter and numbers less than 1 make them thinner. This option does not 
alter the height of the text. 

Using the font Panel 

Although we have not described all the objects in the Font Panel, you now 
know enough to change fonts in your documents - the rest we'll cover 
later. 

Choose which font you want to type with from the list of available families 
and select what size you would like. To apply this to your document click 
on Apply or OK. 

If you haven't already done so, open a new document. Try typing 
something. You will see that your text will now appear in the new font, at 
the new size. Now change the font and carryon typing. It's that simple! 
Carryon typing altering the typeface and its size until you're happy with 
the way the Font Panel works. 

Section Summary 

You should now understand: 

Papyrus deals with font families and not just fonts. 
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How to change the typeface that you're using and how to set its 
point size. 

• How to alter the width of text. 

If you are in any doubt about any of the above points, read through the 
section again. Don't worry too much though, you'll get plenty of practice 
with the Font Panel in the tutorial that follows. 

Administering Font Families 

All this is very well, but what if you want to add a new family? You will 
have noticed a button labelled Load ... at the bottom right corner of the 
Font Panel. This button accesses the Font Families dialog where you can 
add and remove font families and also add and remove individual fonts to 
and from families. Click on this button now. The Font Families dialog will 
appear. 

The font families Dialog 

~t I:::::::::::::::::::!::::::::::::: font f aM iii es :::::::::::::::::::::::::::::::::: 
font faMily --------, 

NaMe IGBitMapsl~ypeMriter 
ID 18 TypeMr iter 
lXI,S.hoM in panel 0 Caps only 

I OK I I Cante I I 

I Apply I ! ~evert I 
font -------------, 

ATTP1D.fNT 
ATTR12.fNT 
ATTR1B.fNT 

~ ,..--------. 
I Add fonts ••• 

I ReMove 
~ .... _"'-=,;;",,;,,;;;_ ..... 

IReMove unused faMiliesl 

I ReMove faMily I 

I NeM faMily." I 

the Font Family dialog 

This dialog should be filled in with the details of the current font family i.e. 
the font family that is selected within the Font Panel dialog. 
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If it is not, it just means that there are no font families registered. Note that 
the Font Panel and the Font Families dialogs are non-modal so that you can 
move between them changing the font and family that is selected. 

The Font section of this dialog shows the individual fonts that make up 
the font family - as we have said before Speedo fonts are grouped into 
families with the Speedo face definition and the user does not have control 
over this from within Papyrus. So, GOOS Font is displayed here if a 
Speedo family has been chosen. 

Adding a font Family 

To create a new font family just click the mouse on the New family ... 
button within the dialog. If the dialog had details of an existing font 
family, then these will be cleared (but the font family itself will still exist). 

The file selector will appear prompting Install New Font Family. Select a 
font to load as part of the family and click the mouse on OK to proceed. 
Cancel aborts the whole operation. 

Assuming that you successfully chose a font and clicked the OK button, 
Papyrus will search the rest of that folder for other font files that it thinks 
belong to the same family. If it finds any, an alert will appear; If Papyrus 
was right and there are matching font files, you can click on the Load all 
button. Clicking on No means that only the font file you selected will be 
used and Cancel stops the whole operation and returns you to the Font 
Families dialog in its original condition. 

Many GOOS faces contain only one type of font, in different point sizes 
and, in this case, all you can do is build up the font family from the 
different point sizes of the same font - still useful of course. To do this, you 
choose your first font as above to define the family and then use Add 
fonts ... on the Font Families dialog to add new point sizes. 

Removing a font family 

In general, hard drive users will not normally find it necessary to remove 
fonts or font families. If Papyrus is run from floppy disks, memory 
constraints may make font removal necessary. 
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Font families may be removed from the Font Families panel. After selecting 
the family to be removed, click over the Remove Family button. If the Font 
Family is in use, a warning dialog will appear preventing removal. It 
should be noted that Speedo fonts and families may be removed as well as 
GOOS and Signum!2 fonts, but Speedo fonts cannot be added from the 
Font Families dialog - use the OUTLINE.PRG program supplied with 
SpeedoGOOS. 

An option is available to remove unused font families. 

Individual fonts may be removed from a family by selecting the font and 
using the Remove button. 

Adding fonts to a family 

Click on the Ad d f 0 n t s ... button in the Font Families panel. The file 
selector will appear. Select the desired font from the file selector and press 
Return or click on OK. Note that only GOOS or Signum!2 fonts may be 
added in this way. Speedo fonts can only be added through the OUTLINE 
program and rebooting Papyrus (see the SpeedoGOOS manual for 
details). 

family Names and Identities 

These are specified in the Font Families dialog. Identity (ID) is normally set 
and should not be changed. The Name box is used to identify the font 
family in the Font Panel dialog. Usually, it should start with the ID name, 
for example Times, followed by the shifted Backslash key (to the right 
of the left Shift key), followed by the font style, e.g. roman, italic, 
bold italic, etc. If the font family consists of a single font, the font style 
may be omitted. When the name and 10 have been entered, click on 
Apply, followed by OK. The effect can then be seen in the Font Panel. 

Section Summary 

You should now understand: 

G Papyrus deals with font families and not just fonts. 

o How to add/remove font families and manage the fonts within 
font families. 

Fonts alld Styles Papyrus Gold Page .35 



Chapter Summary 

This introductory chapter to using Papyrus should have given you 
familiarity with the basic editing techniques and allowed to load and save 
your documents. 

You will also have learned about fonts and font families. 
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Papyrus Tutorial 

This tutorial is designed to show you how easy it is to produce attractive 
looking documents with a minimum of fuss and effort. 

For the purposes of demonstration, you are going to create a product 
description sheet for Papyrus - using Papyrus itself! Much of the raw 
material is provided for you and that which isn't, you're going to create 
yourself from within Papyrus. 

o 

o 

o 

You will first create a blank document, defining the way in which 
text will appear in the final printed version. 

Next, you will import some text and create a paragraph style to add 
character to the information on the page. Other styles will be 
imported from another document and these will be used to 
complement your new style. 

Afterwards, you will form some structureless information into a 
smart looking table. 

To liven up the document, you will import a picture and tell 
Papyrus how you wish to flow text around it. 

Finally, you will add a footer at the bottom of the page and 
provide it with a mono-tone background. 

Planning Ahead 

As with anything, it is always helpful to have a good idea of what you 
hope to achieve. This will enable you to plan the work in advance so that 
any useful elements (text, pictures etc.) can be at hand, thus speeding up 
the production process. 

Please don't be put off however! Papyrus is easy and flexible to use. If you 
change your mind about something, Papyrus will allow you to modify 
your work at any time. Sophisticated features exist to allow you to make 
fine adjustments to almost any aspect of a document, this means that your 
text's appearance can be honed to perfection. 
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The following list shows a typical work session that could be applied to 
practically any document: 

.. 

" 

Set up the paper format required for the document, bearing in 
mind the device on which the final version will be printed. 

Create the document. 

Set up the page layout paying particular attention to the page 
margins (e.g. some printers can't reach the edges of the paper) and 
the number of columns on each page. 

r 

Write text directly into the document or import it from disk as 
ASCII or RTF format data. ( 

" 
., 

.. 

.. 

Create and apply paragraph styles to the text. 

Import any graphics and place them into the document. 

Flow text around pictures, adjusting one format as required . 

Produce a draft print. 

s Modify the document. 

Produce the final print. 

During the course of this tutorial you are going to follow these guidelines I 
quite closely. ~ 

Getting Started 

This tutorial assumes that Papyrus is installed and running from a 
partition of a hard disk. If you have installed Papyrus on a floppy disk 
system, then it is recommended that you create a separate work disk, 
copying the TUTOR IAL folder and its contents from the Papyrus master 
disk. The finished document is not going to be very large, but some extra 
workspace will give Papyrus room to breathe. Please make sure that you 
have at least 30 kbytes of free space on your target disk. 

If you wish to print the results of this tutorial, then it will be necessary to 
have a printer connected to the computer, with the appropriate printer 
driver installed, please refer to the section /Printing the /Document at the 
end of this tutorial for further information on this subject. 
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Having done this, you need to run the program. Open the floppy disk or 
hard disk partition on which Papyrus is installed and locate the file called 
PAPYRUSG. AP P. Move the mouse over the top of this text or icon and 
double-click the left mouse button twice to run the program. 

After a few seconds you will be confronted by the computer's file selector -
Papyrus is asking if you wish to load a document. At this stage you don't, 
so click the mouse on the cancel button and Papyrus will set itself up 
and wait for your further instruction. The computer's screen should look 
something like this: . 

This is known as the Papyrus Desktop. In the upper left hand corner of the 
screen, the Toolbox will be visible, as will a strip of buttons at the foot of the 
screen. These are the Function Keys. Clicking on these within a document 
will produce the same effect as pressing the function keys on the 
computer's keyboard. You won't need these in the work which follows, 
they will almost certainly be overlaid by document most of the time 
anyway, so you may choose to remove this key strip from the screen. You 
may do this by clicking the mouse once on the close box in the top left 
corner of the Function Key strip. 

Finally, the symbol in the bottom left hand corner of the screen is the 
called the Shredder. This is used to dispose of parts of a document which 
aren't required any more. 

To remove an object from the document, simply click on the offending 
item and keeping the mouse button depressed, carry the object onto the 
shredder and let go of the mouse button - it's really that simple! 
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Creating a document 

This tutorial assumes that you want to output the final document onto 
sheets of European, A4 sized paper. This is done using the Pap e r 
Format ... control, found under the File menu. Open up this dialog and 
select DIN A4 on the right of the display and then select OK. 

Now you've told Papyrus what your paper size is, you can create a 
document. To do this, move the mouse to the top of the screen, over the 
File menu and click the mouse once on New Document. 

Papyrus will open a window onto the screen. Unless you're running on a 
special monitor, this will cover most, if not all, of the Papyrus desktop. You 
now need to make some modifications to this page to format the way in 
which the text is to be displayed and ultimately printed. 
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Move the mouse to the F i 1 e menu once again and select the P age 
Layout ... option. Using the Tab key to move around the dialog and the 
Backspace key to delete the contents of the fields, set the controls to the 
following dimensions: 

Master page I STANDARD I 
Text Area Margins -----, 

left ~ right ~ MM 

top ~ bOttOM ~ MM 

D Hi rror for I eft pages 

I
rWithin Margins 

Header Area ~ MM 

Footer Area ~ MM 

I
rcolUMns 

ColuMn nUMber [] 

ColuMn gap ~ MM 

[][:=I I J:aml I 
I apply I I Revert I 

Don't forget the Column number, this is important! Select OK at the foot of 
the screen. 

The text area margins have been deliberately chosen so that when it comes 
to print the page, the information will fit within the printable area of the 
large majority of laser, dot matrix and ink-jet printers. Yours, if you have a 
printer connected, is quite likely to print all of this without losing anything 
off the edges of the paper. 

Arranging the display 

You will probably find that as your work moves around the document and 
you perform different tasks, that you will need to change the display 
magnification to suit. Please feel free to do this, the pictures which 
accompany this tutorial will differ slightly from that which you see on the 
screen, this is usual so please, Don't Panic! 

In fact, it should now be possible to re-arrange the screen slightly. The 
chances are that the right hand edge of the page has disappeared off the 
right hand side of the screen. You may find that bringing down the screen 
magnification may help slightly. 
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To do this, move the mouse to the Zoom menu at the top of the screen. 
Bring the mouse down again and click on a zoom factor of your choice, a 
selection of 86% would normally provide text clear enough to read, but 
still keep enough of the page on the display as to be useful. 

It should now be possible to bring the width of the document window in 
slightly to fit around the columns and then move the window over to the 
right hand edge of the screen to reveal the Toolbox and Shredder again. 

The Toolbox 

Papyrus treats different elements of a document as objects. The Toolbox is 
the small cluster of controls which will allow you to create, select, edit/alter 

r 

r 

I 

and move these objects within a document and is an exact replication of W 
the display located at the top of the Obj ect menu list. ~ 
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The way in which Papyrus will allow you to manipulate objects will 
depend on the mode of operation selected on the Toolbox. It is possible to 
alter the behaviour of Papyrus by clicking the mouse on these controls: 

The currently selected mode of operation is indicated by whichever 
picture is selected (highlighted) in the display. From top to bottom these 
select the Frame Edit, Text entry, Text Frame, Object and Line modes. 
These are identical to those found at the top of the Obj ect menu. 

Initially the Toolbox will be located in the top-left hand corner of the desk, 
but you may move it around the screen by clicking on the grey bar at the 
top of the display, holding the mouse button, moving the mouse and then 
releasing the mouse button once more to leave the Toolbox at the new 
location. 

Before you continue with this tutorial, select the I-Beam icon (that's the 
second one down) to place Papyrus in the Text Entry mode. 

The Mouse form 

As you move the mouse around the Papyrus desk, the appearance of the 
mouse pointer will change. This indicates a difference in the way Papyrus 
will behave at any given time. 

The following is a brief description of each mouse form. 

Arrow 

This is the general purpose mode where clicking the arrow will usually 
select or move something, whether it be an icon or an object of some form. 

I""Beam I 

This will only appear when in text entry mode. By placing the lover an 
area of text and clicking once, it becomes possible to move the text cursor 
around the document. 

Block l§aI 
Blo'k 

In text entry mode, this mouse form indicates that you can drag a marked 
area of text from its current position to another within the document. 
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Draw + 
This fine crosshair indicates that you are able to draw an object on the 
screen. This may be a text frame, an object or a line. 

Grabber 

r 

r 
The grabber will appear whenever Papyrus expects you to move an object r 
or a group of objects. This may be a text frame, a picture or a line. 

finger 

This mouse form will appear when a specific object can be moved. The 
most common place that this will be evident is when re-sizing an object 
frame. 

Importing text 

At this point, Papyrus would be quite happy for you to start writing text 
straight onto the page; if you like, you can try this now, but please delete it 
all before continuing with the rest of this exercise. 

Some text has been provided to speed up the process of creating your 
document so you are about to load this into the computer and start work. 
The act of loading text into a document which is already open requires the 
use of the Insert function found under the File menu. 

Making sure that the text cursor is in the top left hand corner of the left 
hand column (see previous picture), move the mouse to the File menu 
and select Insert ... , you will be presented with the computer's file 
selector. 

Locate the TUTORIAL folder. Double-click on this using the mouse and the 
contents of the file list will change. Double-click on the file titled 
TUTORIAL.ASC. Papyrus will proceed to load the text file and you will see 
the following message: 

Inserting ASCII file "TUTORIAL. ASC" I I I 
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Once this is done, you will see text appear on the screen. Notice how 
Papyrus automatically flows text which is too long to fit in one column, to 
the top of the next. If necessary, Papyrus will carry text over the page. 

The chances are that Papyrus has now left you at the end of the 
document; use the document window's slider bars and the mouse to take 
you back to the start of the text. 

Creating OJ new Text Block 

Before you continue with formatting the document, you are going to add 
an introductory heading at the top of the page. To do this, we will create a 
new text frame and add some text. 

It is important that the heading is added at this stage because all of the text 
which is now in the document columns will be forced out from 
underneath. This will of course affect the way in which the final text fits 
on your page! 

Move the mouse onto either the Toolbox or the Db j ect menu at the top 
of the screen and select the Text Frame icon (symbolised by the letter A). 
Moving the resulting cursor into the top left hand corner of the existing 
text, click and hold the left mouse button. Dragging the mouse over 
toward the right hand side of the screen will reveal the outline of a box 
which will move with the mouse. Move the cross hair to the right hand 
edge of the second column of text and release the mouse button. 

You have just placed a text frame onto the screen. At this stage it will be 
possible to see the original document underneath. The positioning of the 
frame is probably rough, so you can now make some changes. 

Move the mouse to the Toolbox once again and select the Object mode (the 
icon with an arrow). Move the mouse over the new text frame and click on 
it once. The frame should now be joined by a number of black squares, 
one in each corner and one centrally along each edge of the frame. You 
can click the mouse on any of these squares and drag the frame around 
the screen. 
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Alternatively however, now that the frame has been selected as an object, 
you can enter more exact details. Move the mouse up to the Obj ect menu 
and select the Attributes ... option. From the display which will now be 
on the screen, select the following parameters: 

xec:=:J1'I1'I 
Ve~1'I1'1 

0[8] "'rap around 

l4idthe~1'I1'1 
Height.~1'11'1 

left/right distance c::::J 1'11'1 
Top/bottOM distance E=:J 1'11'1 

eO Text ignores Nraparound 
-0 Object height groNs Hi th text 
,,0 froportional reSizing 
.0 ShoN only on screen 
.. 0 Anchor object in text 

Vi Only at paragraph start 

~ I j;ancel I I For neN pictures I 
0iI:U I Revert I 

Upon selecting the OK button, Papyrus will position the frame neatly 
across the top of both text columns and will cause all of the text which was 
under the frame to be flushed out from underneath. 

Now, to write into the text frame, move the mouse up to the Toolbox and 
select the text mode (the I-Beam icon). Position the I-Beam pointer over 
the new text frame and click the left mouse button once - a cursor should 
appear on the left hand side of the frame. Now type in the following text; 
Papyrus Gold - the Word Processor. 

This will appear as small text but won't look very impressive at the 
moment, you'll come back to this in a while. 

Paragraphs 

One of the key features of Papyrus' text control is that it treats large 
continuous chunks of text as a paragraph. Each time you hit the Return 
key, this is a signal to Papyrus that you have finished a paragraph. 

Papyrus will allow you to create different styles for paragraphs in any 
document, these are called Paragraph Tags. This means that when set up, 
you can move through your document very rapidly applying, or tagging, 
a style to each paragraph. 
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Papyrus can be made to display the end of a paragraph on the screen by 
showing a special symbol. To do this, move the mouse up to the Options 
menu and select the Screen Display ... item. The following dialog will 
appear: 

,~ 1!!!i!mii!!f!m~~!m! .... PQ~.~.I'I.enJ .... ~.~reen ... D.i.~p.!.ay ... iiilmili!!i:i:liiliii!i 

@ GEM-fonts (90 x 90 DPIl r 
OptiMize Screen Display forx~ 

o Sigl1UM!2 fonts (90 x 108 DPIl 

Dbject Handles 0 0 g ~ 
Unit I MilliMetres I 

ShOH .•• -----------, 
I6J RedraH objects above text o !,eft Margin 
I6J fictures 
I6J Text and picture fraMes 
I6J Object !!nchors, SYMbols 
I6J ~paces, Tabs, Return 
o !lase Lines 

J!K I ~ancel 

Place a cross in the box titled, Spaces 1 Tabs, Return and then click on 
the OK box at the foot of the display. The screen will be updated to include 
a series of symbols, the left-arrow symbol shows the end of each 
paragraph. 

To prove the point, move the mouse I-Beam over the end of the first 
paragraph and double-click on it. 

Papyrus will now mark the whole of this paragraph by highlighting it 
(placing white text on a black background). 
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Creating a Paragraph Tag 

Since Papyrus can recognise areas of text as paragraphs, then it is also 
useful to be able to make some paragraphs look different from others. For 
example, a normal piece of body text will need one font and text size, 
whereas another will need to stand out from the rest, to add emphasis. In 
this case it may be appropriate to use a different font and size with an 
additional effect such as a line underneath. 

r 

Papyrus will allow you to define many such styles and each can be given a 
unique name to allow you to identify a particular style from a number of 
others very quickly. 

r 

Each style is known as a paragraph tag, since after having typed text into 
Papyrus, you can tag a particular paragraph with its own style. 

You are going to create your own tag now. This will be a simple style used 
to form common areas of reading text (often referred to as the body of a 
document) into neatly displayed text which expands into the column 
margins. 

Ensure that Papyrus is in text mode and click the I-Beam pointer once over 
the first paragraph of the text on screen. Now move the pointer up into 
the area known as the Ruler, above the document. To the right of the text 
No Tag you will see four squares with lines in. Select the second from the 
left: 

[]I No Tag 

You should notice that the paragraph which currently contains the text I 
cursor will be redrawn. Close examination of this will show that the right 
hand edge of the text has been pulled out to align with the right hand text 
margin. In technical speak, this is said to be justified, since both sides of the 
paragraph are aligned with their corresponding margins. 

Now you're going to tell Papyrus that you wish to leave a small space • 
above and below this particular style. f 

L 

l 
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Move the mouse up to the Special menu item and click on the 
Paragraph Offsets ... item. Into the relevant fields of the box enter the 
following numbers: 

Spacing above paragraph -D Pts 

Spacing beloN paragraph -0 Pts 
-0 A line's lIiggest character 

sets MiniMuM line height 
-0 Include paragraph's last 

line in justification 

[I] 1 ~ancel 1 

I9.PPlYI~ 

Click on the OK button to enter the values. The first paragraph will now be 
redrawn to add an extra gap between the header and the following 
paragraph. 

Next, move the mouse up onto the Text menu and select the item Font 
Panel ... From within this dialog select a Swiss font (Swiss 721 or Swiss), a 
font style of Roman (if there is a choice) and a size of 10 Points from the 
points list. 

After setting the values, the dialog should look something like this: 

The Quick Brown Fox Jumps over the Lazy Do 

OCR-A ~ - ~ 

.;;::- I·~;;~ 
Zap! Humani,t I) 14 

~;~:.;~~c ~ 1280 m: 1114/H 1 
Po' e 

~ ShON 1 Hark I!!..~ 
[JL] 1 Cancel II""'-:-Lo-a-:-d,-,-, -'1 
c:i&]~ 

Select OK and the dialog will disappear from the screen. At this point you 
have set up some of the characteristics that you wish to form into your 
paragraph tag. 

Finally, to actually create the paragraph tag, click the mouse on the icon at 
the extreme left hand side of the ruler (the vertical bar with graduations 
on). This is the Paragraph Tag dialog. 
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Type a name into the Name field. Use something obvious such as Body 
T ext. Place a cross in each of the top three T ext sty 1 e switches 
(Include font, Point size and Text effect) by clicking on them 
and then click on OK to complete the operation. 

The new text style will now be available for use. To prove the point, move 
the mouse over the current paragraph style (currently No Tag), press the 
left mouse button and keep the button held down. A menu should now 
pop-up onto the screen revealing the new addition. Release the mouse 
button. 

Applying OJ Paragraph Tag 

To apply a style to a paragraph, it is necessary to move the text cursor into 
a paragraph, or to select multiple paragraphs as blocks. 

To apply your new text style to the whole document, move the mouse up 
to the Edit menu and select the Select All option. The whole 
document will become highlighted. 

Next move the mouse into the ruler region above the document and click 
and hold the left mouse button on the paragraph tag list. Move the mouse 
onto the name Body Text within the list and release the mouse. The Body 
Text style will now be applied to each paragraph in the document. 

r 

Interlude I 
At this stage you will have created a new document, formatted this ! 
document on the screen, imported some text, created and tailored a text 
frame, typed some text into the new frame and created and applied your 
first paragraph tag to the rest of the document - phew! 

Hopefully, you haven't found this to be hard going. 

To move on, you will need to use a few more paragraph styles. Rather 
than showing you how to create each one, the others are already provided 
on disk for you. You are now going to merge these in with your present 
document. 
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Move the text cursor to the very end of the document. Move the mouse to 
the File menu and select Insert ... once again. This time choose the file 
STYLES. PAP from the file selector. Papyrus will now merge the new 
document in at the end of the your existing one. You will now see the 
names, Bullet, Footer, Heading and Sub-Heading appear on the 
screen. 

These were necessary to carry the new text styles into the document. You 
may use the mouse to mark the new text and use Delete from the Edit 
menu to remove it completely once again. Please make sure that there are 
no extra empty paragraphs at the end of the document. 

Now move the mouse over to the paragraph tag list. Press and hold the 
left mouse button and you will now see a list of styles. 

,; No Tag 

Body text 
Bullet 
Footer 
Heading 
Sub-Head i ng 

Saving the document 

This may be a good point at which to save your work to disk if you 
haven't already done so. It is good policy to save work from time to time. 
This will help you to recover data should the computer lose power for any 
reason or in the unlikely event of the computer crashing. 

Regular saving to disk will always ensure that in the event of a mishap, 
rather than losing everything, the worst case is that you may have to re
load your document and redo a few minutes work. 

If you have already saved your document then select the Save option 
from the File menu, your file will automatically be updated. 

Otherwise, move the mouse to the File menu at the top of the screen and 
select Save As ... from the list. Give your document a name in lhe file 
selector, TUTORIAL ,PAP would make some sense and click on OK. 

Papyrus will now save your document to disk. When finished, Papyrus 
will ask you to register the new file name. Select Register from the 
dialog box on the display, this will cause the new file name to be accepted 
by the program and will be used in any future save operations. The 
filename will be reflected in the title bar of the document window. 

Tutorial Papyrus Gold Page 51 



formaffing the document 

The next part of the tutorial will allow you to see your finished document 
come much closer to completion and the form of the document will come 
together quite rapidly at this point. 

Move the I-Beam into the text frame at the top of the screen and then 
select the He ad i n g style from the paragraph tag list. The text will 
transform from the small characters to very large, bold, centred text which 
will be underlined. 

Next, move the text cursor down to the second paragraph which simply 
contains the text ,Editing. Now select the style Sub-Heading from the 
tag list. Once again the text will become bold and underlined - but this 
time it will remain relatively small and on the left hand side of the column. 
Repeat this procedure for the single line paragraphs titled DTP, Tables, 
Fonts and Printer Support. 

You may have noticed that a number of lines of text have a ] character at 
the start. They run in short blocks. Using the mouse, place the text cursor 
somewhere on the first line beneath the Editing sub-heading. 

Now press and hold the left mouse button and drag the mouse down to 
the last line in the block that starts with a ] (the line above the DTP sub
heading). Let go of the mouse button and the whole block should become 
highlighted. Move the mouse up to the paragraph tag list and select 
Bullet from the list. 

Papyrus will reformat the selected lines by indenting them in from the left 
edge of the text frame and will also expand the distance between the first 
character and the first word of the following text. Repeat the marking and 
tagging process for the similar lines beneath the DT P and P r i n t e r 
Support sub-headings, remembering to add the] character at the 
beginning of each line. 

Adding text eHects 

It is possible to add certain effects to text in a Papyrus document. Move the 
text cursor into the Text Frame occupied by the heading. Double-click on 
the word the to highlight it. 
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Now move the mouse to the Style menu and examine the settings. The 
Bold and Underline options are already selected. They are part of the 
paragraph definition for the Heading paragraph tag. 

You can add an extra effect to the text. Using the mouse, click on the 
Italic option under the Style menu. 

The text will now be redrawn to show the new effect which is only applied 
to the section of text which is marked. 

An alternative to using the italic style would have been to choose the italic 
definition of the font in which the text is displayed. However, bitmap 
fonts don't usually have an italic font set, even some outline fonts don't. 
The beauty of the Style menu is that these effects can be applied to any 
font, even if they don't support a separate Italic font definition. 

Inserting characters into text 

The document should be shaping up quite well by now, you are about to 
add another small embellishment. The indented pieces of text which you 
have just entered were called bullets. 

In short - a bullet is a section of text which has a distinguishing character at 
the start of the line. Bullets are used to highlight specific points or features 
within the text, a job which the] perhaps doesn't do too well! 

You are about to replace one of the ] characters with a more noticeable 
symbol. Using the mouse, mark the first ] immediately beneath the 
Editing sub-heading, thus: 

Now move the mouse up to the T ext menu and select the F 0 n t 
Layout ... option. A display will appear which will show a graphical 
representation of the computer's keyboard. 
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The text in the upper left hand corner of the display should read Dutch or 
Dutch 8011 Roman. If it doesn't, click on the font name using the mouse, 
the Font dialog will appear. Select the Dutch font from within the font list 
and then click on OK. The keyboard display will change to reflect the new 
selection. 

Now move the mouse into the top right hand corner of the display over 
the word Keyboard. Click and hold the left mouse button once and a 
pop-up display will appear. 

Move the mouse down to the word ASCII and release the mouse. The 
display will change to show a complete list of all of the characters which 
can be used in the current font. To the right of this list are two arrows, 
these are used to scan up and down the character list. Click on the lower 
arrow several times until the display refuses to change, the number 240 
should be at the bottom of the left hand column. 

176 
H2 ij D ? ? ? ? ? 

298 
224 
249 ±,,:s ( J 

I ~one I 0 Keep 

Move the mouse along the foot of this display and click on one of the black 
dots, preferably the one next to the square root symbol (character number 

r 

r-

r 

I 

250). Move the mouse down into the bottom left hand corner of the dialog , 
and click on the Done button. f 

The ] character will now be replaced by a . symbol. Papyrus has inserted 
a character which is not normally accessible from the keyboard in its J 
place. 

Using Search and Replace I 
Using the mouse, once again mark the area immediately beneath the I 
Editing sub-heading, thus: 
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j Now move the mouse into the Text menu and select the Search & 
Replace ... item. A dialog will appear on the screen. 

D IoIhole Hord D Ignore Case I Joker [7] I 
r-1-£e-a-rc-h-'IIReplace & Contll Rel!lace IIReplace fill I !;ancel I 

Using the mouse, move the pointer into the upper box marked Search. 
Now move the mouse over the pop-up menu currently labelled Joker. 
Press the left mouse button and select the right bracket (the lower of the 
two) from within the list. 

.; Joker [?] 
Tab !TAB] 
Return [CR] 
Page Break [PAGE] 
No break space [ ] 
Hi crospace [M] 
Soft Hyphen [-I 
Hyphen [N] 

Bracket [[] 

Anchor [ANCHOR] 
Data Field [DATI 
Footnote [FN] 
Page NUMber [II] 
Index Entry [I] 

This will now enter the text [ 11 into the search field. Characters enclosed 
between [ and 1 are special case search characters. 

Next, click on the button marked Block, to the right of the Replace field. 
This function will copy the whole of a block marked within the current 
document, into the replace field. In this case its a . symbol. 

HOMe 

r--_~D...,l4hole loIord D Ignore Case r:-~I=Br::ac=k~et=-;::::;:::=[~ll~1 
£earch IIReplace & Cont II Rel!lace IIReplace fill I I !;ancel 
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Finally, click on the Replace All button. Papyrus will respond with the 
following message: 

V Replace 27 occurances beloH 
the cursor? 
(Undo not available) 

I Replace II Cancel I 

Click on the Replace button. After a couple of seconds the screen will be 
updated to reveal that the Bullet paragraphs now have symbols in front 
of them. Papyrus has searched for occurrences of a bracket (1) and 
replaced each one with the appropriate symbol. 

flushing a Column 

At this stage, the chances are that there will be a small amount of text 
sitting on its own at the foot of the first column. This will be the start of the 
paragraph outlining the tabling facilities. 

It looks a little lost here on its own, detached from the rest of the text, so 
you will now put this to rights. Move the text cursor to the end of the 
previous paragraph and move the mouse to the Text menu and select the 
Column Break option. 

Immediately, Papyrus will force the Tables sub-heading from the bottom 
of the screen. It will re-appear at the top of the right hand column. 

Producing a Table 

Papyrus supports a very powerful table generating facility. You are about 
to apply a simple table to a piece of text which is already in the document. 

When generating a table, Papyrus expects to see each column of the text 
separated by a Tab and each row of the table separated by a Carriage 
Return. 
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Move the mouse pointer I-Beam to the left of the text Qty in the Table 
paragraph. Click and hold the left mouse button and drag the mouse to 
the end of the paragraph. It will become selected: 

Move the mouse up to the Special menu and select the Paragraph 
Offsets ... option. Set the spacing above and below the paragraph to be 0 
Pts and select the OK button. 

Spacing above paragraph eD Pts 

Spacing belo" paragraph 00 Pts 
eO A line's !!.iggest character 

sets l'Iinil'lul'I line height 
eO Include paragraph's last 

line in justification 

DO I.c.antell 
o:eeIU I Reyert I 

This text is currently defined as Body Text and you have just removed 
the inter-line spacing placed into the Body Text definition. 

Now move the mouse up to the Special menu again and this time select 
the Table ... option. You will see a large dialog appear. 

r Type g r:::l r+++l r:T:T:"l1:1: ~ ~ rAAl reEIl 
~L..:...JL.::::::::..IL..:.!.I...JL..:£..:..JL..:.!.I...JL.::!:!::..I1IiiilJ 

The Table format 'Types' 

Select the right grid type and click on OK. Papyrus will now create the 
table with a box around each cell. You may experiment with the box types 
if you wish. 

The table is initially placed over to the left of the text column. You could 
have entered an offset value in the dialog just now, but you are going to 
move the table using the mouse. 

Click and hold the mouse pointer on the very left hand edge of the table. 
The mouse form will change into that of a pointing finger indicating that 
you have successfully gathered the table. 
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Moving the mouse from left to right will allow you to centre the table in 
the column. When centred, let go of the mouse button. Click the mouse 
once somewhere off the table to return to the I-Beam mouse form. 

10·49 50· 100 

£650 £550~ 

£0.45 £0.40. 

£0.45 £0.45. 

Selecting a column 

The width of the table cells are a little disproportionate at present. By 
clicking and holding the I-Beam in one of the cells it becomes possible to 
drag a block around within the table. Individual cells or whole rows or 
columns can be selected in this way. 

As each cell becomes highlighted, so a small black square will appear on its 
right hand edge. This indicates that it can be resized, as with any other 
object. 

By clicking the pointing finger on one of these boxes, it becomes possible 
to alter the width of the marked cells. As you do so, you will notice that 
the width of all of the marked cells will change proportionally. 

Use this feature to widen the first column and to even the width of the 
second and third columns with the fourth. 

Finally, the text in the numerical fields looks slightly odd. It is hard up 
against the left edge of its cell. Select the final three columns as discussed: 

Next, move the mouse pointer up into the ruler area and select the Centre 
text icon. 
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Papyrus will now re-adjust the display accordingly: 

Qty .. '·9" 10·49" 50·100~ 

Boals .. £7.50 .. £6.50 .. £5.50 .. 

Pel'S" £0.50 .. £0.45 .. £0.40" 

Paper·clifX'l" £0.50 .. £0.45 .. £0.45 .. 

Importing a Picture 

The next step in creating the Papyrus sheet is to import a picture. This will 
help to add extra interest to the document and adds a point of focus. Well 
designed sheets can be eye-catching and a picture on a page will help to 
attract attention. 

On a more practical note, since Papyrus will allow you to manipulate the 
size of the image, pictures can be used to absorb those embarrassingly 
large areas of white space at the end of a document! 

To import a picture, move the mouse pointer up to the File menu and 
then select the Insert ... option. 

The now familiar file selector will appear on the screen. Select the file 
PAPYRUS. IMG from the list and then select OK. Papyrus will now proceed 
to load the picture into the document and will place it somewhere near the 
centre of the screen. 

At this point it will be possible to treat the picture as if it were any object. 
The picture will have move and size regions located around the edge of its 
frame. These will allow you to alter the size of the picture to suit your 
page. Clicking and holding the left mouse button on the picture will allow 
you to move the picture around the screen. 

You may notice how, as the picture is moved about the screen, the text 
underneath becomes obscured. This is because text flow around the 
picture is currently switched off. 

Another feature of the picture is that, although it is now part of the 
document, it has no specific place within the document. Sometimes this is 
desirable, a picture may be part of the background or may have no direct 
relevance to any specific piece of text, it may just be a centre piece. 
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HQwever, pictures are often used within documents as illustrations to a 
specific piece of text. As you have already seen from formatting the 
document, text may be shuffled back and forth across columns and pages. 

In the case of a mUlti-page document, it is imperative therefore, that such 
pictures are anchored to a paragraph. This will ensure that as the document 
changes, the pictures will not come adrift from their associated text. 

For the moment however, click on the picture once using the mouse and 
ensure that the frame is on display (the black drag bars appear around the 
edge). Next, move the mouse to the Db j ect menu once again and select 
the Attributes function from the list. 

him, 3051 Mill 

V0lm,47sIMM 

Gl~ Hrap around 
Left/right distance CJ MM 
Top/bottOM distance [c::::J MM 

o[J Text .i.gnares I<raparaund 
0[ ... ) Object height gra~s with text 
.. ~ p'ropartional resizing 
GlD ~haH only on screen 
s~ Rnchor object in 1ext o Only at paragraph start 

c:::KJ I.c.ancel I I For neH pictures I 
~ I Revert I 

Ignoring the dimensions at the top of the display, set the Text Wrap, 
Proportional resizing and Anchor options as shown. Instantly, the 
screen will be redrawn, moving any text out from underneath the picture. 

At this stage, the picture will anchor itself to the start of the closest 
paragraph. Should you pick up the picture using the mouse and move it 
around the screen, you will see a line extend from the top left-hand corner 
of the picture. The other end (the anchor point) will be seen to flit around 
the screen, trying to attach itself to a paragraph as it goes. 

Now move the picture so that it sits underneath the bulleted text of the 
Printer Support paragraph. Using the mouse, click and drag the 
bottom right hand corner of the picture out and down. Since you set the 
Proportioned resize option in the Attributes dialog, Papyrus will hold 
the correct widtM1eight ratio for you. 

Page 60 Papyrus Gold Tutorial 

f 

I 

I 

I 

L 



] 

] 

] 

J 

J 

J 

] 

J 

J 

Drag the picture out until it is about 60 mm wide and 70 mm deep. If you 
have a problem with this, the you may set these exactly from within the 
Attributes dialog once again. 

You will see that Papyrus is desperately trying to flow the text for the final 
paragraph down one side of the picture. If it weren't for the fact that the 
image would look too small for the page, you could make the picture 
smaller and let Papyrus get on with it. However, there is some space to be 
taken up here and you must tell Papyrus not to waste its time. 

This is achieved by putting an invisible barrier down the left and right 
hand sides of the picture. Once again, this is set from within the Attributes 
dialog - so get it up onto the screen now. 

The part of the dialog which is of interest to us now is the L eft / Rig h t 
distance. Enter a value of 10 mm first and see how the text flows around 
the picture. If text still insists on running down the side, increase this value 
slightly say to about ISmm and try again. ' 

Tutorial 

,r, I;:~:~:~ m:~mm,,~m:iibJetijjtirfbiites ":~~'~'~:::;:: ... ~ -
x"~1'I1'I Widthe~1'I1'I 
veKJl'I1'I Height .. ~1'I1'I 

e[ZJ "'rap around 
Left/right distance ~ 1'11'1 

Top/bottOM distance L=:J 1'11'1 

oil Text i,gnores I<raparound 
oi; Obje[t~eight groHs >lith text 
&[ZJ froportional resizing 
&0 ShOH only on screen 
.. [ZJ Anchor object in text 

o Only at paragraph start 

~ I J;ancel I I For He ... pictures I 
I apply I I Revert I 
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If the text located below the picture looks uncomfortably close, apply a 
Top/Bottom distance of say 2mm to bump the text lower down the 
screen. 

', ___ U~Idi!ltaJIllR 1lIy,tm~-p:na'P9.1Ip·to·JIJ -Dl.tIlu." 
.... .Pmlt·to·h1! ()l·IMG1icf1a:e .... 

i 1 

I From·~mphi3'6· to· p:JstelS, ·Pawns .can·do·tt ·all.. This i 
i tnuprfld.am .PlliIW . "" .,~" .'~"rri . PrrY"po;,;:nr. ~ ,Ttl:> .nn'" i 

The picture is buffered from the text 

Adding a Footer 

Many publications will put information at the top and bottom of almost 
every page. This information is often the same on each except for the page 
number. Such features are known as the header and the footer of a 
document. 

A special feature of headers and footers is that when set up, Papyrus will 
automatically place the information on each page. You only need to set up 

r 
r 
r 
r 

that information and to tell Papyrus which pages will show that 
information. Papyrus will also cope with swapping the information about I 
on each pair of pages. This is because, in a book, the page number is often 
placed on the outside edge of each page. 

You don't need anything quite that fancy at this point however! This is a 
simple, single page document, but the principals apply just the same. 

When creating the document earlier on, you removed the area normally I 
reserved for the header, but the footer was left. At the moment the footer 
is not visible on the screen. 

1 

t 
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Move the document up the screen to reveal the bottom of the text 
columns. Now place the mouse pointer immediately beneath the these 
columns and double-click the left mouse button. Papyrus will ask the 
following: 

V Go to footer area? 

I Cancel I 

Click on Yes and the screen will be redrawn to reveal an area which was 
hidden until now! A paragraph marker will be visible on the left hand side 
of the screen. Type the following text in at the foot of the display: 

Papyrus Gold [Tab] Page: [Tab] Date: 

Use the Tab key on the computer's keyboard, don't type in the word here! 
Also, place a single space after the page and the date. Now move the 
mouse up into the ruler area of the document window and click on the 
paragraph tag list. 

When you imported the paragraph tags earlier, a special footer definition 
was also provided! Select the Footer style and the text at the bottom of 
the page will be formatted automatically: 

The major point to note about the tag which you have just applied is that 
it uses a ruler to place text at the extremes of the screen and in the centre 
of the display too. 

Now click in the area just to the right of the Page text. You are about to 
tell Papyrus to start page numbering from here. 
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Move the mouse up to the S p e cia 1 menu and select the 
Special chars ... option. A dialog will appear on the screen. Using the 
mouse, select the Page Number option and then click on OK. The text will 
be followed by a symbol which represents that Papyrus will print the 
correct number for each page of text at this point. 

................................. _._ ... _ ..... 

.. .Page: .[jJ 

Now move the mouse pointer to the right of the Date text. 

.......... Date: 

Once again, click on the Special chars ... option from the Special 
menu. This time select the Cu rrent Date option. This will place what 
ever your computer considers to be today's date on the screen. 

,~ I.: :::'::d:::.i':,'ftriserfspecIiiTch"iiriiifer ";;;;;",,"" 

Date fDr~at: I 17 JAN 1994 

o .\I.ariable date 

@ Current .!late: 28 JUN 1"4 

o Jl.age nu~ber 

J!K I .cancel 

r 
r 
f 

I 

I 

You may also select the format in which the date is displayed. This is 
achieved by selecting an item from the Date Format pop-up at the top of 
the dialog. Choose a format to suit your taste. Click on OK to return to the I 
footer. 

.. ..... .Date: ·28·JUN .19911 I 
...................................... " ....................................................................................................... ! 

To return to the main document, click the left mouse button once in one of • 
the text columns and reply Yes to the resulting question. I 

Papy IUS Go kj Page: 1 Date: 23 JUN 1994 I 
The footer will now be displayed at the bottom of the page. Should you 
cause an overflow into the second page, Papyrus will automatically [ 
update the page numbering. 

t 
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The date you have chosen will remain fixed. Should you wish the date to 
change on a daily basis (i.e. to date stamp the document when printed), 
simply select the Variable date from the dialog instead. 

Ruling off 

As a final editing feature, you are going to add a special effect behind the 
footer. This will add more weight to the text at the bottom of the page and 
will help counter-balance the heavy text in the heading. 

Move back into the footer margin by double clicking below the text 
frames. Next, select the Pointer icon from the Toolbox to select the object 
mode. 

Click the mouse once on the footer text and the object frame will appear. 
Move the mouse up to the Obj ect menu and select the Fill Pattern ... 
option. The Fill dialog will appear. 

I b!!!!!!,IiiIiI"". 
Grey Leyel: rn Yo 

LJ Transparent 

c::::::liD I !;ante I I 
[iiliJ~ 

From the control strip immediately above the Grey Level dialog, select the 
second fill pattern in from the left. Papyrus will insert 13% into the grey 
level display. Now click on OK. 

The footer will now be displayed with a soft grey tone in the background. 
If it looks a little harsh at present, don't worry too much. When the tone is 
printed with the higher resolution of a printer, the coarse stipple of the 
screen will be softened. 
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Printing the document 

Providing that a printer has been correctly installed into the computer 
system, it will be quite straight forward to examine your efforts. Simply 
click on the Print ... option under the File menu. You will be presented 
with the Printer dialog. 

TUTORIAL, PAP 

DCopies 
@ .811 pages 
[gJ .Even [gJ Odd 

o Page 

Printer: I HP Laser jet 

to 
o .e.ackHards 

I 
Ouali ty: I Laser 300 x 300 dpi 

I Setup" , Special, , , 

I Print gueue", Print lob" , 

I Print I !!K I ];ancei 

First, select the appropriate output mode. The Printer pop-up will allow 
you to select the type of printer connected to your computer. If your exact 
printer is not listed, then use one which it emulates, or copies. 

The first time that you print the document, it may be wise to choose a I 
lower quality but faster print mode. This will at least allow you to proof 
read the document before committing a slow printer to (quite) a few 
minutes of hard work! 

When the printer and print quality controls are set, you may click on the 
Print button. Papyrus will now turn the page(s) on the screen into a I 
form ready to be sent as data to the printer. . 

Unusually, while printing, Papyrus will keep you posted of the print 
operation via an information box on the screen. Even more unusual is the 
fact that you will be able to continue to use Papyrus while its printing! 

There are a range of print options which can be selected from this dialog. 
These are discussed in more detail later on in the manual. Please refer to 
the chapter which outlines the Options menu, specifically the 
Printer ... item. 
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The finished page should look something like this: 

lPapyn.J!s GQ~d1 ~ the WQrd-Processor 
Papyrus is the powerful easy-to-use word processor for an 

ST;STeffi and Falcon030 computers. This package makes 

use of extensive text processing and DTP facilities to 

enable you to create professional looking documents 

effortlessly. In addition, pictures can be imported to 

enhance any publication and no business should be 

without Papyrus' table generating features. Just look at 

some of the features which are on offer; 

6lI.Ww!. 
Drap, nnd Drop. 
WYSIWYG (what you see is what you ~.t). 
Full te":t «tiling al every level of zoom. 

Search and Replace including character allribules. 
Reliable undo facilities. 

Automatic hyphenation. 

Headers and Foolers.. 
Paragraph styles for a quick, easy and consistent look to your 

document. 
AUlonlalic t3hle of contents (from pamgraph stylinEl. 

Easy lind powerful indexing capabilities. 
Fullmllrgin control. 

Intelligent cui nnd paste (block operations lake care of the 
corrC'Ct number of spaces). 
Discontinuous block operations (block parts do not havc to be 
connected) 
Zoom from thumbnail up 10 printer resolution and higher! 

Optiomll writing from right to Icft. 

Portrdit and landscape modes. 
Preely adjustable paper fOrImlls for labels etc. 
Tt'.'tt ol~ects are freely sizeable, editable. movable and 

rotatable 
Supports siulIl, and moving of vector objects. 
Lellcx microspacing in all directiollS. 
Read and write RTF files for cross platform compatibility 

GEM \'Cctor object import. 
Mastl'"T pages (anything on II master paee will apPI'"ar on all 

pap,es in the document). 
Text objecl chains and automatic lext fl~· around ohj!.'cls 

Editing is as friendly as it should be. with modern 

non-modal dialog boxes. so that. for example. you can 

keep the search dialog open while editing some more text. 

Papyrus supports sophisticated tabling whidl also includes 

powerful spreadsheet cell manipulation. 

Clty 1-0 10-4Q 50-100 

Books £7.50 £6.50 £5.50 

Pens £0.50 £0.45 £0.40 

Paper clips £0.50 £0.45 £0.45 

High quality font support is provided through the use of 

SpeedoGDOS scalable and GODS 1. 1 and Signum bitmap 

font systems. Papyrus will aliOlN all three systems to be 

used simuttaneously. assembled into logical font families. 

Printer SupPOrt 

Papyrus boasts exceptionally flexible printer support. giving 

you full control over every aspect of the printing process. 
Printing options also support: 

Uscr definable print resolulion. 
Full supporl for printer escape codes nmh~$ it (,~Isy 10 lICCCS~ 
printer specific functiollssuch as colour 
User definable page sizing - print pages up 10 A3 in size. 
Prinllo file or IMG piclure 

From pamphlets to posters. Papyrus can do it all. This 

powerful and easy to use Word Processor is the only 

choic~ for both the professional and home user. An intuitive 

easy-to-use interface makes complex operations a 

pleasure I 

Papyrus Gold Page: 1 Dale: 28 JUN 1994 

We hope that this tutorial has shown you just what Papyrus can do in a 
few simple, yet powerful, steps. 
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The rest of the manual is dedicated to the detail of using Papyrus - those 
new to word processing should read the text at least once while the more 
experienced user can use the !Reference sections for looking up particular 
commands and concepts. 
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Papyrus Reference 
The Tools 

] The Toolbox 

] 

J 

J 

] 

J 

J 

J 

The toolbox is a vertical group of icons usually in the top left corner of the 
Papyrus desktop. If required, the toolbox may be moved by simply 
dragging on the grey box at the top of it. If the toolbox is obscured from 
view by another window or dialog, the toolbox icons can also be found at 
the top ofthe Obj ect menu. 

To select a toolbox icon simply click on it with the mouse or select it from 
the Ob j ect menu. 

The frame Edit Icon 

Selecting items from the toolbox changes the way mouse actions work in 
Papyrus. Selecting the icon at the top of the toolbox puts Papyrus into 
Frame edit mode. 

The frame edit mode is used for the selection and manipulation of a frame 
or frames. To select a frame simply click on the frame edit tool then on the 
object in your document that you want to select. Once selected, a box will 
appear around the object; at the corners and midpoints of the frame, 
sizing handles will appear. By dragging one of the handles, you can resize 
the object selected. If the object you are resizing is a bitmap or metafile, 
you can maintain the objects aspect ratio by holding the Cont rol key 
down while dragging the handle. 
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You can also move the selected frame by clicking inside the frame and 
moving the mouse with the left mouse button held down. 

To select multiple frames within a document drag the mouse across the 
frames with the left mouse button held down. All frames in the defined 
marquee will be selected as a group when the mouse button is released. The 
selected frames can then be dragged around the screen with the mouse; 
selected frames can be dragged to position objects within a document, to 
the shredder or to other open documents. 

Selected frames can also be deleted with the S hi f t Delete key 
combination. A frame may be ungrouped by clicking inside it; it is then de
selected. Groups of frames or individual frames are de-selected by clicking 
outside the frames. 

Anch@rs 

Whenever an object is placed onto a page in Papyrus, it is said to be a free 
object. This implies that the object is not relevant to any specific part of the 
text and that it may be moved around within the document freely and 
independently of every thing else. 

Because of this, any text which moves as the result of standard text flow, 
may move away from an object, especially if it is forced onto another page. 

However, it is often desirable to link an object to a specific piece of text. 
This is especially true when a picture is imported into Papyrus as an 
illustration to a descriptive paragraph. In this case, it becomes important 
that the text and picture do not come adrift from one another. 

This is achieved within Papyrus through the use of an object anchor. As its 
name suggests, this will lock an object, any object, to a specified paragraph 
of text. 

When an object is initially placed onto a page, its anchor will be turned off. 
To switch it on, simply select the object using the mouse in object mode 
(with the mouse pointer as an arrow). 
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Once the object is selected (it has an outline with small boxes in each 
corner) move the mouse up to the Obj ect menu and then select the 
Attributes ... option which will appear beneath. The object attributes 
display will look something like this; 

,) ~iiiliiiiiil!i!i!m~m!~~~roiiJettAHrliijjtes m~mm;iiii!!i,!:!~i!m~!m! 

X"~ MM Width "~MM 
y,,~ MA Height "~IU'I 

,,0 !lrap around 
Left/right distance [P. i IU'I 

Top/bottOM d I stance i(::] MM 

o[] Text .i.gnores wraparound 
or] Object height groHs with text 
,,0 I!roportional resizing 
,,0 ShaN only on streen 
.. 181 Anthor objett In lext 

o Only at paragraph start 

[IJ I J:antel I I for neN pltturesl 

DilliiJ ~ 

Move the mouse to the box titled Anchor obj ect in text and click once 
to place a cross inside. Finally, move the mouse onto the OK button and 
click once more. This will remove the display from the screen. 

It should now be possible to see a picture of a small anchor somewhere 
close to the object; 

the Anchor symbol 

If not, then it will be necessary to enable this display. This is achieved 
through the Screen Display dialog, found under the Options menu. 

o 11~~~~!~!~:~mm Dqcul'lent Screen Dl 

I r: OptiMize Streen Display for x ~ 
o liEH-fonts "0 x '0 DPII 
® SlgnulI!2 fonts ('0 x 108 DPII 

Objett Handles DGa~ 
Unit I HllliAetres I 

ShaN ••• 
o RedraN objetts abo~e text o Left Hargln o I!lttures o Text and pltture fraMes 
181 Objett anthors, SYMbols o Spates, Tabs, Return o lase Lines 

I .!1K I I Gantel I 
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Using the mouse, click on the box marked Obj ect Anchors, Symbols. 
When this is done, click on the OK button at the foot of the screen. The 
anchor should be visible now. 

Anchor position 

The positioning of the anchor will depend upon a number of things. From 
within the Attributes dialog, both the Wrap around and Only at 
paragraph start options will affect this. 

Papyrus will initially attach the anchor to the end of the closest paragraph 
on the immediate left or above the object. In the case of a Text frame or 
Box, if the object appears over text, then the anchor point is made at the 
base of the character closest to the centre of the object. 

This isa piece of test 
ext todemo.[1stratethe 

way in which Anchors 
iworkin paragraphs ... 
I 

Providing that the Anchor Only at start of paragraph attribute is not 
selected, then an object can be anchored to any character within a block of 
text. In this case the point is on the left hand side of the baseline of a 
character on the screen. 

Moving the Anchor 

As an object is moved around a page, so Papyrus will move the point in 
the document to which it is anchored. This will be witnessed as a line 
extending from the position of the grabber (the mouse position) to some 
point in the document, this is the anchor line. In the case of a picture, the 
anchor line will always extend from the top left hand corner of the picture 
frame. 

As the object is moved, so the anchor line will be seen to jump around the 
screen. At all times, this is trying to hold onto the closest piece of text that 
it can. 

If the Anchor Only at start of paragraph attribute is selected, then 
the anchor line will move to the start of the closet paragraph to the left or 
above the grabber. 
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In the following example, the text at the top of the screen is the last 
paragraph on the page. In this case, Papyrus has had to reach across the 
paragraph to place the anchor. 

..... "--,." .. " .. ,,, .... ,.", .. ", .. , ...... " ..... ", .. "" ........... , .. "I 

~is.isa.piece.oUest 

Ite~odemonstratethe 
iwaYI whichAnchors 
Iworkin ragraphs., 

Please note that as always, a blank line is still treated as a paragraph by 
Papyrus. It is therefore possible to anchor objects to empty paragraphs. In 
the following example, a carriage return has been placed after the last line 
of text. 

, ................. " ............. " ............ " ............................ "'." ....... -............. . 

!Thi sis a. pi ece oUest 
!textto demonstrate the 
iwayin which Anchors 
Iworkinparagraphs., 

When moving the object, the anchor will now latch onto the closest 
paragraph which is immediately to its left. 

It is possible to select the T ext W rap mode from within the Attributes 
dialog box (from the Obj ect menu). With this mode selected, Papyrus will 
flush all text from under the object and will attempt to flow the text down 
along one side and underneath the frame. 

With Text Wrap enabled, it will only be possible to move the anchor to 
the start of paragraphs. If the Anchor at start of paragraph mode is 
not selected for an object with text wrap, then Papyrus will select this 
automatically. 
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Anchoring & Tables 

When creating a table, Papyrus will anchor each row at the far left of the 
text column. It is not possible to alter the status of table anchors in any 
way, nor is it possible to move tables freely around the screen, they can 
only be moved from left to right within the text column. 

The Text Mode Icon x 
The next icon down is the Text Mode icon. Click on it to select, then click on 
the document page or in a Text Frame (see below) to type text in the 
frame. A vertical line cursor appears at the point where text may be 
entered. 

The Text Frame Icon A 
This icon is used to create a text frame. 

Click to select then, holding down either mouse button, drag the cross 
hairs until the frame is the desired size. Release the mouse button and the 
text mode is automatically selected. The frame may be moved, resized or 
shredded by selecting the Frame Edit Icon. Double-clicking on the A Icon 
brings up the Font Panel. 

The Object Icon 

The Object icon is beneath the Text Frame icon. This is used to create an 
Object Frame. The frame is drawn in the same way as a text frame. 
Double-clicking on the icon brings up the Fill dialog. See under ObJect 
Menu below for the various options. The frame may be outlined. See 6.ine 
Style ••• in the Obj ect menu for details. 

The Line I(;on 

r" 

I 

I 

Clicking on the Line Icon enables a straight line to be drawn. ( 

Double-clicking on it brings up the Line Style dialog (see below). Note that 
the options selected in this dialog affect the borders of object frames as ( 
well as lines. t. 
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Lines are drawn by dragging the mouse whilst clicking and holding down 
the left button. If a shift key is held down whilst dragging, the line will be 
perfectly vertical or horizontal. Lines are deleted by clicking on the Frame 
Edit icon, clicking on the line to select it (handles appear at each end) and 
dragging it to the shredder. 

The Ruler and the Ribbon 

.~ EXAMPLE.PAP [+] 
0 1 2 3 4 5 6 7 8 9 110 11 12 113 14 15 16 1 0 

[)I No Tag I a~~~ [IJ1!HiIG ~1.4 I : Im1I~ Page 11 lIT 
~ 

¢I :::::::::::::1 ~ III 

The Ruler runs across the top of the page and consists of - well, a ruler. The 
units of measurement may be changed using Screen Display in the 
Options menu. A vertical ruler is also available. If either or both are not 
on screen, they may be selected them by choosing Ruler and Vertical 
Ruler under the Options menu. Removing either or both of them from 
the screen leaves more room for the document. 

Beneath the ruler are the margin and indent symbols. The triangle 
symbols determine the left and right margins of the text within a frame 
and may be dragged along the ruler with the mouse, holding down the 
left mouse button. 

The circular indent symbol defines an indent. If dragged to the right of the 
left margin symbol, the first line is indented. If the left margin symbol is 
dragged to the right of the indent symbol, a hanging indent is produced, 
where all lines after the first are indented. Margins, indents and tabs are 
related to paragraphs and frames. 

Beneath the ruler line is a horizontal row of icons called the Ribbon. Each 
icon may be selected by clicking on it. We will now describe each in turn 
from left to right. 

Paragraph Tags 

Papyrus supports a very important and powerful concept - that of 
paragraph tags. That is to say, you can attach, or tag, a pre-defined style to 
any paragraph, within your document. 
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The ability to store a number of different tags in the computer will allow 
you to change the appearance of text at will. This is made possible by 
moving the text cursor into a paragraph and selecting a different tag from 
the list. Papyrus will immediately apply the new text format to the 
paragraph. 

Because you can assign tags proper English names, it should be possible to 
recognise each tag by a meaningful description. For example; Heading, 
Sub-Heading, Indent, Main Text etc. 

Tags can be assigned a number of properties. First of all, every tag has a 
ruler attached to it. This will contain all tabulation and justification 
information necessary to display this text in a specified format. It will also 
contain any line and character spacing, colour, font style, font size and text 
effects (such as Bold, Italic etc.) 

The Tag controls 

The main paragraph controls are located in the Ruler area, at the head of a 
document window. 

B 1. 2 :5 4 5 6 7 8 9 1.0.11. 1.2 1.3 14 15 1.6 17 .18 19 20 21. 22 23 

the Document Ruler 

The two items on the far left hand side of the ruler are the paragraph 
controls. 

~ I No Tag 

the Paragraph Controls 

These two controls do different things and are used in very different ways. 
The small icon on the left is used to create paragraph tags, the display to 
its right is in fact a pop-up menu and is used to select a tag for a 
paragraph. 

The Tag Creator 

This very insignificant looking icon is the key to creating your own 
paragraph tags - a fundamental and powerful feature of Papyrus. Clicking 
on this icon will make Papyrus display the Paragraph Tag dialog. 
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The Tag Selector 

The Tag Selector is located next to the Tag Creation icon. 

I No Tag 

The exact wording in the display will vary. As you move the cursor 
around your document, this will change to reflect the style tagged to the 
current paragraph. 

Applying a Tag 

To add a paragraph tag to an area of text, or to change an existing tag, 
firstly move the text cursor into the paragraph in question. Next, click and 
the hold the left mouse button on the Tag Selector. Providing that the 
document contains at least one style, the tag list will then appear on the 
screen. 

./ No Tag 

Body text 
Bullet 
footer 
Heading 
Sub-Heading 

a typical Tag list 

To select a paragraph style, move the mouse down to the required tag and 
release the mouse button. The tag will be applied to the chosen paragraph 
straight away. Papyrus will reformat not only the new style, but if 
necessary, it will also adjust the whole document from the new style on, to 
accommodate the text. 

Importing Tags 

Paragraph tags can be added into the Tag List in two ways. First, as new 
tags are created using the Tag Creator, so the list will be updated to include 
new styles. The second way to add to the list is by importing text from 
other Papyrus or RTF format documents. 

When importing text, Papyrus will scan the incoming file and will look to 
see which paragraph styles are used. The used styles will then be added to 
the list and the imported text will preserve its old format. However, tags 
which were not applied to imported text will be lost. This is done 
deliberately to prevent the Tag List from becoming populated by many 
unused styles. 
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Creating a Tag 

Tag creation is quite straightforward - it may not look like it at first, but it 
is! The thing to remember is that there is nothing magic about what 
Papyrus does here. Each time you apply a tag to an area of text, all it does 
is to recall a series of settings from its memory and then applies them to 
the paragraph. 

Therefore, to create a tag, all you need to do is tell Papyrus what those 
settings are and give them a collective name. This is achieved using the 
Paragraph Tag dialog which acts as the central control for tag generation. 

To create a new paragraph style, click the left mouse button on the Tag 
Creation icon. Papyrus will display the Paragraph Tag dialog. 

Hallie II 

I Delete I I Hark 

Apply text style 

D Text style gxceptions 

Text style sllli tches 
D Include font 
D faint size 
D Text effects 
D Colour 
D Hyphenation 
D Spacing 

r 
Table of Contents 
D Insert In table of contents I 

Z Include page nunber lIable of Contents ••• I 

C]LJ I ,Cantel I 
[Ji!U I Revert I 

Once in the dialog, there are two possibilities: 

1) 

2) 

Page 78 

The Name box in the top left hand corner of the screen is blank. 
This will occur when the Tag Creation icon was selected with the 
text cursor in an undefined paragraph. That is to say that the area 
of text had No Tag. In this case it will be necessary to enter the 
name of the style which you are about to create. 

The Name box is not blank, in which case this is the name of the 
tag in which the text cursor was sitting when the create icon was 
selected. There are now two further possibilities. 

a) You may edit the existing tag by changing one or more 
aspects of the style and telling Papyrus to update this tag. 
When complete, returning to the document will cause all 
paragraphs which are formed with this style to be updated. 
Clearly this can make quite a dramatic change to a 
document, especially if the tag is quite heavily used! 
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b) You may replace this name with that for a new tag. In this 
case the new tag will inherit all of the old characteristics. 
You may then make as many changes to the new tag as you 
like, but if you don't, you will have two tags which are 
absolutely identical, this is a waste and is not recommended. 

Using the fag Creator 

When applying a paragraph to a piece of text, Papyrus may need to 
remember many things. For example, it may need to recall a particular 
font, font size and font type. So you click on the buttons in the T ext 
Style Switches to tell Papyrus that these are part of your new tag: 

Text style s"itches 
rgJ Inc! ude font 
rgJ foint size o Text effects o .c.olour o !!yphenation o Spacing 

Now you need to tell Papyrus what font you wish to use and what 
physical size it's to be. Move the mouse up to the Text menu and click the 
mouse on the Font Panel. .. option. The tag definition screen is now 
joined by the font selector. 

Paragraph Tag 

HaAe Il1y He" Tag 1 

I l!.elete I I Hark 

I Apply text style 

o Text style gxceptions 

Text s~~ 
rgJ Incluu 
rgJ foint o Text e o .c.olour o Hyphen o Spacin 

o Insert in table of content~ r 
Table of Contents 

Vi Include page nUMber~ II~a':"":bl""e -o':""f ':"co~rl 

c::::i:J I.c.ancel I 

r::i2IiJ I Revert I 

~, Imm~iruii':r:i~i!iili!miii!iiirtiinfiiaiiel . ~mili'!ilm!iili!~mmm~rn~ 

The Quid< Brown Fox Jumps over the Lazy Do 

OCR-A 9 - 9 
Poster Bocioni "'" [halic 1-
::,,:.u. roc I·!: :~: nalre ~ 

~~:~~::i't I e~~ i~~nti 
ZapfCaltigraphic r.- 18 5: W/H 
Zol'Jt""""l' ere ~ 20 "":':' D Po' e 
rgJ Sho" I !'lark I ~~ 
[Jj[J I Cancel II .... -:-L-oa"":"d-.. -, ""1 
I Apply I 1 Revert I 

You are now free to make any choice you like from within the new dialog. 
When you are satisfied, simply click on OK to remove the Font Panel from 
the screen, or on Accept which will leave it open. If you leave the font 
dialog open, then you will need to click on the Paragraph Tag dialog once 
to bring it back to the foreground. 
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OK, you've defined the font characteristics for the style, but you also want 
the text to be underlined. Well, select the Text effects button in the 
Text style switches first... 

Text style SMitthes 
~ Inti ude font 
~ faint size 
~ Text effetts o !:.alour o Hyphenation o Spating 

r 
r 
r 
r 

... and move the mouse up into the Style menu and select the 
Underline option. This is now part of the tag definition also. I 
By now you might be getting the idea. To define a tag, you simply apply 
all of the relevant effects to your document, while the Paragraph Tag dialog I 
is open and then tell the dialog to accept them as styles to be applied to 
the named tag. The Tag dialog simply sits and watches what you are doing 
to the document, recording the significant actions, so it can automatically I 
apply them all for you at a later time. 

Tag Rulers I 
The one notable exception to this use of the dialog is when it comes to 
defining a ruler. This is because, if nothing else, all tags have a Ruler. The I 
ruler taken is that in use when the tag was originally created. 

B .1 2 3 4 5 6 7 9 1.0 11. 12 13 14 15 16 17 18 .19 

[]I Bullet 

the relevant Ruler characteristics 

In actual fact, this includes everything that was set in the ruler area when it 
was created (except the page - a tag can't be tied to a page!) 
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Tag definition controls 

The following is a detailed discussion of each of the tag definition controls. 

General 
NaMe II 
I Delete I I Mark 

Apply text style 

D Text style gxceptions 

These controls are grouped together in the upper left hand quarter of the 
panel and most apply to the management of the tag list. 

Name 

This is the name of the current tag. It is possible to change this using the 
normal cursor and Backspace/Delete keys to alter the display. In this 
way it is possible to clone existing tags and make subtle changes without 
having to redefine the whole tag from scratch. 

DeOete 

Remove the currently named tag from the document (and the tag list). 

Starting from the beginning of the document, search through the whole 
document and mark all paragraphs which are tagged with the named 
style. 

AppUy Text StyUe 

Accept the formatting which has so far been applied to the tag definition 
whose name is currently in the name box and add it to the tag list. 

This avoids the need to exit the dialog in order to change the tag name 
only to have to re-enter the tag definition again. You can change the tag 
being edited by simply typing its name into the Name display. 

Text Sty8e Exceptions 

This cunning little button determines if the named style will be allowed to 
have other effects applied after the paragraph is tagged. 
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For example, if the exceptions are enabled within a tag which has, say, r 
underlining as part of its definition, then when you apply that tag to" a 
paragraph it will be underlined. However, at a later date you might choose r. -
to select a word in that paragraph and italicise it. With this option on, 
Papyrus will not object, with it off however, Papyrus will ask if you wish 
to add the italic effect to the Tag definition, or if you wish to remove the 
Tag from the paragraph altogether. r 
Text Style Switc:hes 

Text style s",1 tthes 
D Intlude font 
D ~oint size 
D Text effetts 
D ~olour 
D !!yphenati on 
D Spating 

The Text style switches are a cluster of status buttons which tell 
Papyrus that you wish the tag to inherit the current settings within the 
document unless deliberately overridden by an external control. 

Nndude font 

When applying the tag to a paragraph, change the font. Please note that 
when dealing with outline fonts, this also includes the font style, such as 
Roman, Regular, Demi, Bold-Italic etc. 

Point Size 

When applying the tag to a paragraph, change the font size. 

TexteHeds 

Selecting this will cause Papyrus to note the text styling which has been 
set from within the Sty 1 e menu. When the tag is applied to the 
paragraph, the chosen effects will also be applied. 

This will override any effects which exist within the paragraph before the 
tag is applied. 

If this is selected, then the colour of the current text or that selected from 
the Colour dialog will be carried into the definition. 

When applying such a tag to text, the colour will be applied to the 
paragraph, otherwise the colour will remain as it was before the tag's 
application. 
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Hyphenation 

A definition with this selected will allow the global hyphenation status (set 
in the Special menu) to be recognised for the current paragraph. 

Please note that it is possible to assign tags different language 
hyphenation rules! 

SpOcOIl1I9 

With this selected, letter and word spacing is remembered, as are the 
paragraph offsets. The most useful application for this is to force Papyrus 
to leave a minimum gap above and below paragraphs so the they do not 
appear to run into one another for the reader. 

Generating a Table of Contents 

Papyrus provides a very easy and flexible system for the automatic 
generation of tables of contents. 

Overview 

Entries from a document file (or files) are written in to a table of contents 
file. The generation of the table of contents file is controlled by paragraph 
tags in the document file. If a paragraph tag is marked for inclusion in the 
table of contents, then each paragraph with that tag is entered in the table 
of contents. The table of contents lists all such paragraphs, in the order 
that they appear in the document. 

Page number 

For each named paragraph tag included in the table of contents, the page 
number in the document file may be set to be included or not, as required. 

Shadow tags 

When the table of contents is generated, each entry is given the same tag 
name as it had in the document file. These table of contents tags may be 
adjusted as explained below. 
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Setting entries 

An entire paragraph appears as an entry in the table of contents by virtue 
of its paragraph tag. 

Generation 

A table of contents is generated by the following procedure: 

Procedure J 
Q 

• 

Open the document whose table of contents is to be generated. 

Select the paragraph tag dialog (click on the vertical ruler at the 
side of the tag indicator) . 

., Select Table of Contents (AI t-T). 

.. A confirmation box appears . 

., The table of contents appears in a window labelled Table of 
Contents for .... 

., Amend and re-style the table of contents file if necessary. 

e Save the table of contents file and print it if required. 

Consecutive page numbers 

If the document file is to' have consecutive page numbers within its table of 
contents file, then a modified procedure is required. The table of contents 
is generated twice. The page numbers of the document file are adjusted 
after the first table of contents have been generated so that the table of 
contents and the document file keep their page numbers in sequence. 

Procedure 2 
., 

.. 
As for Procedure 1 above until: 

The table of contents appears in a window labelled Table of 
Contents for .... 

o Amend and re-style the table of contents file if necessary. 

o Save the table of contents file. 
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o 

Adjust the start page number of the document file so that it 
directly follows the last page of the table of contents file. 

Perform Procedure 1 as given above. 

The double process ensures that the page numbers align, assuming that 
the table of contents file has the same number of pages on both occasions. 

Multiple file documents 

The table of contents for a multiple component file document is generated 
in a similar way to that described above, by opening each file in their order 
in the document and then adding their table of contents together. 

The general process is: 

o 

o 

o 

o 

o 

o 

Open the first component file of the document whose table of 
contents is to be generated. 

Select the paragraph tag dialog (click on the vertical ruler at the 
side of the tag indicator). 

Select Table of Contents (AI t-T). 

A confirmation box appears. 

The table of contents for the first component file appears in a 
window labelled Table of Contents for .... 

Close the first file, but not the window labelled Table of 
Contents for .... 

Now load each further component file, in strict sequence, generate 
its table of contents as described above and close that component 
file's window. 

After all component files have been processed into the open table 
of contents window, amend and re-style the table of contents file 
if necessary. 

Save the table of contents file and print it if required. 

If the multiple file document is to have consecutive page numbers within 
its table of contents, then a two stage process will be necessary, similar to 
that described above except the start page number of each component file 
must be adjusted. 
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Table of contents styling 

By default, the paragraph tags of the table of contents file are copied from 
the first document file. When the table of contents is generated, Papyrus 
searches for a template file called _CONTENT.PAP, according to the 
standard template search order (see Template in the next chapter). If this 
is found, then that template will be used to generate the table of contents 
file. The names of the tags in _CONTENT. PAP should match those used in 
the document file. 

We have supplied a default _CONTENT. PAP file, you are free to amend this 
or generate your own template. 

Page numbers 
Page numbers are automatically entered into the table of contents 
preceded by a Tab, which may be used to align them. A right hand tab 
frequently gives a pleasing layout. 

Manual adjustment 

The tags in the table of contents file may be adjusted in the normal way. 

Multiple file doc:uments 

When dealing with multiple file documents, the template file procedure is 
highly recommended. 

Notes 

Document organisation 
At the start of a project, decide on which tags are to appear in the table of 
contents: 

o 

o 
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For a novel, there could be a tag Chapter which is the only tag to 
appear in the table of contents. 

For a more ambitious novel, there could be tags Part and Chapter 
which are the only tags to appear in the table of contents; The 
novel is organised as a series of parts, within each of which are a 
number of chapters. 
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o A technical manual could have tags Chapter, Heading, 5ub-heading 
and 55-heading which appear in the table of contents; Page 
numbers might be suppressed for 55 -heading. 

The general principle is that the organisation of the document assists the 
reader to navigate their way around. The tags mirror that organisation. 
Each chapter, section or whatever is preceded by a single paragraph with 
an appropriate tag. That paragraph appears in the table of contents. The 
main body of the document uses tags which do not appear in the table of 
contents. 

The tag styling for a table of contents will usually require a smaller point 
size and less paragraph spacing than for the equivalent entries in the 
document file. If there is more than one level of heading in the table of 
contents then the table of contents' tags should be designed for extra 
clarity. Often this means added space above chapters, so that each chapter 
entry can easily be found. 

Chapter comments 
For a new-fashioned old-fashioned look, you can have a set of chapter 
comments immediately after each chapter heading in your document. Use 
one tag for the chapter and another for the chapter comments. Set both of 
these tags to appear in the table of contents. Set the chapter tag to include 
the page number and set the chapter comment tag to exclude the page 
number. 

Table 01 figures etc .. 

In principle, a separate table of figures for a document can be prepared by: 

Assigning paragraph tags to a document, induding a tag 
specifically and uniquely for use for titling figures. 

Setting the titling figures tag not to appear in the table of contents. 

Preparing a table of contents in the usual way. 

Changing the tags such that no tags appear in the table of 
contents. 

Changing the titling figures tag to appear in the table of contents. 
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Preparing a second table of contents for the figure titles. 

Carefully adjusting page numbers as required (but see below). 

Document design 

The more complicated your document, the more important it is to 
establish a consistent design at the start of the project. 

Page numbering (f@lios) 

If you are preparing a book or a similar project, it is often a good idea to 
give the table of contents roman (i, ii. .. ) folios (page numbers are known 
as folios to the publishing trade) and the body of the book arabic (1,2 ... ) 
folios. This avoids the problems of folio adjustment as the document is 
edited and the table of contents is required to change size. The more 
component files there are and the more complicated the arrangements are, 
the more useful this method is. 

Justification 

The next four icons on the ribbon determine paragraph justification. From 
left to right they are:- Left justify, (ragged right margin), fill justify (both 
margins straight), centre justify (centres each line) and right justify (the 
cursor moves to the right of the frame and typing moves the text to the 
left, leaving a ragged left margin). 

If a paragraph is selected, or the cursor is placed within a paragraph and a 
justification icon is clicked upon, the selected justification effect will be 
applied to that paragraph. 
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Tabs 

~ll ~llllllllmlllllllmllllmllllll!I!1111111111111111111111II *U n tit 1 e d !!!!!!!!!!!!!!llllml!!m!!m!II!!!!III!!m!!!lm!!m!!! [+] 
0.l1.1~13.14.15.1~.l7.18.19.1~~lgl~~lqI1~11~1~~IFI1~119.IQ 

... • .,.. t-

~I No Tag ~ liI~~~ [I\I~J[II[!] 

r=iL~'i~b':~'t':~~'~""""""""""'''''''''''''''''l 
___ Wglhl.1t.Talb.a1i:.l!.QP.clIlJ1l, 
___ Centre.tab .at.11cm, 
I __ notice Jf>wthis .balances 
! ___ aroundthe .tab.marker, 

IDecimal.tabs, 
ifor .number .columns, 
I 3.142, 
____ +542.230, 

·264.360. 
I.--Total.= ·281.012, 

tabs in use 

Tabs are used for precise positioning and formatting of text within 
paragraphs; the use of tabs is particularly useful when attempting to 
format sections of text that are required to have a different format to that 
of the general page setup. This may include indenting the first line of a 
paragraph, setting indented margins on the left or right of the page or 
aligning a column of figures about a decimal point. 

The Tab icons are used to set tabs for the paragraph in which the text 
cursor is located, or from the cursor position if no text has been typed in 
the paragraph. From left to right they are, left tab, centre tab, right tab and 
decimal tab. Clicking on the decimal tab icon brings up a dialog requesting 
a decimal symbol. In UK this is normally a full stop, whereas in many 
other countries a comma is preferred. 

Tabs are selected by clicking on the appropriate icon and dragging it onto 
the ruler to the place required. A line appears on the screen to help in 
positioning the tab. 

Pressing the Tab key sends the cursor directly to the first tab. Pressing the 
Backspace key will delete text and then return the cursor to the previous 
tab position, or the left margin. 
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You can insert a tab in a number of paragraphs at once by selected the 
paragraphs first and then adding the tab. 

A tab may be moved by clicking on an existing tab and dragging it to the 
new position. It can be removed by dragging it outside the ruler. 

Care should be taken to ensure that text does not overlap onto a 
neighbouring tab position, otherwise the text will not be correctly tabbed. 

Left Tab 

Use left tabs to position the left side of a paragraph flush to the right hand ( 
side of a tab marker. I 

Centre Tab I 
Centre tabs are used to position text centrally around the tab marker such 
that when entering text, the text will always be balanced either side of the I 
text marker. 

Right fab 

As text is entered, existing text is moved to the left. 

Decimal Tab 

Decimal tabs are used to accurately line up decimal numbers such as sums 
of money. The position of the decimal tab defines where the decimal tab
separator will be placed. 

Normally the decimal tab is the full stop or period, but this can be changed 
by double-clicking on the decimal tab icon. This will display a dialog like 
this: 

mm:::mm Tab Detil'lal Seoarator ii':::':"!':'" 

Detil'lal separator: [] 

J!.K I .c.antel I 

tab-separator dialog 

You can then choose your own decimal tab-separator. 
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Line Spacing 

Papyrus permits the vertical gap between lines of text to be altered at will. 
Clicking on the left icon increases the space between lines, the far right 
icon decreases it. The box between the two line spacing icons gives a 
numerical measurement for line spacing and may be edited by clicking on 
it, using backspace or Esc and entering the desired value. A numerical 
value of 1 gives 6 lines of 12-point text to the inch. 

Reset Line Spacing/ 
Spacing units 

If this icon is shown selected (mostly black) then the line spacing is shown 
in terms of lines. If it is de-selected (as shown above) then the line spacing 
is shown in points. 

If line spacing is selected then clicking on this button will also set the line 
spacing back to the value set in the paragraph offsets dialog. 

Laterally inverled writing 

Papyrus incorporates a facility for writing right to left. If the icon on the 
toolbar is selected, then Papyrus enters text right to left. This allows text 
easily to be set in scripts such as Arabic and Hebrew. 

This is only available with bit-mapped fonts. No Speedo fonts are known 
(yet) to support this procedure and casually selecting right to left will 
cause great confusion. 

Page number 

This box shows the number of the current page. It is editable by clicking 
the left mouse button on it, pressing Backspace or Escape and entering 
the desired page number. Pressing Return brings up the required page. 

If the required page does not exist, this procedure will have no effect. It 
cannot be used to create a new blank page. To go to a master page in your 
document, simply place an M in front of the page number; for example, to 
go to master page 1 simply enter M1 in the box. 
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junction key bar 

At the bottom of the Papyrus desktop lies a row of boxes; these represent f 
the function keys on your computer's keyboard. Most of the boxes contain 
entries that refer to options on the Style menu. 

Function key Action 
FI Bold 
F2 Underline 
F3 Italic 
F4 Outline 
F5 Light 
F6 Superscript 
F7 Subscript 
F8 Delete current line 
F9 Unused 
FlO Redraw screen 

Press the relevant function key to apply a particular style (italic, bold etc.) 
to selected text. 

Customising function keys 

Each function key can also have a font with any style options from the 
Font Panel applied to it. Start by selecting the font and styles you want to 
attach to the key from the Font Panel. 

Once you have made your selection, you must open the Assign Function 
Key dialog for the function key you want to use. This is done by holding 
the Control key down while clicking on the blank strip in the middle of 
the chosen function key. 
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Once the box appears you can enter a name for you chosen effect, like this: 

Shortcut: 16arafllonl I 
~K II I .c.ancel I I !!.elete I 

Assign function key box 

After you have selected OK the name of you effect will appear in the centre 
of the function key bar. 

Clicking on the text of the function button (or pressing Shi ft + function 
key) applies the style you attached to that function key to the currently 
selected text. 

To remove a customised function key simply bring up the assign function 
key box for that key and select Delete to remove it from the function key 
bar. 

Papyrus Logo 

The Papyrus logo appears in the centre of the Papyrus desktop, it is an 
IMG file that is loaded when you run Papyrus. If you wish to remove the 
logo for either aesthetic or memory reasons, this can be done by simply 
renaming or deleting the PAPYRUS. IMG file from the Papyrus folder. 
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Papyrus Reference 
The enus 

Introduction 

Menus are selected by moving the mouse pointer to the chosen menu. The 
options drop down. Move the pointer down the column and click on the 
selected option. Where appropriate, this opens up a dialog panel where 
further selections may be made. Some options are ghosted, signifying that 
they are unavailable. 

PAPYRUS Menu 

Clicking on About Papyrus ... gives details of the version number of 
Papyrus, which is required when requesting assistance from technical 
support. It will also show details of the licensee. 

Papyrus allows desk accessories to be used and if loaded they will be 
accessed from this menu. 

File Menu 

The Menus 

NeH docuAent AN 
Open... AD 

Close AU 
Save AS 
Save as... '»AS 
Revert to saved 

Insert. • • '»AU 
Export. • • AE 

Delete ••• 

Page Layout... AL 
Paper ForAat ••• '»Ap 

Print... Ap 

Ouit AD 

The File menu 
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New Document Ctrl-N 

This opens a new document with the current page format. Dotted lines on 
the page show the limits of the text area as defined in the Page Layout 
dialog. 

Open Ctrl-O 

This brings up the GEM file selector, by default showing only Papyrus 
documents (with .PAP file extension). Other options include RTF (rich text 
format), ASCII, 1st Word Plus and Signum!2 file formats. 

Open Dotunent (PAP/RTF/ASCII) 
Direttory: C:\PAP3B7\*,PAP _____________________ _ 

Selettion: DEMODOC ,PA~ 

ID ~l::::::::m::::::::::::m*, PAP:m::::::m:::::mm::m 

[+] COMPOSL , __ _ (jo 

[t] DEUTSCH_, __ _ 
[+] DOCS ____ , __ _ 
[+] EN6LISH_, __ _ 
[+] EXAMPLES, __ _ 
[~ FONTS ___ , __ _ 
[+] ICON_RSC , __ _ 
[+] MODULL_ , __ _ 
[+] PRINTERS, __ _ 

Gem file selector 

E 
U 
:r 
K 
M 
II 

OK 

Cantel 

Initially only files with a . PAP extension will appear in the file selector. To 
list other files the directory line must be edited. 

To do this, click on the directory line, backspace to delete the PAP file 
extension and type in a *. The directory line should now look something 
like A: \ * . * or, for the above screen shot, C: \ PAP307 \ * . *, Click on the 
close box in the top left corner of the file list box to update the file list and 
all files in the chosen directory will be listed. Click on the required file and 
press return or click on OK. 

For more information on file types see the section on import/export in the 
Options menu. A maximum of six documents may be opened. This is a 
GEM limitation. 
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Note: ASCII files are formatted in a basic manner and most word 
processors are able to save files in this format. Papyrus can therefore 
accept files produced by other word processors. This includes MS-DOS 
and Windows-based word processors on IBM-compatible PCs. 

Close 

Closes the current document. If it has not been saved a dialog box offers 
the options of saving the document with its current name and format and 
automatically closing (Save), closing without saving (Don't save), or 
cancelling the operation and returning to the document. 

Close DotuMent !!!m!!!! ....... ",,·· 

Salle thanges to "EXAMPLE, PAP" 
before tlosing? 

}.alle 

IDon't salle I Cantel 

The Close Document dialog 

When a document is saved for the first time, the GEM file selector appears, 
giving the option to choose a path and filename. 

The file extension is important. Select. PAP, . RTF or .ASC, as Papyrus uses 
these extensions to determine the format of the document. The default is 
.PAP. Note that, before saving a document, an asterisk appears alongside 
its name in the Title Bar, which disappears after saving - this is the dirty 
flag that shows that a file has been changed without saving. 

After a document has been saved for the first time, S a v e ... saves the 
current document with its current name and format and leaves the 
document open. It is essential that documents are saved frequently whilst 
being worked on, otherwise it is possible that data may be lost under 
certain conditions, such as a temporary loss of power supply. 

An option is available to autosave under Miscellaneous in the 
Options menu. Save overwrites previously saved documents, but there 
is an option to rename the original file and retain it as a backup. 
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Save As 
r 

Brings up the GEM file selector, so that a different name and/or r 
directory/path may be selected for saving the document. Use Save as ... to 
save the current document with a different name or path (e.g. when you 
wish to save to a floppy disk in Drive A) or if it is desired to preserve a r 
previously saved version of the document. 

Revert to saved r . 
~ Distard thanges and revert to 
~ the version last saved? 

Revert ~ I Cantel 

Revert dialog 

Select Revert to reload the last previously saved version of the document 
you are currently editing, any changes made to the document will be lost. 

Insert Shift Ctrl ... 1V 

The Insert option brings up a GEM file selector asking you to select a file 
to insert; this can be a text file, bitmap or vector graphic depending upon 
the file selected. 

Importable text formats 
Import format 

1st Word Plus 

ASCII 

Page 98 

Filename 
extension 
* .1WP 

*. ??? 

Format notes 

The import of 1st Word Plus files 
requires the TEXTCONV .PRG 
program to be present in the module 
folder inside your Papyrus folder. 

ASCII text files, if a file cannot be 
recognised Papyrus will offer to load 
it as an ASCII file. 
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Papyrus 

Signum!2 

Rich text 
format 

*.PAP 

*.STX,SDO 

*.RTF 

Papyrus' own file format, any 
Papyrus file loaded into Papyrus 
will retain the pictures and 
formatting of the original document. 

The import of Signum!2 file formats 
also requires the TEXTCONV. PRG 
program to be present in the module 
folder inside your Papyrus folder. 

Rich text format files are the best 
way to transport files across the 
various computer platforms, all 
styling and formatting will be 
retained in the RTF file. The import 
of graphics within RTF files is not 
currently supported. 

Only the Papyrus format supports the loading of pictures within import 
documents, all the other formats will load text only with a varying degrees 
of styling and layout. The recommended cross platform file format is RTF -
rich text format. RTF files include full text and document formatting and 
will require no, or minimal, alterations when transferring documents from 
platform to platform. If you are experiencing problems when importing 
ASCII text files, see the section on import/export options for details on how 
Papyrus should interpret an ASCII file. 

The graphic formats currently supported by Papyrus are GEM vector 
meta files and together with several monochrome bitmap formats: 

Import format 

GEM Metafile 

GEM Bit Image 

STAD 

Degas 
Degas Elite 

Doodle 

The Menus 

Filename 
extension 
*.GEM 

*.IMG 

*.PAC 
*.PIC 
*.PI3 
*.PC3 
*.000 
*.BIG 
*.FAT 

Format notes 

Only horizontal and/or vertical text 
is supported; colours other than 
white are mapped to black; files with 
grey-scaled true colours cannot be 
imported. 

Only monochrome images are 
supported. 

Monochrome only 640x400 format 
used by some programs. 

Monochrome only 640x400. 

Fixed size images in basic screen 
dump format; not widely used. 
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Export Ctr/-E 

The Papyrus export option gives you the ability to save out any text or 
graphics from your Papyrus document for use in other programs. 

Papyrus can export all the text from a document or just a selection. To 
export all the text simply choose the export option with no text or graphic 
objects selected, to export a selection simply mark an area of text with 
mouse and choose Expo rt . Papyrus will then allow you to export the text 
in either the RTF or ASCII formats. The format of the exported text is 
determined by the extension of the file name you enter. Thus, if you want 
to export the text in RTF format you would give the file name an RTF 
extension, in the case of ASCII, an ASC extension. 

To export graphic files in Papyrus documents simply click on the graphic 
with the object tool and select the export option. The format in which the 
graphic is exported will be automatically determined by Papyrus. For 
bitmap files, Papyrus will automatically save the files as bitmap IMG files, 
for vector graphics Papyrus will save them as GEM vector metafiles. 

Delete 

The Delete function brings up a GEM file selector allowing you to delete 
files from your disk(s). Files selected and deleted using this option will be 
irretrievably lost. No alert is given, so caution should be exercised. 
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Page Layout 

, ] The Page Layout dialog within Papyrus is largely responsible for 
determining the look of a page. 

1 
jj 

J 

~I4 Page Layout 

Master page I STANDARD ~ 
Text Area Margins 
left 115 I right 115 11'11'1 
top 115 I bottol'l 125 11'11'1 
[] tlirror for left pages 

Within I'largins 
Header Area I~ 11'11'1 
footer Area 112 11'11'1 

Colul'lns 
NUl'lber of Colul'lns [ill 

Colul'ln gap 11B 11'11'1 

I OK I I Cancel I 
I Apply ~ I Reyert I 

the Page Layout dialog 

Mastel' Page 

At the top of the page layout dialog is the master page option; by clicking 
on the pop-up menu you can select the page setup you want for 
individual master pages. It normally contains the name of the current 
master page. For further details on setting up master pages see Master 
Pages under the Special menu. 

Text Area Margins 

The values entered into the text area margin boxes determine the distance 
from the page perimeter to the text perimeter. Consequently, this also 
determines the size of the text area. The text perimeter can be identified on 
screen by a box made up of closely dotted lines. 
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Mirror for leh pages 

The Mirror for left pages option is used when building a book that 
requires the left and right margins reversing on alternate pages. 

Edge of the paper· 
the paper size is 
defined in the paper 
format dialogue 

Column gap - the 
space between 2 or 
more main text area 
columns 

Text perimeter - the 
area available for text 
entry 

Page perimeter -
the maximimum 
printable area -
defined by margins 
set in the printer 
driver 

Printable page 
margin - the area that 
extends beyond the 
printers capabilities -
defined by margins 
set in the printer 
driver 

: ...................................................................... : . . 
: : 

t::::::::::::::::::::::::::::::::~::~:::::::::::::::::::::::::::::::::1 

Page areas within Papyrus 

Header and Footer 

Header area -
defined by the within 
margins value in the 
page layout dialogue 

Main text area -
defined by the text 
area margins in the 
page layout dialogue 

Text area margins 
surrounding main 
text area - these 
areas are the actual 
values defined by the 
text area margins in 
the page layout 
dialogue 

Footer area -
defined by the within 
margins value in the 
page layout dialogue 

The values entered into the header and footer boxes are used to define the 
vertical areas at the top and bottom of the text area reserved for headers 
and footers. Text can only be typed into these areas on a master page (see 
Master /Palges) and will be repeated on all pages using that master page. 
To go automatically to the header/footer areas on master pages, simply 
double-click above (header) or below (footer) the main text areas. 
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The Column number option in the page layout dialog is used to set the 
number of main text area columns on a page. The space between each 
column is determined by the value entered into the Column gap box. 

Paper !Format 

Hell4 forMat 

ForMat naMe: IDIN A41 
:.r14iTi;::;d;=e ::::;f;=a=n f~o::;:l 7d =7171:::;, 7~*T.1;::=" 

NorMal fanfold 24*1 
DIN A3 . " 
DIN A5 
DIN B5 

'-------....JI if 12~7 11'11'1 
Left border 10 11'11'1 
BottoM border 10 11'11'1 

r 
Label Spating 

[!] tolul'lns spated I 

.!!.K I Cantel 

I Revert I 

o 

11'11'1 apart I 
Adlust 

Paper Format dialog 

The paper format dialog is used to set the physical paper size and 
orientation for the currently active document. 

Newf@lrmat 

To add a paper format to the list of already available formats simply click 
on New format; the format name will go blank so you can enter the new 
name you want to give to your paper size. Once a new name has been 
entered, you will need to enter the dimensions of your new paper size into 
the dimension boxes situated below the list of formats - the first box is 
paper width the second is paper height. 
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To alter the orientation of the paper - portrait or landscape, simply click on 
the buttons to the right of the dimension boxes. The top button is for 
portrait orientation, the bottom button is for a landscape orientation. 

Delete format 

To remove a format from the list of paper formats simply click on the 
format then on the Delete format button. Predefined formats cannot be 
deleted from the list of paper formats. 

Left & B@ttom border 

Values entered into the border boxes dictate non-printable space on your 
document - this is particularly useful when printing labels since it lets you 
set a left border that is different from the inter-column spacing. 

Label Spacing 

For labels, options are available to specify the number of columns and the 
space between the columns. You may also want to set the left and bottom 
borders when printing labels. 

Adjust 

Has sh i fted @ .!!.pHards by c:::=J 1'11'1 o jtoHnHards 

adjust C.ancel 

Page Adjustment dialog 

If a printed document is consistently misaligned at the top or bottom of 
the page, you can use the Adj ust option to tell Papyrus by how much out 
a printed page was. Papyrus will then use the value entered to offset the 
vertical misalignment. 
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Print Ctrl ... P 

Pr i nt DocuMent m::m::m:: ·········:::::::::::· .. m::n:::::':::: 

EXAMPLE,PAP 
~Copies 
@ ftll pages 0 Page 11 : to i1 i , ......................... , 
[g] tven [g] Ogd D .D.ackHards 

Printer: I HP Deskjet 500 

Duality: I 300 DPI I 
Paper type: lSi ng I e sheet auto feed ~ 

Setup" , Special, , , 

Print gueue" , Print job, , , 

frint .cancel 

the Print dialog 

Select the Print option to bring up the Print Document dialog, from here 
you have access to the more commonly used print functions you will 
require. 

To print more than one copy of a document click on the box to the left of 
Copies and enter the number of printed copies of the document you 
require. If you want to print only a section of your document, this can be 
done by clicking on the Page button. Simply enter the starting page in the 
left box and the end page into the right box. To go back to printing all 
pages simply click on the All pages button. 

Odd, Even and Backwards 

To only print the odd or even pages of a document, uncross the relevant 
check box. To print out all pages ensure both check boxes are crossed. 
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The Backwards function is used to determine the order in which the 
print out appears in a printer's paper tray. If the Backward function is 
selected, instead of printing the document in the order 1,2,3,4,5 ... , Papyrus 
will print the pages 5,4,3,2,1, This is useful because it means that instead of 
page 1 being at the bottom of the paper in the printer's out tray, it will be 
at the top, thus avoiding the problem of re-sorting the pages of the printed 
document. 

Printer pop-up 

Click on the box next to Print e r:, a pop-up list will appear displaying the 
currently installed Papyrus printer drivers. Select the printer driver which 
most closely matches your printer - you can fine tune the Papyrus drivers 
by using the Setup button. 

The selection will also contain the entries GDOS Printer (21) and GDOS 
Printer (22), these entries refer to the actual drivers listed in the 
SpeedoGDOS ASSIGN.SYS file at IDs 21 and 22 respectively. If Papyrus 
fails to find a driver installed at ID 21 or 22, consult your SpeedoGDOS 
manual for further information on installing printer drivers. Select one of 
these if you want to use a SpeedoGDOS or regular GDOS printer driver, 
rather than a Papyrus one. 

Click on the box next to Quali ty: for a pop-up list of printer resolutions; 
the contents of this option are dependant upon the settings within the 
Papyrus printer driver selected. 

Click on the box Paper type: for a pop-up list of paper feed options. The 
options available are, fanfold (continuous listing paper), single sheet auto 
feed (used by printers with sheet feeders or trays) and single sheet manual 

r 

r 

I 

feed (used when manually aligning and inserting single sheets into the I 
printer). Again, the contents of this pop-up dialog are dependant upon the : 
settings within the current printer driver. 

The options for print quality and paper handling are only I 
available when using the Papyrus printer drivers; when using a 
SpeedoGDOS driver both options will be unavailable. For further 
information on setting up or loading a printer driver for your t 
printer, see the section Printer on the Option menu. 
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Setup 

The setup command is only available when using a Papyrus printer driver, 
if a SpeedoGOOS driver is selected the box will remain ghosted. For 
details of the printer setup see the P r i n t e r section on the 0 p t ion s 
menu. 

Specia6 

Select Special to bring up the Special Print Options dialog. From this you 
can apply special printing options for typesetting bureaux. The mirror or 
inverse options are only available when using the Papyrus printer drivers 
and are not available with GOOS drivers. If any changes are made to the 
defaults in the special dialog, the Special button in the print document 
dialog will be ticked. 

[]~dditional fornfeed 
[] Mirror horizontally 
[] Inverted 
~ pages per sheet 

~ ~ort for binding 

r 
Zoon 
f"ti>iiIl Width ~ 
@!!U x, Height - ~ 

~ancel 

Special Print Options dialog 

AddDti@trooD fOlfmfeed 

The Addi tional formfeed option may help the correct operation of 
some printers which do not automatically feed the paper through at the 
end of a page. If the printer feeds a blank sheet after each page this feature 
may have been enabled. Try turning it off. 

The horizontal mirror options produces a horizontal mirror image of the 
page, a feature often required when printing to film. 
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Inverted 

The invert option is used to produce a negative of the page. Again, this is a 
feature often required when printing to film. 

Zoom 

The zoom option allows you to enlarge or reduce the printed page. By 
entering a value into the % box, you can control the amount by which the 
printout is scaled - the default is 100%. Next to the zoom box is the width 
to height ratio box; by changing the value in this box you can change the 
aspect ratio of the printed page - this is useful when using a printer that 
has non-square pixels. 

Pages per sheet 

To print more than 1 page on a sheet of paper, simply click on the pages 
per she e t pop-up and select the value required. The pages will 
automatically be reduced to fit on the current paper size, the options 
available are 1,2,4,8,16,32 or 64 pages per sheet. 

Sort for binding 

r 
r 
r 

Sort for binding is available when printing 2 pages per sheet, this I 
option makes Papyrus print pages for a booklet-style document; thus, 
instead of just printing the pages 1-2,3-4,5-6 (left below) Papyrus will print 
the pages as 6-1,5-2,4-3 (right below). 

sort for binding 

I 

I 

l 

l 
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Print Queue 

the Print Queue dialog 

State ----, 
o Mnused 
@ .s.topped 
o .!ictive 

The Print Queue dialog acts as a Macintosh'" or Windows'M style print 
manager for Papyrus, by queuing up documents to be printed. 

By setting the Stopped option in the dialog, all documents you try and 
print will be entered into the list of documents to be printed. Once the 
Active option is set Papyrus will start to print the documents that have 
been queued. 

The print queue also allows you to alter the order in which the documents 
are printed. By selecting one or more entries with the mouse and pushing 
either the Top or Bottom buttons, you can move print entries up or down 
the print queue. 

DOCUMent: EXAMPLE,PAP 

Status: Inactive 
ForMat: Unknown 

~one .s.tart print 

the Print Job dialog 

Use Print Job to start printing items that have been stopped in the print 
j queue. 
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Print 

Click on the Print button to start your document printing. To store any 
changes you have made within the Print dialog and return to the current 
document select OK. Select Cancel to ignore any changes made and go 
back to the current document. 

Before doing any serious printing it is recommended that a 
printing test is carried out. This will ensure that the printable area 
is located correctly on the physical page and that the actual 
margins are identical with those appearing on screen. (Note that 
many printers, especially lasers and inkjets, cannot print fully to 
the top or bottom of the page). 

Quit Ctrl-Q 

Quits Papyrus. Warnings are given of any unsaved documents with 
options to Save before exiting, Don't save and exit or Cancel which 
returns you to Papyrus. 

The Edit Menu 

The Ed it menu provides access to the most fundamental word
processing features. As with most other aspects of Papyrus, keyboard 
shortcuts are provided for faster editing of text. 
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Cut 
Copy 
Paste 
Delete 

Copy style A1 
Paste style A2 

Copy ruler A3 
Paste ruler A4 

Select all AA 

IoIh 

the Edit menu 
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Working with blocks of text 

A block of text is a clearly defined area of a document which has been 
selected for manipulation. In keeping with its power and flexibility, 
Papyrus has a unique facility; it is possible to select more than one block in 
a document at a time. This allows for the simultaneous control of multiple 
blocks within a document. 

Papyrus has several ways to mark blocks of text, blocks which appear in 
reverse video (highlighted). 

o 

o 

o 

.. 

Using the mouse, move the cursor to the beginning of the text to 
be marked, hold down the left mouse button and drag the cursor 
to the end of the required text. Release the mouse button. The text 
is highlighted. 

Move the mouse cursor to the point where the block is to start, 
then click once to place the text cursor at this point. Move the 
mouse cursor to where the block is to end, hold down the Shift 
key and click the mouse button. Text is highlighted from the 
cursor to this new point. If part of the paragraph is already 
marked, then moving the mouse cursor to any point before or 
after the marked block, holding down the shift key and clicking 
will extend the marked area. 

Double-clicking on a word marks the whole word. Triple-clicking 
on a word marks the whole sentence. Double-clicking after the last 
word of the paragraph marks the whole paragraph. Triple-clicking 
after the last word in a paragraph selects the whole page. If it is 
desired to extend a block previously created by double- or triple
clicking, then using the Sh i ft key and mouse button as described 
above will extend the block by whole words, sentences or 
paragraphs. Whichever technique was used to mark the original 
block it will be enlarged in the same way. 

Blocks may be hidden (un-marked) by clicking once in or outside 
the marked block. 

Holding down the S h if t key whilst marking blocks allows 
discontinuous blocks to be highlighted. Individual blocks created 
in this way may be deleted by holding down the Shift key and 
double-clicking on the block. Paragraphs may also be marked 
from the Paragraph tag dialog (see above) by clicking on Mark in 
the dialog. Similarly, clicking on Mark in the Font Panel will mark 
all text in the document with the font, size and style selected in 
the panel. It may then be changed from the Font Panel itself. 
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o If the mouse cursor is moved to a block and the left button clicked 
and held down, a small logo appears attached to the mouse 
cursor. If this cursor is moved to another location whilst holding 
down the button, the whole block is moved to the new position. 
This action may be undone by selecting Undo in the Edit menu. 

Papyrus is always in Insert mode. This means that text is always inserted 
before or after existing text. It is impossible to write text over existing text. 
However, if a block is marked, typing immediately deletes the block and 
new text replaces it. 

The Clipboard 

A clipboard is an area set aside within the computer's memory which is 
used as a temporary storage space for text and pictures. It is possible to 
copy pieces of a document into and out of this area by using the features 
found under Papyrus' Edit menu, such as Copy, Cut and Paste. 

Text which is moved into this space will retain all of its screen formatting 
and effects. This means that Papyrus will remember any paragraph tags, 
rulers, colours, pictures and letter emphasis (italics, bold etc.) which may 
be applied to the text when copied into the clipboard. 

The clipboard can be a very useful facility. The ability to store information 
in this way means that it becomes very easy to move or copy areas of text, 
whether it be a few words, a single picture or a complete chapter, from 
one area of a document to another. The clipboard is completely 
independent of the document from which it was taken. This means that it 
is possible to move text back and forth between completely different 
documents, should this be required! 

Normally speaking, the textual clipboard facilities under the Edit menu, 
Cut, Copy and Paste, will be ghosted out. Since the clipboard is used to 
store blocks of data, the cut and copy facilities will not become accessible 
until a block of text has been marked (please refer back to the section 
Workilllg woth bUodes of text for further details). The Pas t e function 
will be selectable whenever the clipboard contains any information. 

The clipboard must be used with a little caution however. As mentioned 
earlier, the clipboard is a temporary storage space. The action of a cut or 
copy operation will move the selected area of text into the clipboard, the 
previous contents of which will be lost forever. If a cut operation was used 
to remove text from the document and this was followed by another cut or 
copy (before a paste was used to place the first block back into the 
document), then the first area of text will not be recoverable - you have 
been warned! 
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The clipboard will normally be located within the computer's memory, for 
the moment we shall call this the Papyrus clipboard. However, Papyrus also 
supports a device known as the GEM clipboard. The clipboard mode is set 
from within the Import/Export dialog found under the Options 
menu. 

ASCII IMport -------------, 
~ Ignore I ine ends after spates 
~ !!.eMOye leading spaces 

ASCII Export ---------------, 
® CR/Lf (.!Itari, DOS) 0 If (Unix) 0 CR (t!ac) 

o Line ends only after Raragraphs 

o Treat RTf/ASCII forMat the saMe as PAP docUMents 

o lIse GEM cl ipboard 

J;ancel 

Accessing the GEM clipboard control 

It is not normally necessary to know the difference between these two 
modes of operation since the clipboard is usually invisible to you. 
However, for the technically minded, the following is a description of the 
differences between the two; how they affect your document and the way 
in which you work with them. 

The Papyrus clipboard is the default setting from within the program (the 
box in the Import/Export Options dialog is not selected). In this mode of 
operation, an area of the computer's memory is used to store the contents 
of the clipboard. 

An advantage of this is that, because memory is very fast, clipboard 
operations can be very quick too. Also, all information included within an 
area of text which is placed into the clipboard will retain its styles, 
paragraph tags, effects, colour, pictures and tables. 

However, a hidden disadvantage to this mode of operation is that, as a 
document grows in size, the more memory it consumes within the 
computer. This has the effect of reducing the size of the clipboard, thus 
potentially limiting the size of larger areas of text cut from the document. 
For modestly sized documents or computers fitted with sufficient 
memory, this is seldom likely to cause a real problem. 
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Finally, when Papyrus has been quit, the contents of the clipboard will be 
lost. Running Papyrus again will not be able to retrieve the text. 

The GEM Clipb@ard 

In contrast, the GEM clipboard uses disk space to hold its data. The device 
used as the storage medium is normally the computer's boot disk. This will 
either be the internal floppy disk drive (also referred to as A: \ from within 
the file selector) or the first partition of a hard disk (C : \). On the 
appropriate drive there must be a folder called CLI PBRD since this is 
where the computer's operating software (GEM) places the text blocks. 

When copying the clipboard to the disk, the software automatically saves 
two versions of the marked text. The first is called SCRAP. TXT and the 
second, SCRAP. RTF. As you may already be aware, the first is a pure 
ASCII text file, the second is known as Rich Text Format. 

What this means in practical terms is that the first, the ASCII file, will not 
contain any formatting information what so ever. All paragraph tags, 
colours, italics, pagination etc. will be completely stripped from the data. 
In contrast to this, the RTF file does at least retain most of the information. 
Paragraph tags, fonts, font effects (bold, italics) etc. will be retained in the 
file; however, tables (including their contents) and pictures will be lost. 

Another disadvantage of the GEM clipboard may be speed. While the size 
of the clipboard is less often an issue on disk drives (especially hard 
drives), the speed of a drive is some 100 to 1000 times slower than that of 
memory. As a consequence, when cutting and pasting to the clipboard, 
delays may be experienced while the information is saved to, or retrieved 
from the drive. This will be especially noticeable when moving large or 
multiple blocks around or between documents. 

But all is not lost for the GEM clipboard. 

In fact, it has a number of very important redeeming features. For 
example, we have learnt that the Papyrus clipboard can transfer data from 
one Papyrus document to another. Well, with a few limitations, so can the 
GEM clipboard but, unlike the Papyrus mode, the GEM clipboard can 
copy data between applications! This means that other programs which 
also support the GEM clipboard, such as Atari Works, can transfer 
formatted text back and forth between each other. This is especially clever 
when two different applications are running side by side in a multi
tasking environment such as Multi-TOS. 
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Like the Papyrus mode, the GEM clipboard is also used as a temporary 
storage area. However, in contrast, the clipboard is not lost when the 
application which created it is exited, neither will it disappear when the 
computer and the disk drive are switched off! In fact, providing nothing 
else over-writes the contents of the CLIPBRD folder, the text will remain 
there indefinitely. 

The following lists comparative merits for the two clipboard modes: 

o Fast in operation. 
o Retains pictures and tables within the body of the text. 

msadvafl'flfages 

Uses system RAM which may be a restriction on machines with 
limited memory. 

GEM/Dusk 

Advcmfages 
o Doesn't use any significant system memory, so larger documents 

can be held in the computer. 

Clipped text is not vulnerable to loss of power and may be 
recovered from disk at a later date. 

Text can be shared between different applications without 
conversion. 

Disadvcmtages 
o 

o 

o 

Slow in operation, especially when handling large areas of text. 

Is not self contained, it requires a disk drive to store the data. 

Loses pictures and tables contained in text. 

Undo/Redo 

Papyrus supports an intelligent undo function, which will normally allow 
you to undo the last edit within a document. If at any time an undo is not 
possible, then the option at the top of the menu will be ghosted and will 
not be selectable. 
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When an undo is possible, the Ed it menu will reflect this in two ways. 
First of all, the Un d 0 menu item will once again appear in bold text, 
secondly the legend will be followed by a brief description of what the 
undo will achieve. 

When undo has been used, this action itself may once again be reversed. 
This will be shown in the menu since Undo will now be replaced by Redo. 

Cut Ctrl""X 

The Cut command will not be selectable from the menu unless at least one 
area of text is marked as a block. 

The cut command removes the marked areas of text from your document 
and places them into the clipboard. After this operation, text which 
followed the now removed blocks will be moved into the new space and 
the document will be re-paginated as appropriate. 

Copy 

The Copy command will not be selectable from the menu unless at least 
one area of text is marked as a block. 

This function will place an exact copy of the marked block or blocks into 
the clipboard. Please note that any pictures which exist in the marked area 
will be copied, as will all tables, styles and text effects. 

Paste Ctrl-V 

The Pas t e function will not be selectable from the menu unless the 
clipboard contains data. Please refer to the section titled The tt:DipboClurd 
for further details. 

Selecting Paste will cause Papyrus to insert the contents of the clipboard 
into the current document, at the point shown by the text cursor. 
Alternatively, if a block is marked within the text, a paste will cause the 
whole of the marked area to be replaced by the contents of the clipboard. 

In the case where multiple blocks are marked, the text will only replace the 
first block, that which is closest to the top of the document. 
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Paste may be used as often as required, wherever required. The contents 
of the clipboard will remain until such time that it is over-written by new 
text (via another copy or paste) or, for the Papyrus clipboard, when the 
program is exited or switched off. 

Delete 

The Delete command will be not be selectable from the menu unless at 
least one area of text is marked as a block. 

This option will delete a block without copying it to the clipboard first. It 
may be undone by clicking on Undo, but will be permanently lost if any 
action is taken to change the undo function, such as marking another 
block. 

Copy Style 

Copy Style copies the current font, style and size from the point where 
the text cursor is located, into a clipboard. A separate clipboard is provided 
for this purpose and Copy Style will leave the contents of the normal 
text clipboard intact. 

To paste a style into a document, it is necessary to select a block first. Once 
Paste Style has been selected, Papyrus will apply the new style 
attributes (font, style and point size) to the marked block. 

Copy Ruler 

It is possible to apply a ruler used in one paragraph to any other part of 
the document. As with Copy Style, Copy Ruler will use its own 
clipboard and will not overwrite the contents of the text clipboard. 

Upon selecting Copy Ruler, Papyrus will note the current ruler settings, 
including justification, tab settings and line spacing in the paragraph 
where the cursor is located. 
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Paste Ruler Ctrl-4 

This function will apply the ruler in the clipboard to the paragraph where 
the text cursor is located. If a block is marked, then the ruler will be 
applied to the start of the first paragraph through to the end of the last. 

Select All Orl-A 

The exact behaviour of Select All depends on the mode in which 
Papyrus is operating at the time: 

fextMode 
In text cursor is within a text frame, then all text within that frame will 
become selected. If the text cursor is located outside a frame, i.e. on the 
background, the whole document will be selected. 

Other modes 
If the text frame, object frame or edit frame mode, all frames are selected 
and Papyrus changes to frame edit mode. All the frames are grouped and 
may only be edited, moved or deleted together. Fill options will be applied 
to text and object frames and line options will be applied to all object 
frames and lines. 

To de-select, click outside the frames. Double-clicking on a text frame de
selects all and changes Papyrus to text mode. Double-clicking on an object 
frame brings up the Fill dialog. Double-clicking on a picture frame brings 
up the Picture Size dialog (see Picture Size in the Obj ect menu). 

Why the Beep Cfl'I .. ? 

Providing that the volume is turned up on your computer's audio system, 
you may hear your computer beep at you from time to time. This is 
generally a warning from Papyrus that you have tried to do something 
with which it doesn't agree. 
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Papyrus beeped because no 
~ "atching text Mas found after 
~ the cursor position. 

OK 
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Selecting the Why the Beep option from the menu will provide an on
screen explanation of what Papyrus objected to. 

The Text Menu 

The Text menu provides access to facilities which control the way in 
which text is displayed, searched and modified. 

font Panel 

Font Panel", 
Font Layout", 

Search & Replace", AF 
Find next AG 

Spe 11 checker, , , 
Spe 11 check next 

Page break A~ 
ColUMn break ~~ 

Group lines A( 
Un rou lines A) 

the Text menu 

The Font Panel provides access to most of Papyrus' text manipulation 
facilities. Because of this, it is important that you have read the chapter 
titled fOll1ts & S#y8es found earlier in the manual. 

The Font Panel controls the choice and appearance of text within a 
document. Please don't be daunted by its rather complicated appearance, 
it is actually quite simple and there are a number of exciting things to 
investigate here. 

There are three displays which contain font information lists. In each it is 
likely that one of the elements will be highlighted (white text against a 
black background). These represent the current text format in the 
paragraph or marked block on entry to the dialog. 

It is quite likely that the next thing to which your eyes will be drawn are 
the four dots to the left of the font lists. These buttons form a deceptively 
powerful feature of Papyrus and are known as the Permit buttons. 
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font Panel 

Sample Text 

Font Selection 
List --Hl~~ 

Permit button 

Bitmap font 

Show box --tf-~ S.how 

OK Load ••• 

.8PP ly I I Revert I 

The Font Panel 

The Sample Text 

Font Style 

Available 
point sizes 

.r-ll-- Current point 
size 

+-IHf-- Width/Height 

At the top of the panel, at least part of the text 'The Quick Brown Fox 
Jumps over the Lazy Dog' may be seen. This text will demonstrate how 
the mixture of Font Family, Font Style and Font Size will appear on the 
computer's screen. As selections are made elsewhere on this dialog, so the 
text in this display will be updated to reflect those changes. 

F@nt :5electi@n list 

The font selection list is located beneath the sample font on the left hand 
side of the dialog. This is the largest of the three scrollable windows and 
providing that there are sufficient font names to exceed the font list, you 
will see a slider on the right hand side. 

Providing that the Permit button is active, it will be possible to click the 
mouse on any of the Font families in the list. Upon doing this, the choice 
will be reflected in the sample font at the top of the screen. 

The Shew button 

If this is selected, then the name of each font family will be displayed in 
selector list using its own font. This has the advantage that you can see the 
effect which you will achieve, before you select the font. However, the 
disadvantage is that the list will take some time to compile and will be 
especially sluggish as you scan up and down the list using the slider bar 
and arrows. 
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/Font Sfyle 

This shows the family options which are available for the current font in 
the font selector. Often this will contain font effects such as italic and bold. 
Please be aware that these will be different from the other Italic and 
Bold effects which Papyrus can apply to text (under the Style menu). In 
general, the print quality of say Swiss Italic will be superior to that of Swiss 
Roman to which Papyrus has applied its own italic slant. 

Once again, as the choice is made from within this window, so the Sample 
Text will change to demonstrate the result. 

The Font Size selector has two associated controls. But first, a selection of 
common point sizes can be selected from the list by using the mouse 
alone. Once again, as the mouse is clicked on a size in the list, so the 
Sample Text will demonstrate the effect. 

To the right of this display is another box under the heading of Points. 
For the un-initiated, the word point, is used as a measure of font size in the 
print industry, where 72 points are equal to 1 inch (36 pts = 0.5 inches 
etc.). Click inside this box to place the cursor. 

You can now use the text editing keys (Backspace etc.) to change the 
number inside this display. Its purpose is to provide you with the ability to 
select unusual text point sizes which are not readily available from within 
the scrolling list to its left. Once a size has been entered, simply press the 
Return key once or click outside the box. The Sample Text will update to 
reflect the selection as will any marked text within the document. 

Width/HeHglht 

The control under the W / H heading provides an unusual feature. In effect, 
it allows you to alter the width of text, over and above the point size 
setting. To make the text appear at half width, simply enter the value 0.5 
into the box and press Return. To double the width enter 2 and so forth. 

These buttons are located on the left hand side of four of the Papyrus font 
controls. Click on them with the mouse. Upon doing so, the contents of 
the dots will appear to switch off and on again, to indicate their de
selection and re-selection accordingly. 
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As the status of a Permit button changes, so will the contents of the 
relevant display. With the permission off, it will not be possible to select an 
item within the display, neither will it be possible to scan up and down the 
list with the slider bars, they will be locked. 

The function of these innocent looking buttons is quite simple; to choose 
the text attributes which will be searched for, or applied to, the selected 
Paragraph or marked text block - giving an extremely powerful feature. 

When used in conjunction with the OK or Apply buttons, the function of 
the Permit buttons is to replace occurrences of the entry text, with only 
those which you have given Papyrus the permission to change from 
within the Font Panel. 

When used in conjunction with the Mark function, Papyrus will search 
the whole document for all occurrences of the permitted font style and 
will highlight them as marked blocks. 

It is a good idea to experiment with the Permit buttons to get a feel for 
how they work - used correctly they offer amazing possibilities. 

Mark 

This function is used in conjunction with the Permit buttons to scan the l 
current document for all occurrences of certain font combinations and 
mark them on the screen. Once this is done, the permits may be changed, ~ 
along with their respective font control data and applied to the designated @ 

areas. 

For example, you wish to replace all occurrences of Swiss 12pt, with Dutch , 
14pt. Simply ensure that the Permit buttons on the font selector and the ~ 
font size controls are selected and all others are de-selected. Now select 
Swiss and 12pt with the relevant selectors and click on Mark. Papyrus will '. 
now move from the start of the document to the end, marking all t 
occurrences of Swiss 12pt text. When the dialog returns to you, click on 
Dutch and 14pt from within the lists. Finally move down to the OK or I 
Apply button and click on it. t 

Papyrus will now effect the requested font and size change. 
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Apply 
The defined font selections will be applied to the text in the current 
document when you click on the Apply button. Once the operation is 
complete, Papyrus will return control back to the dialog This facilitates 
faster searching and replacement of font styles than if the dialog had to be 
re-opened after each operation. 

Selecting OK will apply the selected font styles to the marked block within 
the current document. When the operation is complete, the Font Panel 
will be closed. 

The Load function allows you to organise your font families. This may be 
necessary after purchasing new bitmap (GOOS and Signum!2) fonts and 
installing them onto your computer since the font management system 
probably will not automatically recognise the relationship between the 
font files. 

This allows Papyrus to unite bitmap font families, so that their related text 
styles and point sizes appear correctly in their respective selection lists. 

One outstanding feature of Papyrus is the way in which it can be made to 
handle a mixture of different font systems and font formats and make 
them work together in an effortless and apparently seamless fashion. 

For example, if you have GOOS installed on your computer, then you may 
have noticed that most software products which show font lists 
somewhere within them, will show fonts such as Swiss Bpt, Swiss 9pt and 
Swiss 14pt as separate entries. This is despite that fact that they all actually 
belong to the same family, just that each applies a different text size. 

It would be much more convenient if they could somehow be re-united 
with one another and grouped into more logical font categories, or 
Families. In actual fact, Papyrus automatically sorts SpeedoGOOS fonts 
into their respective families and font styles. However, for standard 
bitmapped fonts (GOOS and Signum!2 fonts), this is not the case. 
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The Font Families dialog will allow you to group GOOS and Signum!2 
bitmap fonts so that they will appear to be similar to SpeedoGOOS fonts in 
their behaviour. It will be necessary to unite each family with its relevant 
styles each time that a new font is installed on the computer. 

~ 1!!!!!!!!!!i!!i!!!!!!ii!!!!!!!!!! .... .f..!l.Itt . ..f..~!'!.~ .. ~.J.!il.~.j!!!!!!!!!!!!!!m!~!!!!!!!!!!! 
Font Fanily 

Nane }=I =======~ 
10 L-I __ ----=----= __ ----' 
[gI ~holll in panel 0 ~aps only 

OK I I Cantel I 

! Apply II I Revert I 
Font ------------, 

D ' Add fonts ... 
I Renove 

<lo 

IRenove unused faniliesl 
I Renove fanily I 
I Nelli fanily". I 

To create a new font family just click the mouse on the New Family ... 
button. If the dialog had details of an existing font family, then these will 
be cleared (but the font family itself will still exist). 

The file selector will appear prompting Install New Font Family. Select a 
font file to load and click the mouse on OK to proceed. Cancel will abort 
the whole operation. 

Assuming that you have successfully chosen a font and clicked the 0 K 
button, Papyrus will search the rest of that folder for other font files that it 
thinks belong to the same family. If it finds any, an alert will appear: 

Page 1M 

VI The font fanily 1I0CR_SI.III 
has 6 files. 
Load then all? 

II Load all II No II Cantel 
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If Papyrus was right and there are indeed 6 matching font files, click on 
the Load all button. Clicking on No means that only the font file you 
selected will be used and Cancel stops the whole operation and returns 
you to the Font Families dialog in its original condition. Assuming that you 
have clicked on Load all, then the Font Families dialog should now look 
something like this: 

iII ~m mmimmmiimimLIt:ll)tIi!f.!UJE.!!!mj::jj:::::::t::H:HiiiiH'''' 

Font Fal'lily 
Mallie [OCR I Morl'lal 
ID [OCR Morl'lali 
C8l.s.ho~ in panel D taps only 

I OK I I Cancel I 

I Apply ~ I Revert I 

Font ------------, 
OCR_Sl0.E24 
OCR_S12.E24 
OCR_SOB.L30 
OCR_Sl0.L30 
OCR_S12. L30 

Q 

1== I Add fonts ... 

~ I Rel'love 
0() 

IRel'love unused fal'liliesl 

Rel'love fal'lily 

Me~ fal'lily ... 

Please pay particular attention to the Font list which shows all of the fonts 
which were loaded into the machine in one go. 

/Removing OJ font family 

In general, hard drive users will not normally find it necessary to remove 
fonts or font families. If Papyrus is run from floppy disks, media 
constraints may make font removal necessary. Font families may be 
removed using the Font Families dialog, After selecting the family to be 
removed, click on the Remove family button. If the font family is in use, 
a warning dialog will appear preventing removal. It should be noted that 
Speedo fonts and families may be removed as well as GOOS and Signum!2 
fonts, but Speedo fonts can't be added from this panel. An option is 
available to remove unused font families. 

Individual fonts may be removed from a family by using the Remove 
button. 
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Adding fonts to a Family 

Select the font family from the Font Panel. Click on the Add fonts ... 
button in the Font Families dialog. The file selector will appear. Select the 
desired font from the file selector and press Return or click on OK. Note 
that only bitmap (GDOS and Signum!2) fonts may be added in this way. 
Speedo fonts can only be added through the Outline fonts accessory 
supplied with the Speedo system software and rebooting Papyrus (see the 
SpeedoGDOS manual for details). 

family Names and Identities 

These are specified in the Font Families dialog. Identity (ID) is normally set 
and should not be changed. The Name box is used to identify the font 
family in the Font Panel dialog. Usually, it should start with the ID name, 
for example Times, followed by the shifted backslash key (to the right of 
the left shift key), followed by the font style, e.g. regular, italic, bold italic, 
etc. If the font family consists of a single font, the font style may be 
omitted. When the name and ID have been entered, click on Apply, 
followed by OK. The effect can then be seen in the Font Panel. 

font Layout Shift Ctrl ... Z 

The font layout display is a useful way of finding where unusual 
characters may be found on the keyboard and for manually entering 
inaccessible characters into a document. 

r 

f 

I 

1 

This may be achieved by using the mouse to click on the appropriate I 
character within the font layout screen. When the Done button is selected, 
the dialog will disappear and the new text will be positioned in front of 
the text cursor. I 
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Keyboard 
Upon selecting Font Layout, you will see one of two screens. The 
chances are it will look something like this: 

Done D Keep o Signul'I!2 
COiYIj:loOllit1ble 

If not, then click on the pop-up in the top right hand corner and select 
Keyboard from the resulting display. The picture shows which characters 
can be typed directly into a document from the keyboard. By clicking 
either of the Shift keys on the display, it will change to show all of the 
upper case characters and any new special characters that may be 
accessible when the Shift key is held down. 

If you now move the mouse up to the top left hand corner of the window 
and click on the font name, the Font Panel will appear on the screen. 
Providing that the Keep button isn't selected on the layout display, then 
changes within the Font Panel will immediately be shown. It is quite 
possible that a completely different character sub-set will be found as a 
result, especially when the font family is changed. 

The Ke e p button is used to lock a character set on the display. This 
prevents later use of the Font Panel from changing the font when both 
displays are present on the screen together. 

The ASCI I mode will display all of the letters, numbers and symbols for a 
given font. It is possible to scroll from the start of the set (at character 32) to 
the end of the set (character 255) by using the two arrows on the right of 
the symbolic display. 
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Dutch 8011RoAan (6DOS Font) I ASCII 

32 !" # $ % & ' ( ) * + , - . I 
48 0 1 2 3 4 5 6 7 8 9 : ; < = > ? {l' 

64 @ABCDEFGH I J KLMNOr-
80 P Q R STU VW X Y Z [ \ 1 A ~ 
'6 ' abc d e f.~ h i j kIm n 0 

Done o Keep OSignUA!2! 
CO.v.p.a'tlble 

r 
r' 

r 

ASCII stands for American Standard Code for Information Interchange. As its 
name implies, it is a system which agrees that certain characters will be 
replicated on keyboards and computer character sets, from one computer ~ 
manufacturer to another. This implies a degree of uniformity, which it 
does indeed provide, for some of the characters. The others (usually 
characters 128 upwards) may vary from one manufacturer to another, or I 
in this case, from one font company to another. 

At the bottom right hand corner of the screen, there is an option to switch I 
the screen display between Normal and Signum! 2 character sets. This 
alters the height and width proportion of some characters on the screen 
and may make them clearer. Only the screen display is affected, printing 
remains un-affected. I 

Search and Replace Ctl'l-f I 
The Search and Replace dialog will allow you to match areas of text within 
your document with that in the Search field of the dialog and replace I 
them with the text which is present in the Replace field of the dialog. f 

This allows for a very high degree of automation when it comes to 
removing common mistakes or repetitive areas of text which need to be I 
located quickly and modified. Alternatively, the location and replacement 
of text may be progressed one occurrence at a time under your own, 
manual supervision. l 
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Searth Ipapyrus 

Rep 1 ate L-Ip--'ap-=y'-ru_s-'-I ________ --' HOMe 
'-;:::==~====~ 

I:ZI Whole Hord D Ignore Case ... 1 ...;J;.;;ok;;.;,;;;er~_~_.;.['?;,;;l..dl 

"'-s-ea-r-th"""""'lll I Replate & Cont II Relliate II Replate all I Cantel 

A sequence of characters may be typed into the Search text field. Such a 
sequence is known as a text string or string for short. These characters 
form the search criteria. 

It is also possible to search for sequences which would normally be 
invisible on the screen such as tabs and carriage returns. These may be 
entered by enclosing them within square brackets. e.g. [TAB] and [CR]. 
Please note that should you wish to search for square brackets within your 
document, simply use [[] or [ ] ] as appropriate. 

A complete and automated way of entering such text into a search or 
replace string is provided by the pop-up below the Home button (normally 
labelled Joker [?]. This is discussed in more detail later on. 

ReIPIOJ~e (st"ing) 

The characters typed into this field will be those which Papyrus will use to 
replace a marked block of text as the result of a successful search. 

The rules for such text are basically the same, except that only the tabs, 
brackets and hyphen sequences can be placed into the replacement string. 

Block 

The two Block buttons will copy a marked block of text in the document 
into the appropriate search or replace boxes. This text may be very much 
larger than the size of the actual box. Any non-printable characters (such 
as carriage return) will be displayed between square brackets e.g. [CR] 
(for carriage return). 
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Mark 

Selecting Mark will cause Papyrus to start searching the current document 
for all occurrences of the Search string. It will start at the current text 
cursor position or the start of a marked block and will continue until it 
reaches the end of the document, marking each occurrence as it goes. 

When it is finished, control will once again be returned to the Search and 
Replace dialog, where you might take further action. 

Home 

Clicking on this will cause Papyrus to move to the start of the current 
document. This is a labour saving function! 

Whole Word 

This very useful control can save a lot of time and effort. It forces Papyrus 
to look for complete occurrences of the Search string and not parts of the 
word contained within others. 

For example, you wish to find occurrences of the word 'the'. You type the 
into the search string and select Mark. With the Whole Word checkbox de
selected, all occurrence of 'the' will be highlighted, including those 
contained within 'there', 'theme', 'withering' etc. 

With Whole Word selected, only the complete word 'the' will be 
recognised. This is a labour saving device indeed, since you would 
otherwise have had to do the search in two parts, once for all occurrences 
of the word preceded and followed by a space (within a sentence) and a 
second time for the word preceded by a space and followed by a full stop 
(at the end of a sentence). 

With Ignore Case off, then Papyrus will match the search string exactly 
within the document. So to find all occurrences of 'The' at the start of a 
sentence, ensure that Ignore Case is off. Assuming that Whole Word is 
also off, then Papyrus will always find occurrences of the string in 'The', 
'There' etc. 

By selecting Ignore Case, Papyrus will also find 'the' and 'there' as well. 
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The Control Code list 

Initially this wide pop-up list will display J 0 k e r [?] in the dialog. Upon 
clicking on this and holding the mouse button down, a list of (normally) 
hidden control codes will appear on the screen. By moving the mouse 
down to one of the items in the list and releasing the mouse button, the 
textual substitute for the selected control code will be placed into the 
Search or Replace string, whichever has the cursor in it at the time. The 
Joker text will be replaced by that of the most recently selected control 
code. 

Most of the items displayed in this list represent text formatting controls 
which do not have an immediately identifiable presence on the screen, or 
which can't easily be typed in from the keyboard. It now becomes possible 
to search for pictures (by looking for their text anchors), formatted text (by 
looking for tabs), Index entries and many other useful types of text control. 

The Joker is probably the only code which requires particular explanation 
here, since it is the only one which is used exclusively within the Search 
and Replace dialog. 

Joker characters can be used to enhance the power of the Papyrus search 
facility. Jokers can't be used within a Replace string since they have no 
equivalent replacement code value. 

When placed into a Search string, the Joker code will cause Papyrus to 
ignore the exact character in this position of the string, but only to note 
that a character of some form or another must be there. This may be any 
legal printable character such as a letter, a number or a punctuation mark. 
However, it can't be a hard space, a tab, a carriage return or anything 
which may otherwise be selectable from the Control Code list itself. 

When performing a search, Papyrus will look explicitly for the characters 
in the search string but will allow any printable character in the position of 
the Joker to be acceptable to the search. An example may illustrate its 
function more clearly: 

A search string of S [ ? ] S would highlight occurrences in: 

SISTER 

S1S1 

FATHER'S.SONS 
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However, it will ignore: 

o 

" 

• 

GAS [carriage return] STEAM 

S[tab]S1 

FATHER' S[hard space]SONS 

Search 
Starting from the current text position, search the document for the 
presence of the Search string. When and if found, Papyrus will mark that 
presence as a block and will display it on the screen. 

Replace and Continue 

Replace the current marked block with the Replace string and start 
looking for another occurrence of the Search string. When and if found, 
mark that text as a block and stop. 

Replace 

Replace the marked text block with that contained in the Replace string. 
When done, return back to the Search and Replace dialog. 

Repla~eAII 

Starting from the current text position, look for all occurrences of the text 
string and replace then with the Replace string without question. Papyrus 
will stop when it can't find any more occurrences of the Search string and 
it has reached the end of the document. 

Cancel 
Close down the Search and Replace dialog 

find Next 

r 
I 

I 

I 

This mimicks the Replace and Continue function found at the foot of 
thle t~ealrchl and dR:ePllace ditahlog. Howtevebr, it is not n~cessafrtYhtot hatve the l. 
re a lve y arge la og on e screen 0 0 scure your VIew 0 e ex. 

By using the keyboard shortcut, rather than moving up to the menu each l 
time, this can be a quite effective alternative to the larger dialog box. 
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The Spelling Checker 

Papyrus features a fast and extensive spelling checker which uses its own 
spell checking algorithms. We also provide the ability to see spelling 
mistakes on the screen as you type them; this is called IntelliView and is 
described in detailed under S p e 11 c h e c k e r in the 0 p t ion s section of 
this manual. 

While it is supplied with an English dictionary as standard, it can be 
extended by you to incorporate slang, abbreviations or technical language 
not normally found in everyday modern English. 

Another important aspect of this spellchecker is that it may have a number 
of different dictionaries open at once and that powerful dictionary 
management is available to control them. These features are described 
under the Spellchecker item in the Options menu. Here we will 
concentrate on use of the main Spellchecker command. 

The Spellchecker command searches from the current cursor position 
until it finds a word that is not in its opened dictionaries. If it doesn't find 
any mis-spelled words, it will display an alert to that effect. 

If a word is mis-spelled, a dialog box like this will be displayed: 

114 Spellchecker 

accidental 0 o S iM il ar i ty search 
accidentally I UK, DIC I accidents 
acclaiM I Replace II Continue I attlaiMs 
att I aMat i on 0 I 1Idd II Ignore 

lattidintl I 
I .!!ptions, , , I .!!elete !;antel 

The mis-spelled word here is accidint. Papyrus shows the words in its 
dictionary that are alphabetically closest. You can now do one of the 
following 

o 

edit the word until it is correct and then press Return or click on 
the Replace button. 

click on a word in the list - this will then be displayed as the word 
to be edited and you can press Return or Replace as before. 

double-click on a word in the list. This will automatically replace 
the word. 
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" click on Ignore. This will add the word to a special dictionary, 
called Local Exceptions. Subsequent entries in this document will be 
treated as if they were spelt correctly. 

r 

click on Ad d. This will add the word to the currently selected 
dictionary. We strongly recommend that you don't add words to r~' 
the supplied dictionary; see the Options section for how to create 
your own dictionary. 

" click on Continue. This will ignore this word, but subsequent 
occurrences in this document will be treated as if they were errors. 

click on the Similarity search check box. This will display { 
words that are similar to the errant word. For this example you ~ 

o 

would see: 

['''''''' 
lauidintl 

I Options", 

~
o [gJ SiMilarity search 

I UK, DIC I 
I Rep lace I I Cont i nue 

() I Add I I Ignore 

I 
I Delete I I Add aU I I Cancel 

thus spotting the correct spelling immediately. 

click on Cancel which will return you to editing the document. 

Once you have decided what to do with this word, clicking on Continue 
will look for the next spelling mistake and you can repeat the process. 

The Similarity search is often much more useful than the straight 
alphabetic search but it does take longer, particularly on a slow machine. If 
you want you can make this the default via the Spellchecker Options dialog 
which can be accessed via the item on the Options menu or via the 
Options button in the box above. 

You can choose which dictionary words will be added to via the dictionary 
pop-up. In the example above you will only have the following: 

*Local exceptions 
(i gnored ~wrds) 

oj UK,DIC 

but if you have created your own dictionaries these will be shown too. 
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If you add a word to a dictionary by mistake, you can delete it again by 
typing it (or selecting it) and then selecting the Delete button. 

The Add all button will add every unknown word in the rest of the 
document to the current directory; it is great for creating your own 
dictionaries, but make sure you double-check the list of words first. 

$pel6check next Cterl-; 

Once the spelling checker is set up, it is not necessary to have the dialog 
on the screen just to check text. Repeated use of the Ct r 1- ; keyboard 
shortcut will scan from the current text cursor position to the next word 
which Papyrus doesn't recognise, at which point the screen will be 
updated to display this text in reverse video for clarity. 

Should you wish to ignore the selection, simply press Ct r 1- ; again and 
Papyrus will start the sequence once again. Should you wish to alter the 
word, however, it is only necessary to re-enter the word over the block, or 
click on it once with the mouse and use the traditional cursor and delete 
keys to make the necessary changes. 

Alternatively, you may enter the spelling checker dialog to investigate the 
spelling further, or simply to add the word into Papyrus' dictionary. 

Page Bureak 

Placing a hard page break into a document will cause all text after the 
current cursor position to be forced over to the following page. 

If after inserting a page break this symbol is not visible on the screen, then 
it is disabled within Papyrus. To make all page break symbols visible 
again, move to the Options menu and select the Screen Display ... 
item. The page breaks are switched on and off by the Spaces I Tabs I 

Return control. 

Column Bereak Shift Ctrl-RetulfUJ1 

This control, when inserted into a column of text, flushes all text after the 
break into the top of the next column. By way of an example, this, may be 
particularly useful for forcing the start of a new index heading from the 
bottom of an index page to the top of a fresh column. 
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If this symbol is not visible on the screen, then it is disabled within 
Papyrus. To make all column break symbols visible again, move to the 
Options menu and select the Screen Display ... item. The column 
breaks are controlled by the Spaces, Tabs, Return switch. 

Group Lines 

Select a block of lines, choose this option and the selected lines are tied 

[ 

r 
r 
r 

together and as a result can't be split between pages. Attempts to force f .•. ' 
page breaks (see above) will be refused. I 

f,\pply the setting of a dialogue box without having to close it. 

Supplied with Swiss and Times fonts in 6,8,10,12,14 points, andl 

Amri and Science fonts in 10 point. Signum!2 fonts,) 

Normally it will be possible see the start and end of a tied group on the 
screen. These are shown as two small arrows which point in towards one 
another, as seen in the diagram above. 

If these indicators are not visible, then it is possible to switch them back f 
on. Move to the Options menu and select the Screen Display ... item ! 
in the menu. The group markers are switched on and off by the Obj ect 
Anchors, Symbols control. 

Ungl'oupLines 

Selecting this option will cancel any line groups which exist within the 
marked text blocks. As a result, Papyrus may be forced to re-paginate the 
document, allowing text to flow backwards if appropriate. 

One effect of this function is that, if applied within a group of lines, the 
group is split into two smaller groups! 
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Style Menu 

The Style menu supplies commands for manipulating the style (bold, 
italic, colour etc.) of existing text: 

if NorMal 

Bold AB 
Underline AJ 
Ital ic AI 
Outline 
Light 

Superscript 1.6 
Subscript 1.7 

Function keys ... 

Colour .. . 

6et style ~6 
if RIl'lays get style 

In general commands on the style menu apply either to the current 
selection (assuming one is in force), or to future text entered (when there is 
no selection). 

Normal Ctrl- 0 

The No rmal command cancels any bold, underline, italic, outline, light 
and sub/super-script which has been applied to the current text selection. 
If no text is selected then any future text entered will be in the 'normal' 
style. 
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Bold 
Underline 
Italic 
Outline 
Light 

Ctr/~B 

Ctrl""J 
Or'· I 

These commands add there respective effect to the current text selection. If 
no text is selected then any future text entered will be in the appropriate 
style. If the effect is already in force then it will, instead, be removed. 

Note that when using Speedo TM fonts the Bold and Italic commands 
will select a suitable font in preference to using a text effect if the relevant 
font is available, for example: Dutch 801 Roman when set as Bold would 
use the Dutch 801 Bold font if available. 

Supers«:l'i pI 
Subscript 

Orl~6 

01'1 ... 7 
I 

i 
Superscript and Subscript add a superscript (text reduced in size 
and moved above the baseline) and subscript (text reduced in size and 
moved onto the baseline) effect to the current text selection; note that the I 
two commands are mutually exclusive. 

If no text is selected then any future text entered will be in the appropriate I 
style. If the effect is already in force then it will, instead, be removed. 

function /keySe" c> J 

The Function keys ... command opens the Function Key dialog; the I 
function key strip includes many of the common style commands via a ~ 
single function key press: 

For more information on the use of function keys and how to customise l 
them, see the fFllJItrodioll1 Keys section of the Tools chapter. 

L 
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The Colour ... command opens the Text/Object Colour dialog, this allows 
the colour of the current selection to be modified, or to allow the colour of 
future text/objects to be preset. 

I!~ !iiiText/Obj ec t Co 1 ourmi 

ODWhite 
@.Black 
O.Magenta 
O.Cyan 
O. Violet 
O. VelloH O. Orange 
O. Green 
O. BroHn 

1 OK 1 r-I C-a-nc-el-'I 

I Apply ~ I Revert I 

The number of colours visible will depend on the screen mode being used 
to edit the file, although internally all colours are maintained even if a 
document is edited on a monochrome screen. 

Get Style 

The Get Style command sets the current style attributes (both those on 
the Sty 1 e menu and on the T ext menu) to the style used by the 
character immediately to the left of the cursor. 

Always Get Style 

If this option is enabled, text will always be inserted using the font and 
style of the character to the left of the cursor (see Get StyDe). 
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Special Menu 

Page Offsets .•. 
Master Pages .•. 
Paragraph Offsets .. 

Spacing ..• 
Microspacing ... QAM 
Hyphenation... AH 

Soft hyphen A_ 
Footnote QAF 
Special chars •.. A~ 

Docul"lent Type •.• 
Data Field ... 
Index Entry ..• QAI 
Table... AT 
Cell Type... QAT 
Calculation... A* 

From the Special menu some of the most powerful features of Papyrus 

r 
r 
f 

I 

can be accessed including indexing, tables and forms. Owing to the I 
complexity of some of the features within this section, it is advisable to 
have a prior understanding of the earlier manual sections. 

Page Offsets I 

Page nUMbering footnote nUMbering -------, 
Start nUMbering at m:==J ® BY.I!age 

Headers/footers start at ~ 0 By ~ocul'lent, start at ~ 

Paragraph forMatting ----, 
Keep at least ~ line(s) 
at the top of lbe page 

footnote line ---------, 

Min gap text to line ~ filM 
6ap footnote to line ~ I'Ifil 

Thickness ~ 1'11'1 

Length~fIIl'I 
Offset froM left Margin LJ 1'11'1 

Keep at I east ~ li ne (s) 
at the bottOM ~ the page 

OK I I Cancel I 
apply I I Revert I 
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From the Page Offsets dialog box you can control every aspect of page 
numbering and footnotes for your document. By inserting special page 
number characters within your document you can make Papyrus insert 
the appropriate page numbers into the document. 

Stan numbering 0111' 

For a document comprising of several separate sections of several separate 
Papyrus files, you will require page numbering to start at a number other 
than 1 for each section. 

Papyrus therefore allows you set the page number of the first page of the 
current document. Thus, if you were writing chapter 2 of your document, 
you may require page 1 of chapter 2 to start at page 30. To do this, enter 30 
into the Start numbering at box. The first page of your document will 
then jump to page 30 - as shown on the far right of the ruler bar. 

If you are adding a header or footer to a document, you may need to 
suppress the appearance of these up until a certain page number. This can 
be done by entering the page number at which you would like the headers 
and footers to start appearing into the Headers/footers start at box. 

footnote numbering 
The footnote (see /FcctDTIcftes below) numbering options are again vital 
features when building a document comprising various sections. By 
controlling the way in which footnotes appear you can maintain a 
continuation of style throughout the finished document. 

By setting the footnote numbering option to By page, every time a new 
page is started, the first footnote entry on that page will be set to footnote 
number 1. 

If footnote numbering is set to By Document, the numbering of footnotes 
will rise throughout the whole section despite footnote entries being on 
different pages. Again, if the document you are writing is comprised of 
individual sections, you may require the value at which the footnotes start 
to be a value other than 1. To set the start number for footnotes, enter the 
number required into the start at box. 
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Footnote Line 

When inserting footnotes into a document, Papyrus will automatically 
insert a footnote line between the bottom of the main text area and the 
footnote region. The footnote line is used to provide a separator between 
the footnote region and the main text area. The size, position and distance 
from the main text area can be precisely controlled by the values entered 
into the control boxes. 

Min Gap between text and Dine 

The value entered into the Min gap text to line box sets the vertical 
distance between the main text area and the footnote line. 

Gap between footnote and line 

The value entered into the Gap footnote to line box sets the vertical 
distance between the footnote line and the footnotes. 

Length & rhffdcness 

Both the length and thickness of the footnote line can be accurately 
controlled. To set the footline dimensions, insert the desired length and 
thickness values into the appropriate boxes on this dialog. 

Offset from Deft margan 

The lateral positioning of the footnote line is controlled by the value 

r 
r 
r 
r 

entered into the box next to Offset from left margin, the value , 
entered into this box determines the starting point of the footline from the f 
left hand margin of the page. 

[ 
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Master Pages 

Master Itaaes To l"Iaster page I STANDARD L INDEX Nelli l"Iaster page I 
GLOSSARY 

Delete l"Iaster page I IIlli 0 

Nal"le: INEWS LETTERI 
Assign l"Iaster page ----------, 

[SJ fyen pages 

Pages II:=! to 12 
[SJ lldd pages 

1 I"'--.!!.s-s-i g-n-' 

L..-c::..;o~.I!.",-Y....;I"I.;.:a;=.s..:.;te;;;.r-","pa;;;.:g:<..:e'--ll I Insert l"Iaster page 

OK I I Cancel I 
.!!.pply ! I R,:ov:ort I 

Master Page dialog 

Every Papyrus document can have an arbitrary number of master pages. 
Each master page sets 

o 

o 

Headers. 

Footers. 

Text columns and text flow. 

Blocks which are to appear on each page for all the pages under its 
direction. 

Every page in a Papyrus document is directed by one and only one, 
master page. A master page may direct one page only, a range of pages, or 
an arbitrary set of pages and ranges. Master pages may be assigned to: 

o Odd pages. 

o Even pages. 

Both odd and even pages. 
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When a new document is created, without the use of a template, a master 
page named STANDARD is automatically assigned. Master pages may be 
stored in Papyrus template files, so that sophisticated layouts may be 
readily reused. 

New master page 

To create a new master select the New master page button. A new master 
page is created, which is a copy of the previously selected page. Select the 
Page Layout entry of the File menu (Ctrl-L). You may now set the 
number of columns required and the column gap between them. If you 
wish headers or footers, then set a suitable space for the Header Area 
and/or Footer Area within the Page Layout dialog. 

The master page may be given a name by clearing the Name: box and 
typing a name of your choice. Set this with Apply or OK. 

Further master pages may be generated from the same box. 

To master page 

If you want to edit a master page there are three methods of getting to it: 

" From the Master Pages entry of the Special menu, selecting 
To master page takes you to the selected master page. 

" 

o 

Clicking in the header or footer area of a normal page, which takes 
you to the header or footer of the currently applicable master 
page. 

Entering M and a master page number in the page box of the 
toolbar (number 1 corresponds to the first master page, 2 to the 
second and so on). 

Master page b/@cks 
All elements on a master page, apart from text, are blocks. This includes 
the columns set by the Page Layout dialog and the upper and lower boxes 
which hold the header and footer. 

As blocks they may be selected, sized and moved using the mouse cursor 
or the Co-ordinates entry from the Obj ect menu. Any other block 
may be placed on the page, including a picture block and be placed, filled 
and coloured as if it were being set on a normal document page. 
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rextflow 

When a page is initially set up it looks something like the picture below. In 
this case there are four text columns, with a header and a footer above and 
below. The four text columns can contain flowing text and this text would 
normally flows from column 1 to column 2 to column 3 and finally to 
column 4. When column 4 has been filled, text will then flow into the first 
column of the following page. By default, Papyrus flows text from top to 
bottom and left to right. 

1 

~ .............•................••....................................•.......... ..: 

Default flow order 

Flow order 

The four columns are flowing text blocks and the flow order is associated 
with the block itself as it is created on the page. If you wish, these flowing 
text blocks may be shuffled to any positions required by moving the text 
boxes on the master page. Beware: most people expect text to flow top to 
bottom and left to right, with Papyrus, you can flow text in any direction 
by altering the default positions of the text boxes. 

fi)eDetolTlJg C@O(JJlI!f!IJll'8$ 

If .a column is deleted from the master page, the flow order is retained, 
except that the deleted block is skipped. If column 3 were to be deleted, 
the flow order would become ... 2 to 4 instead of ... 2 to 3 to 4 ... 

The Menus Papyrus Gold Page 145 



Adding c@lumns r 
Columns may only be added to a master page from the Page Layout r-
entry of the File menu (Ct r 1- L). When any alteration to the number of 
columns is made from here, the pages directed by the master page are 
effectively wiped clean and refilled with text. Independent text blocks will 
be lost from any existing pages directed by the amended master page. r 
HeadeD's a/J'IJd f@@teD's 

Headers and footers may be edited by clicking in the header and footer 
(top and bottom) areas and entering text directly. Page numbers may be 
inserted from the Special chars entry of the Special menu (Ctrl-#). 
Text may be styled in the usual way. 

There are two ways to return from viewing a master page to the normal 
page: 

Click with the text cursor in a flowing text block. 

Entering a page number in the page box of the toolbar. 

Copying masterr pages 

Entire master pages may be copied to the clipboard and copied from the 
clipboard by using the Copy master page and Insert master page 
options of the Master Pages dialog. This allows easy transfer of master 
pages between documents. 

Unwanted master pages may be deleted from a document by selecting the 
Delete master page option of the Master Pages dialog. The pages 
previously assigned to the unwanted master page must first be assigned to 
other master pages. 

Master pages are assigned from the Master Pages dialog. The selected 
master page may be assigned to a range of page numbers. Within this 
range, the selected master page can apply to even pages, or to odd pages 
or to both odd and even pages. After the selection is made, the Assign 
button sets the selection. 
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Paragraph offsets 

!1tli!!iiii!i!i!i!i!!!!mimmiii! Paragraph Offsets mill!!!!!!!!!!!!!!!!!!!!!!!!!!! 

Spating above paragraph.oc=J Pts 

Spating beloH paragraph.~ Pts 
.[gJ A line's .!!.iggest tharatter 

sets nininun line height 
.[gJ Int I ude paragraph I s last 

line in justifitation 

OK I I Cantel I 
Apply I I Revert I 

Paragraph Offsets dialog 

The Paragraph Offsets entry of the Special menu allows fine tuning 
of the typography of a paragraph. If paragraph spacing is defined, the 
effect may be incorporated into a paragraph tag. 

Lines within a paragraph are separated by an amount specified on the 
toolbar. Each time a new paragraph is started, the spacing specified is 
added to the existing spacing between lines. This allows paragraphs to be 
differentiated by their separation. 

Different offsets may be used for different paragraph tags, to give a clean 
look to a document. 

Above and below 
The values entered into the above and below boxes set the relative space 
above and below the current paragraph. It must be remembered that if the 
paragraph above or below the current paragraph has a before or after, this 
value must be added to the current paragraph's before or after to obtain 
the actual paragraph spacing. Thus, if the paragraph before the current 
paragraph has a 6 point after and the current paragraph has a 6 point 
before, the inter-paragraph spacing will be 12 points. 
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Biggest character 

If lines are set fairly close together then, for general English text there is no 
problem. If a line contains capital letters with accents, the accents may 
break in to the line above. Selecting A line I s biggest character 
sets minimum line height avoids this, by temporarily increasing the 
line height. 

It is usually better to avoid the problem by increasing line height for all 
lines, except for publications such as catalogues or phone books. 

Last line 

r 
r 
r 

The last line of a paragraph which is set full out (justified) is normally set 
ragged left. If the Inc 1 u d epa rag rap his las t lin e i n 
jus t if i cat io n option is set, then the last line is justified in the same I 
manner as all preceding lines. 

This effect is not often required and can look odd! 

Spacing 

Spacing ®!2CJ I 1'11'1 
(not for Speedo ronts) '=========...!I 

Extra for spaces .10 I 
OK I I Cancel I 

i apply i I Revert I 

Word Spacing dialog 

The Spacing dialog allows you to set the default spacing between words in 
selected paragraphs or from the cursor if no paragraph is selected. The 
Spacing dialog also allows you to set different spacing for both bitmap and 
SpeedoGDOS fonts. 

The value entered into the Spacing box only applies to bitmap fonts and 
will have no effect on SpeedoGDOS outline fonts. The Ext ra for 
spaces option will apply to both scalable and bitmaps fonts. 
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Microspacing Shift Ctrl-M 

I~ I!!!!!!!!!!!H!!!!!!!!!!!!!!!H!!H!!!!!!H! 11 i trospat i ng H!H!!!!!!!!!!!!!!!!!!!!!!!m!!!!!!!H!!! 

Keys * 111 
Horizontal .~Io =:::::11 
Uertital -10 I 

OK I I Cantel I 

;:;:A p::p I;:::Y ::;, IRe v e r t I 

Left & right I 
@ A.!!.solute 
o Relative 

The Microspacing dialog 

Microspacing can be used for precise positioning of selected areas of text 
giving you full control of text on a page or individual characters. Common 
uses for microspacing include positioning numbers in complex 
mathematical equations or adding mass numbers to chemical symbols. 

The position of selected characters can be controlled from within the 
Microspacing dialog or by holding down the Ctrl & Shift keys and using 
the cursor keys to move the currently selected block. The distance by 
which the text moves when you hit a cursor key is controlled by the value 
set at the top of the Microspacing dialog. 

Horiz@ntal and VerlicaU 

The horizontal and vertical microspacing of the currently selected text may 
be adjusted by entering values into the relevant horizontal or vertical box 
and selecting Apply. 

left, Left & Right 

If you require the selected text to move in one horizontal direction only 
(chemical formulas etc.) you can lock the direction by clicking on the pop
up next to the Horizontal box. The Left option permits you to 
microspace the selected text left only, where as the Left and right 
option allows the text to move in both directions. 
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Absolute and Relative 

The Absolute and Relative options are particularly useful when 
attempting to microspace text precisely. With the absolute option selected, 
values entered into the vertical and horizontal boxes will place the text the 
distance you entered from the original position. 

The Relative option will place the text relative to the text's last location; 
thus, if you entered 10 into the horizontal box and hit Apply, then hit 
Apply again, the total distance from the original point will be 20. 

Hyphenation 

III 1!!!!m!!!!!!!Jl!!Jlm! Hyphenati on !!!m!m!!!!!Jl!!~Jl 

[gI Hyphenate 
Language: I Eng li sh I 

I OK I I Cancel I 
I Apply II Revert I 

Hyphenation dialog box 

Ctrl-H 

Select Hyphenation to bring up the Hyphenation dialog, from here you 
can control whether Papyrus hyphenates your document, as well as the 
way in which Papyrus hyphenates words. 

Clicking on the Hyphenate box enables hyphenation. Wherever suitable, 
Papyrus will insert soft hyphens between syllables of words so that only 
syllables will be wrapped onto the next line instead of whole words. Thus 
for the word hyphenation, Papyrus would hyphenate it as hyph-en-a-tion. 

/Language 

There are several language options available on the Language pop-up 
which, when selected, automatically apply the appropriate hyphenation 
rules for that language. 

Special Text Control 
Papyrus will allow you to insert special characters into your document 
which override ail. aspect of its automatic text formatting. 
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The Hard Space "'Space 

A hard space is sometimes also known as a non-breaking space. This latter 
name describes the function of the hard-space rather well. 

Sometimes it's useful to prevent two or more words from being separated 
between lines. Consider the following; 

il went to my 1003.1 compute' shop and purcrased Stereo! 

Irvaster. I 

The word Stereo Master has been split. This can be remedied by deleting 
the space that exists and putting a hard space (Ctrl-Space) in its place. 
The result looks like this; 

II went to my 
i Stereo rvaster. 

1003.1 compute' shop and purotesedl 

As you can see, Papyrus has refused to split the two words and has forced 
the line break in front of the word 'Stereo' instead. 

Another effect of a hard space can be seen when viewing lines of text that 
are justified. For example; 

I Stratford upon Avon is the town in 
!William Srakespe:ue wrote plays. 

Replacing the spaces between the first three words with hard spaces you 
will achieve the following; 

I Stratford upon Avon is the 

IWiliiam SrakespEare wrote plays. 

town in 

In this example, Papyrus has kept a fixed width between the words due to 
the Hard Spaces and justified the rest of the line. 

OIf'D- -

With the Hyphenation mode selected, Papyrus will use the selected 
dictionary to determine where it should try to split a word. If you disagree 
with its decision, you may tell it that you would prefer to split the word in 
a different place - this is known as a soft hyphen. 
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For example, the following paragraph doesn't have hyphenation switched r" 
on; 

i Mr. Smith was a man 
!antidisestabli shmentarian ism. 

not given to~ , 

! 
The following is the same paragraph, but with hyphenation; 

i Mr. Smith was a man not given to anti di sestab Ii sh menta- i 
irianism. i 
~ ~ 

Notice how Papyrus has hyphenated the line. This may not be a 
convenient place. It is possible to tell Papyrus that you are unhappy with 
the position by moving the text cursor to the required place and typing a 
dash with the Control key pressed at the same time (Ctrl-). 

IMr. Smith was a man not given to anti-i 

! dis establis hm entariani sm. 

iMr. Smith was a man not given to antidisestablishment-i 
iarianism. i 
~ ~ 

The above examples show how the hyphen can be moved to a more 
convenient place. Please note that placing the soft hyphen too close to the 
end of the word may cause Papyrus to give up and move the word onto 
the next line! 

iMr. Smith was a man 

I antidisestablishm entarianlsm. 

not given to~ 

I 
In this case the soft hyphen is between the n and the i. 

PeJll'C1Jgraph Hyphenation 

As you have seen, Papyrus is quite flexible with the way in which it treats 
the hyphenation of words. However, it isn't always convenient to allow a 
word which is deliberately hyphenated to flow between two lines. For this 
reason, Papyrus will allow you to turn hyphenation on/off within 
specified. 
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In the following paragraph, hyphenation is switched on using the 
Hyphenation ... control found under the Special menu; 

jWilliam St-akesp€€l.re lived in the town of Stratford-upon

lAvon, 

Notice how Papyrus has taken the opportunity to split the line at a 
position which is already occupied by a hyphen that is part of the town's 
name. With hyphenation turned on, Papyrus accepts this as a legitimate 
position to split the line, without having to add one of its own. 

In order to make the text stay together, you can simply turn hyphenation 
for this particular paragraph off! 

IWilliam St-akesp€€l.re lived in the to'wn 0'1 
I Stratford-upon-Avon, 

As you can see, the hyphenated text is treated as one word and is forced 
onto the next line of the paragraph. 

Soft Hyphen Ctr/~ .., 

Places a soft hyphen at the cursor point. This will be the point where a 
hyphen will be inserted if it is necessary whilst text is being formatted with 
hyphenation turned on. This is discussed in more detail above. 

footnote Shih Ctri-f 

To insert a footnote at the cursor position simply select Footnote from 
the menu, a footnote number in superscript will then be inserted at that 
cursor position provided it is in the main text area (footnotes may not be 
inserted in a text or object frame). 

At the same time the footnote number will inserted into the footnote area 
at the bottom of the page, separated from the main text area by a footnote 
line. Once the footnote has been entered Papyrus will automatically jump 
to the footnote area so that you can enter the text for the footnote. 

The footnote line itself is controlled by the Page Offsets dialog, as are the 
many other footnote parameters. 
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Special Characters 

Date forl'lat: I 17.01.1994 

~ ~ariable date 

() Current ~ate: 

() fage nUl'lber 

.!!.K 

07.06.1994 

kancel 

Special Characters dialog 

Ctrl-# 

From the Insert Special Character dialog you can insert the current time and 
date in various formats, as well as page number fields. 

Variable & Current date 

r 
r 
r 

The variable and current date entry options allow you to insert the current I 
time and/or date (taken from your computer's internal clock) into the 
point at which the text cursor is currently positioned. 

The format of the date string inserted at the cursor point is determined by 
the option selected from the Date format pop-up. 

Use the Variable date option to create a date that is updated every time 
the document is opened. If the Current date option is used, the current 
date will be inserted but it will not update when you re-open the 
document. 

Page number 

This inserts a page number character at the cursor. 

Every time Papyrus comes across a page number character in a document 
it will substitute the current page number for it. When a page number 
character is placed on a master page, it is displayed as a # in a box, this 
will appear as an incrementing page number on normal pages. 
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Thus, to add a page number to every page of your document, all that is 
needed is to add a special page number character to the master page. Page 
numbers will then appear throughout the document at the location of the 
special character on the master page. 

If the page number character is inserted on a normal page, only the page 
number on which the character lies is inserted into the document. 

Document Type",,,,,, 

The Document Type ... command opens a dialog which allows the type of 
the current document to be set: 

............... j~lj;lHHjlllgl 

@ flain dotul'lent 
o Iel'lplate 
o Eorl'l 

1!.K .!:.antel 

The three options are: 

Plain document: 
A 'normal' document which allows full editing of every element. 

Template: 

Form: 

A document set up to hold frequently used master pages, text 
styles, pictures etc. A template may contain text, though it will be 
frequently empty of text. It is often used as a starting point for a 
publication. 

This freezes all frames in their current positions and cancels all 
page layout features. Text may only be entered in previously 
created text frames. As the name of this option indicates, it is 
useful in designing pre-printed forms where entries may only be 
made in specified locations. The form itself should be designed in 
Plain document mode, then use the Form option, to freeze all 
the frames and text. 
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Templates 
A document is given the Template characteristic with the Document 
Type entry of the Special menu. 

Creating from scratch 

Select New document from the File menu. Then choose whatever 
characteristics the template is to have, such as paper format, page layout, 
text tags and master pages. Select the Document Type entry of the 
Special menu. Set the document type to Template, save the document 
with an appropriate filename and close it. 

CO'eatilJ1g from Cfll!'!J existing diocument 

Load the chosen document. Select the Save as entry of the File menu 
and save the document under a different name. Delete unwanted text and 
other items from the document until what remains is no more than is 
required for the template. Select the Document Type entry of the 
Special menu and set the document type to Template and re-save the 
document. 

Usong fempBates 

Spedfic fJempBafJe 

Load the template file in the usual way that you would load a document. 
The file name at the top of the screen will indicate that it is a template file. 
Save the file with a new name using the Save as entry of the File menu 
and the new file will have all the characteristics of the template, which 
remains unaltered. 

foDders 

To avoid confusion, it is a good idea to use folders to keep templates 
separate from other documents. 

Defo(jj}Dt ttempDates 

When you use the New document selection from the File menu then 
Papyrus searches for a template file called _NEW.PAP in the following 
places, in order: 

o the current document path (folder), 

in a folder named TEMPLATE, 
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in the folder which holds the Papyrus application. 

Suppressing the default temp Bate 

If _NEW. PAP exists as described above, its effect may be overridden by 
starting a new document with Shi ft Ctrl-N, in which case the new 
document takes on the page layout of the previous document. 

Bndex and talb8e of contents 

The file _INDEX.PAP may be used in similar fashion to that described 
above to define a newly created index and _CONTENT. PAP to define a 
newly created table of contents. 

form production 
] Papyrus incorporates fast and efficient mechanisms for form design, filling 

in and printing. 

J Concepts 

J 

J 

A Papyrus form file consists of a constant part and a fillable part. 

The fillable part is a set of input fields which may be filled in when the 
form file is loaded from disk; everything else in the form is protected 
against change. This allows you, or someone else, to prepare Papyrus
based forms with the minimum of fuss. 

The input fields are text objects (text boxes) and when the fields are being 
filled in, all the usual text manipulation facilities of Papyrus are available. 
After a Papyrus form has been filled in, it may be processed to print it or 
save it as a new Papyrus file. 

!Field order 

The natural order of a Papyrus form's input fields is: 

o 

o 

firstly, top to bottom from the top left hand side of the form, 

secondly, for fields at the same height down the page, from left to 
right. 

The first field is at the top left hand side of the form and the last field is at 
the bottom right hand side of the form. 
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Preset text 

Input fields may contain preset text. This may subsequently be deleted or 
otherwise edited when the form is being filled in. 

Designing a form 

The basic procedure for designing a Papyrus form is: 

.. 

., 

Prepare a new Papyrus document in the usual way, perhaps using 
a template. 

You may design the form directly on the screen, remembering the 
field order defined above. 

Place the fixed part of the form on the page, including boxes lines 

r-

and graphics, appropriately styled, toned and coloured. I 
.. 

" 

" 

.. 

" 

Place a number of text objects on the page where the input fields 
are to be (each text object may either be empty or preset with 
some text). 

Text in an empty text object may be styled or re-styled with the 
text cursor in the empty box, or by selecting a text object (or 
objects) and then applying styling including paragraph tags, fonts, 
sizes, toning and colour in the usual way. 

If only some of the text objects are to be input fields, then select all 
of these (S h if t + left mouse click) but no other text objects; 
otherwise ensure that no text objects are selected. 

Select the Document Type entry from the Special menu . 
Change the document type from Plain document to Form and 
select OK. 

The document now becomes a form and all the text objects that 
will be input fields receive a black outline to mark them as such. 

Save the file and close it. 

Subsequent editing 

An existing form file may be edited by: 

.. 

" 

Page 158 

Loading the form file . 

Selecting the Document Type entry from the Special menu and 
changing the document type from Form to Plain document. 
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o Editing the form as a normal Papyrus document. 

o Re-converting it back to a form as described above, being careful 
to select the text objects corresponding to the required input 
fields. 

fiWng in OJ form 

When a Papyrus form file is opened, Papyrus changes its usual behaviour. 
The form's window becomes field oriented to allow the form to be filled in 
as efficiently and as quickly as possible. 

Opening a form file 

A Papyrus form file is opened in the same way as any other file. The top of 
the file window contains the file name, preceded by the word Form to 
indicate the special status of the file. The text entry cursor appears in the 
first field. 

'if"ext entry clllrsor 

The text entry cursor, which is a vertical bar, appears whilst the form 
window is active and is constrained to appear in input fields only (the 
mouse position is represented by the usual text cursor, which may be 
clicked to move the text entry cursor to a new permitted position). 

SpedaU keys1frokes 

When a form window is active, the following special keystrokes apply: 

Esc 
Clr/Home 
Cursor Up 
Cursor 
Down 
Tab 
Alt- Tab 
Return 
Alt-Return 
Shift-Tab 

'if"extentry 

clears the field containing the text entry cursor 

moves text entry cursor to first (topmost) field 

text entry cursor to previous or next field or 
previous or next line of multiline field 

text entry cursor to next field 

insert a TAB character 

text entry cursor to next field 

new line 

text entry cursor to previous field 

Text entry is constrained to the pre-defined input fields. Within these 
fields all the usual Papyrus text entry facilities are available, including font 
selection, text colour selection, tags and the clipboard. 
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Processing a form 

After a form has been filled in, a request to process it can be indicated in 
one of three ways: 

.. 
o 

• 

Pressing Return in the last field . 

Clicking on the window close gadget after the form has been 
amended. 

Selecting Close from the File menu . 

Any of these actions cause the Form Termination dialog to appear, from 
which some actions may be selected with checkboxes. Selecting Close 
Form closes the form with no further action. Selecting Cancel returns to 
the filled in form for further editing. Selecting OK performs the selected 
(checked) actions: 

Printing 

The forI'! is tOl'!pletel what do you want to do with It? 

o ~ave it as [E.~.I~~~jl PRP 

[8! frint D Copies 

o Reset entries afterwards 

J!K I I ~antel I Close ForI'! 

Selecting the Print checkbox causes the form to be printed according to 
the current printer setup options. The number of copies may be selected 
from the Copies box. 

Saving 

Selecting the Save it as checkbox causes a copy of the form to be saved 
as a Papyrus plain document file. The file name is constructed from the 
form's file name and an incrementing digit. This field may be cleared and 
a new name offered, if required. 

The saved Papyrus plain document file may be subsequently used as 
required. 
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Resetting entries 

After one form has been filled in and printed or saved, it is often time to 
do another. The form's fields may be reset to their original values, or kept 
as edited. This is controlled by the Reset entries afterwards 
checkbox: 

o 

Notes 

If each form is different, then resetting the entries saves clearing 
each entry by hand. 

If a number of forms are to be filled in with similar information 
then not resetting saves repetitiously entering the same 
information time and again. 

Other dO(;llPments 

When a form is being filled in, other Papyrus documents may be open at 
the same time, allowing text to be cut and pasted. 

7!abDes 

o 

" 

Each cell of a table is a text object and may be used as an entry 
field of a form. 

Table calculations are possible. 

Specific cells may be selected before converting the base document 
into a form, as described above. 
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White text boxes against toning 

An input field which is white against a toned background is an attractive 
design. The effect may be obtained by the following procedure: 

o 

" 

" 

" 

Pennanent 

Field 

Draw a block and set it to a suitable tone, such as 13% black. 

Place a single text object on top of the toned block and select that 
text object (Esc). 

Select White from the Colou r entry of the Ob j ect menu. 

Select Grey Level 1 00% from the Fill pattern entry of the 
Obj ect menu and keep Transparent unselected. 

o Iransparent 

CJK:::J I ~an[el I 
~~ 

Now double-click in the text object, to get a text entry cursor. 

" Select Black from the Colou r entry of the Ob j ect menu. 
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The text object is now styled to have an opaque white background 
and black ink. 

Create further similar boxes by selecting the text box and Shi ft
dragging to copy it. 

] Data field 

] ~:!;~!!!~!!!;~~~~ 
I:gJ D.isplay field nane 

] Field nane: r-IHA-M=EI.--------------.. 

J 

J 

] 

J 

J 

.ilK ~ I Cancel I I Mail Merging" , 

New Field dialog 

Papyrus lets you prepare serial letters (mailmerge) and reports by 
processing information from a data file, prepared with some database 
program, according to a merge file prepared with Papyrus. The merge file 
controls the way that the data from the data file is imported into the 
merged document. 

Mail merging 

mmm!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!iii!!!!!!!!!!!!!!!!!!!! M a i I Mer II i n II mm!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!m!!!!!!!!!iii!!!!!!!!!!!!!!!!!!!! 

Data file: 
~==================~ Hafile file: 
~----------------------------~ 

DATA,EXP 

Data Fornat ---------------------------------, 
@ One entry per line, 

at least II] lines per record 

() Confila ieparated 

()I User-defined fornat", 

l:gJyenerate a neH page for each record 

Create D.ocunent ~ I fr i nt "' I I .ilK I I Cance I I 
Mail Merging dialog 
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The process of merging the records from the data file with the Papyrus 
merge file is started by the following procedure: 

.. 
• 
• 
• 
.. 

• 
• 

Select the Data Field entry of the Special menu . 

The Create Mail Merge Entry dialog is displayed. 

Select Mail Merging ... (Alt-M). 

The Mail Merging dialog is displayed. 

Select a Data file and a Name file if necessary, by clicking in 
the box to call a file selector and selecting the appropriate file. 

Set other options as explained below. 

If no other action is required, select OK (AI t-O) to remember the 
settings. 

Data file 

A data file holds a number of records, each of which consists of a number 
of fields. Each record is processed through the merge file in turn, in the 
order in which the records appear in the data file. 

Name file 

If field names are used in the merge file, but they are not given in the data 
file itself, then it is necessary to use an auxiliary (field) name file. This file is 
in the same format as the data file and consists of one record which 
defines the field names in the order in which they appear in the data file. 

From the Data Format box, select one of the following, to match the 

r 
r 
r 
r 

I 

I 

chosen data file: I 
.. 

.. 
o 

One entry per line (Alt-L); if this entry is chosen a minimum 
number of fields per record may be selected to prevent blank 
fields appearing to be false end of record markers. 

Comma separated (Alt-S) . 

User defined (Alt-U). 

One entry per line 

.. Each field is placed on a new line . 

• The end of a record is indicated by an extra (blank) new line. 
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Comma separated 

o 

o 

Each field is separated from the next by a comma. 

The end of a record is indicated by a new line. 

Field separator: 1,1 
~=~ 

Data separator: ICR LF 
~==~ 

Quote tharat ter: LI'_" ' __ --' 

I ~antel 

User Defined Format dialog 

The field separator may be freely defined. 

The end of record separator may be freely defined. 

A quote character may be defined; if defined, pairs of these 
characters may enclose data fields. 

Data file organisation 
Papyrus is able to process a number of different data file organisations, to 
make it easier to export data from the database program being used. 

fieUd names 

If possible, the first record of the data file should contain the field names 
from the database. This procedure is much easier than it sounds. Using the 
manual which came with your database will make it straightforward. 

Hnserling C1I lieDeR 

j A data field is added to a Papyrus document by the following procedure: 

o 

o 

Select the Data Field entry of the Special menu. 

The Create Mail Merge Entry dialog is displayed. 

Provide the appropriate information for the Field name (see 
below). 
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If you do not want the field name to be displayed in the 
document, de-select Display field name (AI t-D). 

o Select DK (Alt-D). 

Naming a field 

Name a field by using a field name from the data file, or its auxiliary field 
name file, in the Create Mail Merge Entry dialog. 

Se8eding t!he next field on crder 

Select the next field after the last one read from the data file by leaving the 
name field empty in the Create Mail Merge Entry dialog. 

SeHecting fneHds by @lrder number 

Select a field by its order in a data file record by giving a field number in 
the Create Mail Merge Entry dialog. The first field is numbered 1. 

Named disp8ClY @f fields 

A data field is displayed as a boxed arrow plus the associated name, or 
number, when Display field name (AI t-D) is selected in the Mail 
Merge Entry dialog. 

A data field is displayed as a boxed arrow only when Display field 
name (AI t-D) is de-selected in the Mail Merge Entry dialog. 

The Generate new page for each record option allows you create 
either serial letters or reports with the merged data. 

A serial letter takes a new page (sheet of paper) for each record in the data 
file. The Generate a new page for each record (AI t-G) option should 
be selected (checked). Each letter, which may be several pages long, will 
start on a fresh page. 
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A report produces a single, continuous document for all the records in the 
data file. The Generate a new page for each record (AI t-G) option 
should be unselected (unchecked). Records appear one after the other, in a 
continuous flow. 

After the report has been generated, it will probably need text etc. adding 
both before and after. 

The Create Document (AI t-D) option opens a new window titled 
Filename Mail Merge into which the merged document is created. The 
merge file is a normal Papyrus document to which one or more data fields 
have been added. Each data field acts as a place holder. When the merge 
file is merge processed, the corresponding entry from a data file record is 
inserted at the data field position and the merged document layout 
adjusted to account for the width of the inserted data. 

Plfunt 

Selecting Print ... (AI t-P) brings up the Print Document dialog box from 
which the parameters for the printed document may be set. See P r i n t on 
the File menu for full details on the Print Document dialog. 

Useful Database information 

Papyrus does not directly support data files in the following formats: 

o DIF. 

o dBase II. 

o dBase III. 

o Fixed length field. 

If you wish to use data in any of these formats, the data must first be 
processed into a form which Papyrus accepts. 
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Superbase Professional 

A Superbase Pro database may be used by the following procedure: 

• 

• 

• 

• 

• 

• 

o 

Open the required database. 

Select an appropriate filter. 

Set the separator to be the double quote ( ") character from the 
Options entry of the System menu. 

Export the file. 

Optionally, create an auxiliary name file. 

Generate a Papyrus merge file; use the field names if an auxiliary 
name file exists or use field numbers if that file does not exist. 

Merge the data as described above. 

Twist 2 
For a Twist database to be used, a report file must be set up. This report 
file must be set up to contain the field names in the report header, 
followed by the data fields in the data part section below. 

The import/export parameters should be set up so that the file is exported, 
for instance, as a line oriented file. The column name box must be selected 
to ensure that the field names appear in the exported data file. 

Export the file. The Papyrus merge file may use the field names with no 
problem at all. 

Other databases 
Refer to the manual and use your native cunning to generate a file format 
that requires least work on your behalf. This will often mean setting up a 
special report for Papyrus mail merging or adjusting user definable 
parameters. 
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Example 

i~···i;;·i·t;;···[j··"~~;·;·;·;·;:~·;;·~·~;;···········....... . ........................................................... ··············r······· .. ·· .. ·········· .. ·····M·y··fj'~tl 

i~ ;\ddre';'; 1 I My streetl 
!~ ;\ddre';';;;! ! My Town! 
I~ ;\ddre';';'~ ! POSTCODE! 
i~ ;'\ddre';';4 1 Phone number: 

I Dear~ Fo rem me t ...................................................... ...1 

i 
jhow ue you fixed ~~~~~!? ~~~~~and ,orne ,un andl 

!fresh air~ i 
~ 

Mail merge example 

You can just as easily use mailmerge to write invitations to a party, 
renewal notices for a society or whatever else you can think up. 

Indexing Shift e'f'I""m 

:::::::::lllH::i::::::::::::::::::H:::::::::::::::::H::::::::::::::::::::::lll::::ii C rea te I n de x E nt r y iiiiiiiiiii:::::::iiiiiiillliiiiiiiHiiiii::i:::::iii:iiiiiiiHi~ii::Hiiiiiiimi:i: 

Entry: ~ing Charle~ 
Sub-entry of :1 cS!::...pa::..:cn:..::.i.::.;el~ _____________ --, 

r Include 
o Con!lerse o Hithout title o Include lext style 

Page HUMber --------------------, 
o D.old 0 Italic 
Before 1'---'1 ~ Page nUMber After 1 

.!!.K II Cance I I I As Defau I t I I 6enerate Index I I , 

Create Index Entry dialog 

The basic concept of an index is that a subject, represented by a keyword 
or phrase, in a list has a set of page references where that subject is to be 
found in the main body of a document's text. 
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Papyrus provides powerful two level indexing that easily handles most 
requirements of technical documents, reference works, text books and 
similar enterprises. Papyrus allows index entries to be either: 

• 

• 

A specific word (or words) and the position (page number) at 
which it appears in the text. 

Some word chosen by the author which is linked to a position 
(page number) in the text. 

Entry levels 
Papyrus allows entries in the index to be of two types: 

A principal entry. 

r 
r 
r 

A sub-entry of a principal entry. I 
Each principal entry is given its own line in the index. A sub-entry appears 
in the index underneath a principal entry. I 
Serf order 

Index entries are sorted in ascending order, starting with 0 to 9, then A to 
Z, followed by unusual characters. Umlauts and accents follow the letters 
A, 0 and U and IS follows SS. Scandinavian umlauts are sorted after all 
other characters. 

Marking index entries 
Marking index entries is a very simple procedure: 

o 

• 

• 

• 

Page 170 

Place the cursor at the start or middle of a word, or select a block 
of text (the block may be discontinuous). 

Select the Index Entry entry from the Special menu (Shift
Ctrl-I). 

The Create Index Entry dialog appears, which allows full control 
over the form of index entry associated with the selected word or 
block of text. 

Amend the dialog entries as required. 

Select OK to record the index entry. 
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The index entry now appears in the text as a grey marker, at the start of 
the word or marked text area. 

Index entry indude options 

The offered Create Index Entry box may be amended in a number of ways: 

The offered entry may be changed to whatever is required. 

A principal entry may be specified in the Sub - en try 0 f field, under 
which the entry will appear in the index. Be careful that the spelling of the 
principal entry is correct. 

If Converse entry (AI t-V) is selected then the index entry will appear 
twice. Once as described above and once with the principal and sub-entry 
swapped. If A is a sub-entry of B, then the index will also include B as a 
sub-entry of A. 

With@lJ.Qif' if'otBe 

If Without title (Alt-W) is selected then the index entry will appear 
twice. Once as described above and once with the entry as a principal 
entry. If A is a sub-entry of B, then the index will include A as a principal 
entry. 

When Include text style (AI t- T) is selected the index entry takes the 
text style of the text it appears in. This is useful for foreign character sets 
etc. Beware: the sort order may not be what you intuitively expect. 

The generated index can have the page numbers inserted before or after 
the index entry as well as in various styles, the options available are: 

The page number may appear as bold text (AI t-B). 

The page number may appear as italic text (AI t- I). 
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• 

• 

Text may appear before the page number. 

Text may appear after the page number. 

• The page number may be suppressed (AI t-P), if Page number is 
unchecked (AI t-N). 

As default 

The selection As Default (Alt-D) sets further occurrences of previously 
given index entries with the same options as previously selected. The 
further entries are amendable. 

Index file creation 
Index file creation is controlled from the Generate Index (Alt-G) 
selection of the Create Index Entry dialog. Taking this entry leads to the 
Generate Index dialog from which indexes can be generated. 

~t fill!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!iii!!!!!!!!!!!!!!!!!!!!!!! 6enerate Index I!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!i 

Nothing read. 
@ for DRTR. RSC 
() For all open ~ocuMents 

Insert before sub-entr i es: I!..II ___ -, 

r Page nUMber ranges 
() 1,2-34 @ It: ~ pp: IE:] 

Read and 6enerate I I Read !.p.enerate I I Cancel I 
Generate Index dialog 

Single file 

To index a single file, already open in Papyrus: 

.. 

.. 

• 

.. 
• 
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Make the file the top window . 

Go to the Generate Index dialog as described above . 

Select the style options described below. 

Select For filename (Alt-F) . 

Select Read and Generate (AI t-A). 
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The index appears in a new window, labelled Index ,of the open file. 

o 

o 

Amend and re-style the index file if necessary. 

Set the start page number if the index file is to have page numbers 
consecutive to its parent file. 

Save and or print the index file. 

Documents composed of multiple files may readily be indexed (see below). 
Before indexing, it is important to make sure that the page numbers flow 
in sequence from one file to the next. Manual adjustment will usually be 
necessary. 

M(1JIOto[pOe foOes (J) 

To index several files (method 1): 

o 

o 

o 

o 

Adjust the starting page numbers of all the files that are to be 
indexed, so that the page numbers flow in the correct order. 

Open each of the files. 

Go to the Generate Index dialog as described above. 

Select the style options described below. 

Select For all open documents (Alt-D). 

Select Read and Generate (AI t-A). 

The index file appears in a new window, labelled Index of, the topmost 
open file. 

o 

G 

Amend and re-style the index file if necessary. 

Set the start page number if the index file is to have page numbers 
consecutive to its parent file. 

Save and or print the index file. 

This procedure is limited by the maximum number of windows which 
may be open at anyone time, which in turn limits the number of files 
which may be open at anyone time. Each opened file requires a window. 
For a standard ST the window limit is 4 or 7, for a Falcon up to 15. Various 
patch programs exist which may increase this limit. 
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Multiple files (2) 

A second method avoids the potential problems of method 1. To index 
several files (method 2): 

.. 

" 

" 

" 

Adjust the starting page numbers of all the files that are to be 
indexed, so that the page numbers flow in the correct order. 

Open the first file . 

Go to the Generate Index dialog as described above. 

Select the style options described below. 

Select Read (AI t-R). 

The file is indexed and G en era t e becomes available as a 
selection. 

Close the original file. 

Open the next file in the sequence, go to the Generate Index dialog 
as described above and select Read (AI t-R). 

r 
r 
f 

I 

f 

The index from the newly opened file is added to the existing index and I 
Papyrus reports how many entries have been indexed. 

.. 

Close the newly opened and indexed file and repeat the process 
until all the desired files have been indexed. 

Select Generate (AI t-G) to output the index to a new window, 
which will be labelled Index, of the most recently opened file. 

" Amend and re-style the index file if necessary. 

" 

o 

Set the start page number if the index file is to have page numbers 
consecutive to its parent file. 

Save and or print the index file. 

Sub-entry prefix 

The Insert before sub -ent ries field allows text to be printed before [ 
sub-entries, such as an asterisk. . 
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Sometimes the same index entry appears on several pages, one after the 
other. This may be represented in the index either by: 

o 

o 

A pair of page numbers separated by a hyphen (AI t-1). 

A single page number suffixed by f if the same reference appears 
on the next page, or ff if the same reference appears on more 
than two consecutive pages (AI t-P). The indicators f and ff may 
be changed if required. 

An index entry is tabbed from the entry name to the first page number. 
Further page numbers follow the first, in rising numerical order and are 
separated by commas and spaces. 

When an index file is generated, it has two tags associated with it. 
ENTRY 1 is the style for principal entries and ENTRY 2 is the style for sub
entries. These may be re-styled as for any other tags. Note that the default 
setting for these tags is that all attributes are switched off. 

When the index is generated, Papyrus searches for a template file called 
_INDEX. PAP, according to the standard template search order (see section 
ii'emp8coffe). If this is found, then that template will be used to generate the 
index file. If it is not found, then Papyrus bases the styles ENTRY 1 and 
ENTRY 2 on those used in the currently open document. 

The planning and presentation of an index is important to the utility of the 
final result. Function follows form. In other words, if the index is ugly and 
unreadable it is wasted. The reader needs guides around the index. 

The default settings of ENTRY 1 and ENTRY 2 will require changing. Even 
Papyrus is not clever enough to know how your index should be laid out. 
Often, the font for ENTRY 2 should use a smaller point size than that for 
ENTRY 1. 
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Leffer separators 

To help the reader find the right general area of an index it is useful to 
include markers for each new letter. Not only are these guide-posts, but 
they help to break up the text and make it attractive. They must be added 
manually, but at least there are only 26 or so of them! Use of a tag to set 
their spacing, font etc. is recommended. 

Advice to authors 

Papyrus's facilities will allow you to produce, if you wish, an index that is 
almost as long as your base text. Decide what to index by thinking of your 
reader. What will they want to find from the index? Does the reader really 
need to be able to find all the fine detail? Conversely, are you about to 
miss some major issue? Typically a non-fiction book's index is 1 % to 5% as 
many pages as the rest of the book. The more a document is a work of 
reference, the longer its index is likely to be. 

Design the style of the index as carefully, if not more so, as the rest of the 
document. A poorly styled index is very hard to use. 

Tables 

Papyrus provides extensive table manipulation facilities, to make the 
preparation of tables simple and efficient. 

Conceptually, a Papyrus table is an ordered rectangular arrangement of 
cells, such that each cell belongs to one row and to one column, with line 
boundaries between adjacent cells. 

Col A Col B Col C 

Row 1 

Row 2 

Row 3 
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When table calculations are being used each cell is labelled by its column 
letter and row number, in that order, as shown below: 

Col A Col B Col C 

Row 1 A1 B1 C1 

Row 2 A2 B2 C2 

Row 3 A3 B3 C3 

Currently, tables are only possible in the main text. They may not be 
present in headers or footers, nor in other text objects, nor in footnotes. 

fableooo 0"'-1 
There are two ways to generate a table. Either an empty table may be 
created or tab-separated text may be transformed into a filled table. This is 
controlled from the Table entry of the Special menu. 

r Type ... ~ ............ HI 
BEJEJDIl[j[][j[]~ • 
Cells Table 

Width 115,81111'11'1 
"or. l'Iargin ~I'II'I 
Uer. l'Iargin ~I'II'I 

Unite tells 

c::r:J I ~antel I 
£::iiliJ I Revert I 

ROMSC] 
Colul'lnsC] 

Left Indent [![:=J 1'11'1 

Spli t tell 

The first line of the dialog allows the type of table to be selected. This is an 
initial table layout which may be modified later. 

.. The Text button converts an existing table to tab-separated text 
form to allow easy amendment or export, if necessary. 
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o 

o 

Rows and Columns set the size of the table and the Left indent 
specifies a margin from the left hand of the text column. 

Table-----

ROHS L::=J 
colUl'lns~ 

Left indent [![::=J 1'11'1 

left / right and top / bottom margins set the clearance 
between the nominal cell borders and the display box containing 
the cell contents. 

Cells ----------, 

Width 115. Bllll'1l'1 
Hor. l'Iargin IC::]I'II'1 
Ver. l'Iargin IC::]I'II'1 

Width sets the overall cell width. 

The display box is unaffected by the width of any separation line. 
The height of each row and thus the size of the display box, is 
automatically adjusted to allow each table entry to be displayed. 

For text layout purposes each cell entry counts as a separate 
column. If text in a cell is set fully justified then it will be justified 
across the display width of the cell (in a narrow cell it is often best 
to set text ranged left or centred to avoid ugly gaps in the text). 

Clicking on OK or Apply will set the table you have just defined. If 
it is an empty table it will be inserted at the current cursor 
position. 

Tab-separated text has: 

o 

o 
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a new line at the end of each row (Return key), 

entries (which may be empty) for each column of a table, 
separated by tab characters. 
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Text entry info a table 

After an empty table has been created it looks like this: 

o If the cursor is clicked in any of the cells (empty or not) further 
text entry takes place from that point. The Tab key moves the 
cursor from one cell to the next, column by column and to the first 
column of the row below from the final column. 

o Shi ft-Tab moves the cursor to the previous cell. 

o 

o 

o 

o 

" 

o 

o 

An ordinary tab character may be entered into a cell by using the 
Al t -Tab keystroke. 

Shi ft-+- or Shi ft-~ move the cursor to the previous or next 
field respectively, when the cursor is at the left or right edge of a 
cell. 

The t and ~ keys move the cursor to the row above or below its 
current position. 

The +- and ~ keys move the cursor over all the text in a cell, in the 
usual way, but jump from one cell to the next at the start and 
finish of that text. 

When text (which may include a picture block) is entered into a 
cell Papyrus automatically adds text lines to the cell such that the 
contents of the cell may be fully displayed. At the same time, the 
height of all cells in the corresponding row is set to that required 
by the tallest cell. 

Ctrl-Return causes a new (empty) row to be inserted below the 
row the cursor is resting in. 

Shift Ctrl-Return causes a new (empty) row to be inserted 
above the row the cursor is resting in. 

Ctrl-DeIete causes an entire row to be deleted at the cursor 
position if the cursor is in a cell containing a single line only. If the 
cursor is in a cell with more than one line of text, then only the 
cursor's text line is deleted. 
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• The number of columns may be adjusted by setting the cursor 
somewhere in the table, calling the Tab 1 e dialog from the 
Special menu, increasing the number of columns and setting 
this with OK or Apply. The new columns appear to the right of 
the existing columns. 

Inserting tab separated text 

Tab-separated text may be made into a table by the following procedure: 

o 

o 

Prepare tab-separated text, either in Papyrus directly or using 
some other procedure. Often a database or a spreadsheet can 
easily export its data in tab-separated form, using a built-in option. 

Import the text into the document, at the point where the table is 
to appear. 

Select all of the text with the text cursor. 

Bring up the Table entry of the Special menu. 

Select the table style required and any dimensions (do not select 
Text): 

o Select OK or Apply. 

o The table is built and appears in the document, with the cells filled 
with the data from the tab-separated text. 

CeOU seUedo@ffIJ 

To select one or several cells use the following procedure. Set the cursor in 
a cell. Depress the left mouse button and keeping the button depressed, 
drag the cursor to another cell. The cursor changes to a pointing finger 
and at least two cells invert their colours. 

aWl 
ba 

ea 

.. 
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bb be 

eb ee 

To select the original cell only, drag the cursor back inside and 
release the mouse button. That cell is now selected. 
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o 

To select a rectangle of cells, drag the cursor to select the cells 
required and release the mouse button. That rectangular set of 
cells is now selected. 

To select (and de-select) a single cell, leaving an existing selection 
otherwise intact, Shift click when the mouse pointer is a hand. 

To select a single cell Ct r 1 click with the text cursor. To select a 
single cell, clearing any other selection, Ct r 1 click when the 
mouse pointer is a hand. 

Column widths 

After a number of columns, which may be a single column, have been 
selected: 

o The widths of the selected columns may be set using Width from 
the Table dialog, with other column widths remaining constant. 

The widths of the selected columns can be set by dragging a 
vertical column selection bar, with other column widths 
remaining constant. 

After a single column has been selected, the width of that column may be 
set by Shi ft dragging a vertical column selection bar, with the overall 
table width remaining constant. 

bB' 
j--~~ ••• ~' .. ~:.:.:~-. ' .• , 
.. 

. ---------- -" "- - --

As always, column operations involving dragging with the mouse may be 
aborted by pressing the right mouse button before the left mouse button 
has been released. 

Line sty8i1l19 

Individual lines, or parts of lines, within a table may be freely re-styled 
using the Line style dialog from the Ob j ect menu. This styling includes 
width and colour. 
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First, the arrow cursor is required: 

.. 

.. 

.. 

.. 

A click selects an entire boundary line (horizontal or vertical), 
clearing any other selection. 

A Shift click adds an entire boundary line (horizontal or vertical) 
to the existing selection, or removes it from the selection if it was 
already selected. 

A Ct r 1 click selects a boundary line segment (horizontal or 
vertical) for a single cell only, clearing any other selection. 

ASh if t -C t r 1 click adds the boundary line (horizontal or 
vertical) for a single cell only to the existing selection, or removes 
it from the selection if it was already selected. 

The dialogs Line style and Colour from the Obj ects menu will now 
affect the selected lines and line segments, allowing as complicated a 
layout as you care to use. 

Cell styling 

After a cell has been selected (or a group of cells) that cell may be styled 
with both colour and a fill pattern with the Colour ... and Fill... pattern 
entries from the Obj ect menu: 

r 
r·· 

r 

I 

I 

I 

I 

I 
Text within a cell may be selected and given its own colour in the same 
way as for any other text. I 
Paragraph oHsets 

Text in a table should have the paragraph offsets (Paragraph Offsets 
entry of the Special menu) set to 0 points before and 0 points after. It 
may be convenient to set up a tag specifically for tables. 
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Vetrtic:aO ten 

Cells of a table may be given a vertical orientation by selecting the cells, 
selecting the Orientation ... entry from the Obj ect menu and rotating 
the cells. 

ab ae ad 

bb be bd 

ea eb ee cd 

da db de dd 2.70· 

c::iCJ I ];aml I 
~ I Revert I 

The cell entries rotate and two grab handles appear, the lower of which 
allows the height of the cell's row to be set by dragging, in the same 
manner as for setting the width of other cells. In this case however, there is 
a minimum dimension set by the height of the horizontally oriented cells. 

ae ad 

be bd 

ea eb ee cd 

da db de dd 

A group of cells may be transformed into one larger cell by selecting the 
cells and then selecting Un it e cell s from the Tab 1 e entry of the 
Special menu. 

ab ae ad 

bb be bd 

eb ee cd 

da db de dd 
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Cell splitting r 
In similar fashion, a single cell may be split into two (or more) by selecting 
Spli t cells from the Table entry of the SpeCial menu. r' 

aa ab lac ad 

ba bb bd 
- be r--
ea eb cd 

ee I 

da db I de dd 

Tables may be copied by selecting the table with a text cursor and then 
selecting Copy from the Edit menu (or moved by selecting Cut from the 
Edit menu). 

a.1 ab U~ ~ 

~ bb I~ M 

N ICb U~ ~ 

d. U~ I~ dd 

The cursor is then moved to the table's new location and the table pasted 
in by selecting Paste from the Edit menu. The table may be pasted as 
many times as required. Note that the various copies of the table are quite 
independent of one another. 

COlTDvers;olTD to 71'ob-separated text 

To convert a whole table to tab-separated text, first place the text cursor 
somewhere in the table and then select the Table entry of the Special 
menu. The whole table will be selected. Selecting Text will convert the 
whole table to tab-separated text, where previously the table was 
(frequently this procedure is best carried out on a copy of the original 
table.). 

The same general procedure may be used for part of a table, but selecting 
the cells to be converted first. 
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CelD Typeo 0 0 Shih Ctlfl= 1 

The results of calculations and the contents of any other cell, may be 
formatted from the Cell Type dialog of the Special menu. 

o !!nforMatted (text or nUMber) 
o Expliti t text 
® Eorl'latted nUMber: ---------, 

ForMat I 12345,67 I 
Hi nus c::.:!!!] D Red 

DetiMals I!J [gJ Zero pad 
D !!ertentage 

Before I 
After I~======: 
D Exatt taltulation 

[IJ I J:.antel I 
I ftpply I I Revert I 

A normal cell is unformatted (text or number) and can hold either text or a 
number. Setting a cell to Explicit text marks that cell for exclusion 
from any calculation. Setting a cell to Formatted number allows control 
of the presentation of the contents of the cell. 

o 

o 

o 

o 

o 

& 

Format allows decimal point and thousand's separators to be set. 

Minus allows the presentation of a negative number to be set. 

Red sets negative numbers to be printed in red, rather than their 
otherwise assigned colour. 

Decimals sets the number of decimal places displayed. 

Zero pad, if checked, forces zeroes after a number such as 1, 
which is otherwise printed without a decimal point, so that it 
appears as 1.000. 

Percentage displays a fraction as a percentage, with a % symbol, 
such that 1 appears as 100%. 

Before and After set text strings to be printed before and after 
the number, such as £ and p. These strings may include tab 
characters to assist in formatting. 

The Menus Papyrus Gold Page 185 



If Exact calculation is not checked, then the displayed result 
is used in any other calculation which references it. If E x act 
cal cui a t ion is checked, then the full contents of the cell are 
used in any other calculation which refers to that cell. 

Calcu/ation.oo 0,.8 ... * 
Papyrus allows for easy calculations within a table, such as summing rows 
or columns. 

1ZIl1utol'latic I !!pdate I 

This is enabled from the Calculation ... entry of the Special menu. 
Table cells are numbered, as explained in the section rab8es. 

Col A Col B Col C 

Row 1 A1 B1 C1 

Row 2 A2 B2 C2 

Row 3 A3 B3 C3 

IPrrcf:edrlJJtre 

Place the text cursor in the desired table entry. Call the Calculation 
entry of the Special menu. Place the cursor on the function pop-up. A 
function selection bar appears, from where a function may be selected. 
The function is placed into the formula line. 
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ABS(x) 
SI6N (x) 

CEIL (x) ~ 
FLOOR (x) 
ROIINO (x) 
!RIINC (x) 
fRAC(x) 

SORTlx) 
fAC(x) 

E 
EXP(x) 
L06(x) 
L0610 (x)
COLIIHN 
LINE 
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Functions, such as SUM, with opening brackets, require closing brackets to 
be entered by the user. The multiply (*), divide(l), addition (+) and 
subtraction (-) operators may be used, along with brackets to group 
calculations together. If brackets are not used the order of calculation is 
undefined. When the formula is complete, select OK or Apply. The cell's 
screen display is flagged to indicate a formula and the process is complete. 

SUM computes the arithmetic sum of the cell entries in the square defined 
by ax (top left cell, such as AI) and by (bottom right cell, such as B2). The 
two cell references must be separated by two dots. 

C:oDlIJmUTJ cmeR UiUTJe 

These functions return column and row numbers, where column A maps 
to 1, column B to 2 etc. 

OtOneD' fllmdioUTJs 

Other functions may be typed in directly: 

o 

G 

PI (3.14 ... ). 

SIN, COS, TAN for sine, cosine and tangent (argument in radians). 

ASIN, ACOS, ATAN for arcsine, arccosine and arctangent (result in 
radians). 

SINH, COSH, TANH for hyperbolic sine, cosine and tangent 
(argument in radians). 
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Object Menu 

The Db j ect menu provides commands for working with objects on a 
page in Papyrus, whether in the background layer, or on top of the page. 

Line style", 
Fill pattern", 
Colour, , , 
Orientation" , 
Attributes, , , A , 
Picture Size", AI 
Picture Window", oAR 

Put to back 
Rrillg to front 

The toolbox icons appear at the top of the menu for easy access to them 
without having to move windows to get to the control panel on the 
Papyrus desktop. For full detail on using the toolbox icons see the section 
titled The Toolbox. 

The Line Style ... command opens the Line Style dialog, this allows the 
line attributes of the current selection to be modified (assuming a line or 
area is currently selected), or to allow the options of future lines to be 
preset. 
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The line style is used when drawing filled areas to set the outline used by 
the object. 

~tart ~nd 
@- @-
0....... O-+-
0- 0-
Style -------., 
o no llne o 0.13 

o 0.25 

o 0.5 

@ 0.7 

o 1.0 

o 1.4 

Thickness 

o Halrllne 

0----
0--------
0·_·_·_·_· 
0- - --
0·-··-··-··-·· 
0································ 

10.71 11'11'1 

OK I I Cancel I 
Apply ! I Revert I 

Start and End set the form of the ends of lines: squared, arrowed or 
rounded. The Style portion sets either the line's thickness, or its pattern, 
via a set of radio buttons, alternatively a custom line thickness may be set; 
note that a thickened patterned line is not allowed - a line may either be 
thickened or patterned. 

fill Pattern .... " 

The Fill Pattern ... command opens the Fill Style dialog, this allows the 
fill attributes of the current selection to be modified (assuming an area is 
currently selected), or to allow the options of future areas to be preset. 
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Within the dialog either a fill pattern, or a grey level, may be chosen via a 
set of radio buttons, alternatively a custom grey level may be set; note that 
a grey pattern is not allowed - an area may either be grey or patterned. 

6rey Level: my
O Iransparent 

-----. 
OK I I Cancel I 

I llpply I I Revert I 

The Transparent option makes the filled object frame transparent, i.e. 
any text, object or picture underneath it will show through. The empty fill 
pattern is always transparent, whereas 0% Grey, i.e. white, may be made 
either transparent or opaque. 

Note that double-clicking on selected object frames provides a quick way 
of accessing the Fill Pattern dialog. 

Colour'"." 

The Colou r ... command opens the Text/Object Colour dialog, this is 
identical to the Colour ... option discussed in the Style menu section. 
The menu is replicated on the Obj ect menu for ease of access. 
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Orientation", e" 

The Orientation ... command opens the Orientation dialog, this allows 
selected objects to be rotated in 90· steps: 

.!lK I I Cantel I 
apply ~ I R.evert I 

The Attributes ... command opens the Attributes dialog, this allows fine 
control over the position of an object, together with the manner in which 
text flows around the selected objects. 

~~ I:m:m::::::m:m:::::::::::::::::: Db jet t Attr i butes iii:::::::::::::::::::::::::::!!!::::: 

X .13.8791 1 inth Width .13.595 1 inth 
y.17.318 1 inth Height ®12.488 1 inth 

®!2J !!trap around 
Left/right distante 10.157 1 inth 
Top/botton distante 10 1 inth 

®!2J Text ignores Nraparound 
®!2J Objett height groNs Nith text 
@!2J .!!roportional resizing 
1ilI!2J ShON only on streen 
®!2J Anthor objett in .1ext 

!2J Only at paragraph start 

OK I I Cantel I I For neN pittures I 
Apply ~ I Revert I 

When a single block has been selected, then all parameters may be freely 
set and the selected block precisely placed anywhere on the page. 
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When several blocks have been selected, some parameters are usually 
deactivated if two or more blocks are on the same page. When the chosen 
parameters are applied, then those chosen parameters are applied to all 
selected blocks. For instance, two blocks could be set to have the same left 
hand margin. 

If the Permit dot next to a parameter is black, then that parameter is 
activated and will apply to all selected blocks. If the dot next to a 
parameter is an unfilled circle, then that parameter is deactivated and the 
parameter box is greyed out. The parameter will not be altered on any 
selected blocks. 

Activate and deactivate a parameter by clicking on the circle or Permit dot. 

X and Y set the horizontal and vertical distances to the top left hand 
corner of the block from the top left hand corner of the page. 

Width and Height set the area of the block from its top left reference 
point. 

Text on a page may be present in: 

.. flowing text blocks (columns), 

headers, 

.. footers, 

" text blocks (non-flowing). 

Papyrus allows a block to be set either: 

.. to force all text to wrap around it, by specified distances, 

o 

o 

to allow text to flow over (or under) it, 

to force column text wrap around it, by specified distances, but to 
allow text block text to flow over (or under) it. 

r 

r 

I 

I 

When W rap a r 0 u n d is set, then all column text is forced to be the 
distances specified away from the selected block(s). If a block is to the right 
of a flcolumn, then text flows to its lefdt banhd if. the blockbiS to tfhe left'btlhen [ 
text ows to its right. The wraparoun e avlOur may e set or any ock 
type: text, filled, picture or line. 

L 

l 
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Text ignores wraparound is used when placing a text box on top of a 
frame that already has wraparound selected. This will force the text in the 
text frame to not wraparound the other frame but instead to flow over the 
other frame. This is useful when annotating a diagram that requires the 
main body text to flow around the diagram but the annotations to flow 
over the diagram. 

Obj ect height grows with text allows a text object's height to change 
dynamically as additional text is entered; additional lines will be added or 
removed to/from the space used by the frame as the number of lines of 
text changes. 

Proportional resizing forces all resizes on a frame to size both x and 
y axes in a manner proportional to one another i.e. the aspect ratio of the 
frame will be maintained. 

Show 0 n 1 yon s c r e e n option allows objects to be used for display 
purposes only, when printed they do not appear. 

Anchor obj ect in text, if enabled, will create an anchor, a symbol 
indicating the piece of text to which the object is tied. Subsequently 
changing the text will cause the anchor to move with it. As you move the 
object a line is drawn from the anchor to the object that you are moving. 

If enabled, there is a further option to limit the position of the anchor to 
the start of paragraphs. 

In general, you will probably want to have objects anchored to the start of 
paragraphs as it will ensure that your graphics and text stay in step 
without your pictures suddenly jumping across the page. 

When you want to position a graphic, like a special symbol, within a 
paragraph, then you will want to disable the Only at paragraph start 
option. It should be noted that objects that have this option disabled 
cannot also have word wrap applied to them. 

Also if you are designing a backdrop for a document then you will want 
this without an anchor on a master page. 

The For new pictures option within this dialog allows the default 
settings for the wraparound and size of newly inserted pictures to be set. 
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Picture Size ..... 01'1"" / 

The Picture Size ... command opens the Picture Size dialog, this allows 
accurate scaling of the selected pictures. 

.r'I""'!;"">:;"""'" Picture Size "iH"";;;;;;"," 

Scale for 
o Screen @ frinter 

FactorD 
Width/Height D 
~ lJ;ancell 

0iiiiTY] I Revert I 

A picture block may be scaled, according either to the screen or to the 
printer: 

o 

o 

For a vector graphic (.GEM file) scaling according to the Screen 
preserves the correct image dimensions, scaled by an overall 
multiplicative Factor which sets the height of the picture and 
with an adjustable Width / Height ratio. Both of these may be 
arbitrary numbers in the range 0.02 to 64. This is the 
recommended procedure for a vector graphic image. 

For a bit-image graphic (.I MG file etc.) things are more 
complicated. The overall multiplicative Factor sets the height of 
the picture and the adjustable Width/Height ratio sets the 
width. The size of the printed image depends on the bitmap and 
printer dots per inch (dpi). 

With many images it is important to set the ratio of original image 
dots to printed image dots to be an integral ratio to avoid 
unpleasant moire patterning effects (this is also important if the 
direct dimensioning procedure noted above is used.) The table 
provides some useful starting points when scaling for the printer: 

r 
r 
r 

i 

i 

Note that double-clicking on selected picture frames provides a quick way I 
of accessing the Picture Size dialog. 

Picture WindowU0 Shift Clrl..,S I 
The Picture Window ... command opens the Papyrus picture window; l 
its use is to store the bitmaps and GEM metafiles inserted into a Papyrus . 
document, each document has its own picture window. 
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It is possible to zoom in and out of the picture by selecting entries from the 
Zoom menu, for more details see the Zoom menu. 

Papyrus can load graphics in both bit image and vector formats. Loaded 
graphics are placed in a picture window. From there they may be 
repeatedly placed into a document as a picture block, on each occasion 
being cropped if necessary. The picture window allows full image 
management and its contents are saved as part of the document. 

A graphic may be imported either directly from Insert on the File 
menu, or indirectly from the Picture Window entry on the Obj ect 
menu . If a picture is directly inserted, then it is both placed on the page 
and recorded in the picture window. Otherwise, the picture window must 
be opened and Load selected from the menu along the bottom. The 
graphic then appears in the picture window. 

A graphic may also be imported using paste if Use GEM Clipboard is set 
in the Import/Export ... entry of the Options menu. This facility is 
particularly useful when Papyrus is being run under MultiTOS or another 
multi-tasking or task switching system. 
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Picture placement 
When the picture window is opened, any graphic in it may be selected in 
the usual way, by clicking on it. A selection box then appears, complete 
with re-sizing handles. ,If necessary, it may be cropped by sizing the 
selection box, with its handles and moving it. The command Ins e r t 
Block will insert the graphic, as cropped by the selection box, on to the 
page. Close the Picture Window and the graphic will be found on the page 
(if in text mode, press Esc and click on the graphic to select it; if not in text 
mode, the graphic will already be selected.). 

The picture may be moved and resized with the arrow cursor in the same 
way as any other block. Its position may also be set from the Ob j ect 
menu using the Attributes ... option. 

Copying a picture block 

A picture block may be copied by selecting it and then Shift dragging 
with the left mouse button. An outline box appears representing the copy 
and when the mouse button is released a copy of the image appears in a 
new picture block. A second copy of the image can also be obtained by 
inserting the same image from the Picture Window. 

It is not possible to use the clipboard to copy picture blocks directly. If a 
text item which contains the anchor screen symbol is copied or cut into the 
clipboard, then the images associated with that anchor will appear in new 
picture blocks, in the same position relative to the pasted anchor, each 
time that paste is selected. 

Deleting a picture block 
A picture block may be deleted by dragging it to the Shredder icon, or by 
selecting the block and choosing Delete from the Edit menu, or by 
deleting its associated anchor, if it is anchored. If that block was the last 
instance of the image, then Papyrus will ask if the image is to be deleted 
from the Picture Window. 

This behaviour may be modified according to the setting Remove Unused 
Pictures in the Miscellaneous ... selection of the Options menu. An 
image may either be deleted automatically, the question may be asked as 
above, or the image may always be retained. 
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Picture Window Management 

After the Picture Window has been opened by selecting Pic t u r e 
Window ... from the Obj ect menu: 

.. 

.. 

.. 

.. 

An image in the Picture Window may be saved as an external file 
with the Save ... option. 

An image in the Picture Window may be deleted with the 
Remove ... option. 

Further occurrences of a previously selected image may be found 
with the Find Next option. 

An image may be loaded into the Picture Window with the 
Load ... option. 

An image in the Picture Window may be placed on the page with 
the Insert Block option. 

Bring To front 
Put To Back 

This pair of commands move the selected objects behind or in front of all 
other objects on the page (respectively). 

Zoom Menu 

Z5 Yo AFl 
33 Yo AFZ 
50 Yo AF3 
67 Yo AF4 
BO Yo AF5 

./ 100 Yo AF6 
117 Yo AF7 
ZOO Yo AFB 

Full page A( 
./ Nornal A~ 

Printer resolution A} 

Setu III 

All the options under this menu heading determine the size of the 
document shown in the document window. 
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All the zoom sizes have keyboard shortcuts as shown on the drop-down 
menu, e.g. Ctrl-Es (hold down the Control key and press the Esc key) 
gives Normal, which displays the actual size of the document as printed, 
provided an Atari SM124 Monitor or similar-sized high resolution screen is 
being used; thus, one inch on screen is almost exactly one inch on the 
printed page. 

Full page Ct r 1- < shows the whole page on screen, as most page sizes are 
too big to be seen on screen without scrolling. The percentage options are 
percentages of Normal, i.e. Normal is 100%. 

Printer resolution shows each individual dot as it will displayed on 
the print and so depends on the resolution of the current printer, as 
shown (and changed) via the Printer item on the Options menu. You 
can use this for the ultimate in print preview; letting you see each 
individual dot that the printer will be ask to print; remember that some 
printing technologies are not as good as others, a dot matrix or ink jet 
printer won't be able to print as precisely as a laser printer. The higher the 
resolution of the printer, the larger the image will be. 

When choosing to zoom to a larger size (whether from 100% to 200% or 
from 25% to 33%), a temporary frame is shown which should be moved 
over an area of the document by the mouse without holding down the 
mouse button. Clicking on the frame when it is over the required area 
displays it in the chosen size. 

Setup 

Selecting Setup .. , displays the following dialog that lets all the percentage 
options to be configured to personal taste. 
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Current ZOOM: ~:t. 
Menu Entries -------, 
1.~:t. 5.~:t. 
2.~:t. 6.[illJ:t. 

3.~:t. 7.1!ITJ:t. 
4. lIT:::]:t. 8. ~:t. 

OK I Canc.el I 
App 1 Y ~ I Revert I 
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If you are using a large monitor is being used, you may want to configure 
one of the options to show actual print size. 

You can also use this for zooming to a one-off degree by typing a number 
in the current zoom box and clicking on Apply. 

Options Menu 

I •• 

./ Ruler "R 
Vertical ruler 

Cycle JoIindoJol "W 
Cycle dialogue <:JAV 

Screen Display ••• <:JAD 
Mouse Actions ••• 
Dialogues ••• 
II'IPort/Export ••• 
Spellchecker ••• 
Miscellaneous ••• 

Mel'lory ••• 
Printer ••• 
Font Paths ••• 
COl'lpatibility ••• 

Save options 

The Options menu lets you configure Papyrus for your system and for 
the way you like to work. 

Ruler Cttrl-R 

Toggles the ruler and ruler icons on and off. A tick shows the ruler is 
enabled and the ruler is present. By default the ruler is shown. 

You may wish to switch the ruler off so that you can see more of your text 
on the screen at one time. You can still insert tabs into the text when the 
ruler is switched off, but you won't be able to see where your tabs will go, 
change the tag for this paragraph, etc. 

The components of the ruler are described in detail under The RuDer in 
the Toolbox section. 

Vertical Ruler 

Toggles the vertical ruler on and off. A tick shows it is enabled. 
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The vertical ruler is used for aligning objects and seeing where a given 
paragraph will appear when printed. The vertical ruler defaults to off as 
most people prefer the additional screen space for their text. 

The scales of both rulers are changed via the Screen Display command 
on the Options menu. 

Cycle Window Ctr/-W 

If more than one document is open, this function brings each document to 
the top in turn and makes it the active window. If a dialog is the currently 
selected window, this switches to the current document's window. 

Usually, simply clicking on a window makes it active and is quicker and 
more convenient than using the cycle function. However if you have a lot 
of documents open on a standard-size screen, using Cycle Window will 
be much quicker than re-sizing all the windows. 

This command is also great for people who like to drive with the keyboard 
only; the sequence Al t-W, Al t-W, Ctrl-C, Ctrl-N, Ctrl-V, Ctrl-W will 
copy the next two words under the cursor in the current window to a new 
one, leaving you editing the original window. 

Cycle Dialog Shift Cftrl-Y 

r 
r 
r 
r 

I 

1 

I 
If more than one dialog is open, this function cycles between them, 
making each one active in turn. Even if there is only one dialog open on 
the screen, this command will switch to it. I 
Usually, simply clicking on a window or dialog makes it active and is 
quicker and more convenient than using the cycle function. However, if ~ 
the required window or dialog is hidden behind another one then the cycle i 
option may be appropriate. 

Screen Display Shift elr/-D I 

This command brings up the following dialog to let you customise how 1 
your document is displayed on the screen. 

l 

L 
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I~ I!lliiilllillllimmmm Dotufllent Streen Dis p I a y lllllllllllll!ll!mmm 
Dptifllize Streen Display for 

@ 6EM-fonts ('8 x '8 DPl) 
o SignufII! 2 fonts ('8 x 188 DPl) 

Objett Handles 0 0 a ~ 
Unit I Mi II iflletres ! 

ShOH .. . 
IXI RedraH objetts abolle text 
lXI.I,.eft Margin 
IXI fi t tures 
IXI Objett Eraflles 
IXI Objett .8.nthors, SYfllbols o Spates, Tabs, o D.ase Li nes 

Return 

i .11K ~ I .c.antel I 

Optimise s~reen display 

This option toggles between GEM-fonts and SIGNUM!2 fonts. Choose 
whichever appears to make text clearer; generally if you are using just 
standard GEM fonts, have GEM - F 0 n t s selected. 

There may be slight changes in the height/width ratio of text characters. 
Only the screen display is affected. 

Object Handles 

These are the small black squares which surround selected frames. The 
size of the handles may be chosen by clicking on one of the buttons. If you 
find that large object handles are distracting and don't give you enough 
fine mouse control, then choose a smaller size. Alternatively, if you are 
using a high resolution on a small monitor, using a larger size may mean 
that you can actually see the handles! 

Units 

Clicking on the Units box gives a choice of units, millimetres, 
centimetres, inches and picas. A pica is 1/6th inch. The Rulers and 
the Page Layout, Table, Line Style and Object Co-ordinates dialogs will be 
changed to the selected units. 
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Show 

This group of check boxes lets you set how text and objects are displayed 
on the screen when editing. This is very much a matter of personal choice 
- some people like to see the document as it will appear on paper while 
others prefer to be able to see exactly which special characters they have 
inserted. 

Redraw Objects Above Text 

If this item is enabled, i.e. a cross is displayed in the little box by this item, 
then objects will be drawn over the text that you are editing, possibly 
obliterating what you are typing, but showing how the document would 
appear when printed. 

If you disable this option, then objects won't be drawn over the line that 
you editing, but will re-appear when you move to another line or print the 
document. 

Left Margun 

When Left Margin is selected, the white space to the left of the text area 
is shown on the screen. The size of this margin is set in the Page Layout 
dialog on the File Menu. 

When this margin isn't displayed there's more room for your text on 
screen, so you'll need to use the horizontal scroll bar less. On the other 
hand, if you want to place objects to the left of the text area, you won't be 
able to do this without enabling this option. 

Pictures 

If enabled, i.e. a cross is inserted in the little box by clicking on it, imported 
pictures will appear in the document. If disabled, the picture is replaced by 
a grey fill and scrolling and screen display is faster. 

Obled /Frames 

This option controls whether a box is shown around text frames. If 
enabled, text frames are visible - but not printed. If disabled, they are not 
shown on screen and the document is shown as it will appear in print. 
Text frames are described in the Toolbox section. 
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Objed Anchors, Symbo8s 

Anchor symbols are used to indicate the paragraph that an object is tied to. 
When Obj ect Anchors, Symbols is disabled, anchors are only shown 
when moving the object; with this option enabled the anchors are shown 
all the time. 

This option also controls whether index entry symbols and special 
characters (as inserted via the Special Chars item on the Special 
menu) are displayed. The corresponding text is always shown, this option 
just toggles the symbols that tell you that you have used a special 
character rather than ordinary text. 

Spaces, Tabs, lRe1i1lD1f1!D 

When enabled, non-printable characters are inserted in text to indicate 
spaces, tabs and carriage returns. Spaces are shown as a single dot, tabs as 
a line of dots and carriage returns as an arrow like that traditionally used 
on electric typewriters. 

This option can often be useful to check that you don't have multiple 
spaces when only one is required or that you have used spaces where a 
tab or carriage return would be more appropriate. However many people 
prefer the cleaner look when this is disabled. 

If enabled, non-printable dotted lines are drawn along the base line of 
each text line. The base line is the line at the bottom of characters without 
descenders. This is useful for lining up text and object frames. 

~ IliiiiiiiiiiiiiiiiiH1iiiiiiiiHiiiiiiiiiiHii Mouse Ac t ions iliiiiH1iiiiiiiiliiiiiiiiiiiiiiiiiiiiiiiiii 

~}hOH ~ouse position in ruler(s) 

~Horizontal auto-scrolling 

UK t.ancel 

This dialog configures the behaviour of the mouse when using Papyrus. 
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Show Mouse position on ruler(s) 

If this option is enabled, i.e. a cross placed in the button by clicking on it, a 
hairline appears on whichever rulers are shown on screen. This is useful 
for accurate positioning of text, objects and pictures on the page. 

Horizontal auto scrolling 

If enabled, causes the screen to scroll horizontally as the mouse is dragged 
to the left or right window edge. Note that this option does not cause 
horizontal scrolling if the mouse button is not pressed. 

Disabling this option means that scrolling horizontally may only be carried 
out using the scroll bars across the base of the window. 

Dialogs 

III lllllHilllllllllllllHillllHillllllHilllllHillllHillllllHillllllHilHilll D i a 1 0 ue 0 t i ons llll!!!!!!!!lHil!!!!!ll!!!lll!!!!!!!Hil!!HiHi!!!!!!l!ll!!!Hil!Hi!!!!!!!!! 

Dialogues -------------------, 
~ Display keyboard shortcuts by underline 
[J~ialogue activation also registered as single click 

Buttons -------------------, 

~Right nouse button reverses 
OK <-> Apply I Cancel <-> Revert (Shift always does) 

.Q.K ~ancel 

r' 

r 
r 
I 

I 

I 

I 

I 

I 
Display keyboard shortcuts by underline I 
This controls whether the Papyrus keyboard shortcuts for buttons are 
shown on the screen. If enabled these are shown as underlined, like the k 
in keyboard, indicating that this option may be toggled on and off by 1 
pressing Al t and k just as if you had clicked on the check box. 

If this option is disabled th~n the keyboard shortcuts are not shown by the l. . 
underline although they will still work. 

You may want to disable this option if new users find this confusing, or for 
a slightly faster display of dialogs. L ,. 
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Activation registeredi as OJ single cHick 
With this option selected you can click on buttons and text fields (with the 
left mouse button) without selecting the dialog window first. This will 
automatically select the dialog that you have clicked on as the front dialog. 

If this option is disabled then clicking on a button or text field will just 
select the dialog window and you will need to select the button or text 
field again. This is the traditional way that GEM dialogs and windows 
work. 

This option is particularly useful if you have the Function Keys window 
displayed as you can click straight on the buttons with the mouse. 

These four options determine which buttons appear in most of the 
Papyrus dialogs. The two 4 button combinations let you choose whether 
OK or Apply is the default when you press the Return key. 

The 2-button versions have the advantage of using slightly less screen 
space in some cases (for example in the Line Styles dialog), thus letting you 
see a little more of your document. However, it isn't obvious how to use 
the 'missing' commands so we only recommend that you use this once 
you are familiar with Papyrus. 

To select OK when there is no OK button, hold down Shift on the 
keyboard and press the Ap ply button and vice versa. If there is no 
Cancel button then Shift-Click on Revert and vice versa. 

This option lets you use the right mouse button to reverse the operation of 
OK and Apply, Cancel and Revert. Thus with this selected, clicking on 
OK with the right mouse button will Apply the changes. This would 
typically be used when using one of the two button alternatives. 
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Import/Export 

line ends after spates 
~ ReMove leading spates 

ASCII Export -----------------, 
@ CR/Lf (fttari, DDS) O.l,J (Unix) 0 CR (!1at) 
[] Line ends only after Qaragraphs 

[] Ireat RTf/ASCII forMat the saMe as PAP dotuMents 
[] !!.se GEM tlipboard 

.ilK .c.antel 

This dialog determines the options set when Save as .. or Export ... are 
used to save a file in non-Papyrus format and also to import a non
Papyrus file. 

As these relate mainly to the ASCII format, it may be useful to describe this 
in non-technical language. ASCII stands for American Standard Code for 
Information Interchange. Each of the main alpha numeric and punctuation 
characters is given a standard code number between 32 and 127 which is 
recognised by virtually all computers and printers. Codes below 32 are for 
non-printable characters, such as Esc. 

Codes of 128 and above contain a variety of characters which can be used 
in a Papyrus document. They are more easily accessed from the Font 
Layout option. Unfortunately different computers (and even different 
programs on the same machine) display different characters for different 
values above 128. Thus if you want to read a document properly on 
another system you should avoid using these characters, as they may not 
be accepted by other software. 

Under TOS 2.05, 3.05 and above you can type ASCII codes directly into 
your documents. For example, in text mode, hold down the Al t key and 
type 97 on the numeric keyboard. Release the Al t key and the letter a will 
be printed, because 97 is the ASCII code for a. Of course, it is much easier 
to type a from the keyboard. 
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ASCII files are by convention given the extension .ASC. As Papyrus detects 
file extensions, . PAP must not be used for non-Papyrus files, as they are 
automatically saved as Papyrus files and other applications won't be able 
to read them. 

Files saved in ASCII are stripped of all software-specific format and style. 
As a result, ASCII documents can usually be loaded into any word 
processors, document processors, desktop publishers and other software 
which can enter text; naturally you will lose any styling or font 
information. 

Since diskettes formatted on Atari computers can normally be read by 
MSDOS, ASCII files can also usually be loaded into other makes of 
computer; this applies to modern Macintoshes and Amigas as well as PCs. 

However, there are some problems and the options in this dialog 
overcome the major ones. Different systems use different characters to 
indicate the end of a line. Some ASCII files have a line end only at the end 
of each paragraph, in the same way that you only press Ret urn in 
Papyrus at the end of each paragraph. Other ASCII files have an end of 
line at the end of each line; this is often the form used by simple text 
editors. 

ASCBB imp@rt 

It is advisable to enable both the two options under this heading. 

Many programs that export ASCII as separate lines rather than paragraphs 
output a space character at the end of lines which are not the end of 
paragraphs. Using this option will cause Papyrus to reconstruct such 
paragraphs automatically. 

Some programs can only export ASCII by printing to disk, i.e. storing the 
ASCII characters that would be sent to the printer in a disk file. Often this 
will mean that the left hand margin will be sent as spaces. Using this 
option will save you deleting these manually. 

It will also remove the spaces at the beginning of lines caused by 
paragraph indents and tabs which may be better achieved by using 
Papyrus' paragraph tags. 
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ASCII Export 

There are three options to include carriage return (CR) and linefeed (LF) 
codes automatically which are understood by various operating systems. 
Keep the CR / LF button selected if you are exporting to another program 
on the Atari or to the Pc. Use the LF button if you are moving the file to 
Unix or the Amiga and use the CR button if you are taking the file to the 
Macintosh. 

If you are exporting the text to a DTP package or a word processor, you 
will almost certainly want to enable this option as this will mean that each 
paragraph will remain a paragraph and won't need extra ends of lines 
laboriously removing. Enabling this option removes soft (automatic) 
carriage returns from the end of each line, thus making each paragraph 
one long line. If a hard carriage return is detected, which is what happens 
when Retu rn or Enter is pressed, it is retained in the ASCII document. 

If you are exporting to a simple text editor, or communications package 
you need to disable this - otherwise each paragraph will be treated as a 
single line. If you do set Line ends only after paragraphs, at best the 
editor may split the paragraphs where you don't want; at worst the editor 
may crash because it has been given a 400 character line. 

Treat RTf/ASCII format. the 
same as PAP documents 
Normally when you load an RTF or ASCII file Papyrus converts it to a 
Papyrus document; that way you can use all the Papyrus facilities in your 

r 
r 
r 

imported document. When you save the file out it will be saved as a I 
Papyrus document with a . PAP extension. I 

If you enable this option then Papyrus won't convert the document from 
ASCII or RTF; that way you can move the file you have edited back to the ( 
program or system that you imported it from. Note however that Papyrus 
cannot save tables and images in RTF files and that ASCII files will not 
containing any formatting information (bold, underline etc.) whatsoever. ( , 

l 
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Use GEM clipboard 
When using the GEM clipboard, Papyrus will save the text you cut or copy 
to your hard disk in both RTF and ASCII formats. The cut/copied text will 
be saved to a folder called CLIPBRD on drive C. The GEM clipboard is 
useful when transferring text between different applications that support 
the GEM clipboard; it is not necessary for using the clipboard within 
Papyrus. See the Edit menu section for a detailed discussion of the GEM 
clipboard. 

Spellchecker Options 

The Spellchecker Options dialog is used for controlling the IntelliView 
Correction system and managing dictionaries as well as the main Spellcheck 
dialog. This can be accessed via the Options button in that dialog as well 
as from the Options menu. 

~ .!!er!'lanent checking 
@ ShON .!Ill suspicious Nords o Check only neNly gntered Nords 
~ The ri ght !'louse key se I ec ts 
o Acoustic signal HeN dictionary" , 

Spell checker Dialogue -------, :=====i!0:§pe~n= .. =, ==l 
~ Continue alNalis Close 
~ AINays ~i!'lilarity search 
~ Display dictionary nUl'llters Save 

Spellchecker -------,r=~===~1 
o Check CAPITALIZED !!lords Ignore area 
o Check Nords Nith digits 0 ~s=~ .!lon't ignore 

OK .!:ancel 

IntelliView Correction 
Many people are too lazy to run the Spellchecker before they print their 
documents; others prefer to spot typing mistakes as they enter their text. 
IntelliView Correction is for these people; it shows on screen words that 
aren't in the current dictionaries by drawing a zig-zag line underneath 
them like this: 

and optionally makes a sound too. 
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Permanent cheddlflg 

Selecting this check box enables IntelliView Correction and the sub-items 
in the dialog box. 

When this is selected all words, anywhere in the document are checked; 
this can slow down screen display a little. Alternatively, choosing Check 
only newly entered words will only check words as you type them. 

The lRig/ht M@!!.8se key seUeds 

With this option selected double-clicking with the right mouse button on a 
misspelt word will display the main Spellchecker dialog, so that you can 
look for an alternative, or add it to a dictionary. 

Enabling the Acoustic Signal option will cause Papyrus to make a 
sound when you enter a mistyped word. For people without speakers, the 
menu bar will flash too. 

Di ti c onanes -
1: PAPYRUS. DIA 0 

I 

CO 
I HeN dictionary ••• I 
I Open ••• I 
I Close I 
I Save I 

r 
r 
r 
r 

This part of the dialog is used for controlling which dictionaries are used 
by Papyrus, saving dictionaries and creating new dictionaries. f 
The scroll able list shows which directories are currently loaded. An 
asterisk (*) in front of a directory name shows that the dictionary has been I 
modified since it was last saved. Dictionaries with file extension .OIC are l 
compressed, whereas in .OIA entries the words are stored as ASCII .. OIA 
files are not pure ASCII however, they should be created as described 
below. [ 
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The numbers before the dictionary names are the numbers that are used in 
the suggestions part of the main Spellchecker dialog. You can remove these 
by de-selecting the Display dictionary numbers item. 

This button creates a new dictionary; first you are asked to enter the sort of 
dictionary that you wish to create: 

g Create uncoMpressed ASCII or 
V cOMpressed dictionary? 

ASCII i I COMpressed II Cancel 

If you select ASC I I then the words in the dictionary will not be 
compressed; this means that they can be searched faster than a 
Compressed dictionary but that the dictionary will take up more room in 
memory and disk. Compressed dictionaries are more appropriate where 
there are many entries, such as entire languages, where the uncompressed 
dictionary would use a great deal of memory. 

After choosing the type of dictionary you are creating, you will be 
presented with the file selector to enter the name of your new dictionary; 
you should use an extension of . D I A for ASCII dictionaries and . D I C for 
compressed ones. 

If you want to add words to your dictionary immediately, open a file 
containing the words, select Spellchecker from the Text menu and 
select the Add All button; this will add all the words that are not in an 
existing loaded dictionary. Note that you may want to add the plural 
versions of nouns and the different conjugations of verbs. For example, if 
you were adding download, you might want to add downloads and 
downloaded as well. A dictionary can start with no words in it at all, you 
can then add them manually as you find them with the spellchecker. 

One approach to using multiple dictionaries is just to use one dictionary of 
your own and put all the words that you use, that aren't in the main 
dictionary in that. 
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Another approach is to use different dictionaries for different categories of 
writing, For example, if you sometimes write about horses, you might 
want to include morgan in your HORSE dictionary; if you were then 
writing about the profits of your business and mistyped margin as 
morgan, Papyrus could spot the error (as long as you didn't have the 
HORSE dictionary loaded). If you just put everything in one dictionary, 
Papyrus would let this one through. So we recommend that you use 
separate dictionaries. 

One thing not to do, is to add items to the main UK.DIC file; if we then 
upgrade the dictionary, you'll have the choice of using the new dictionary 
and losing all the words you have entered, or using the old dictionary and 
not being able to use the new improved dictionary at all. 

Open 

This button is used to open an existing Papyrus dictionary, so that its 
words will be searched when using the spellchecker. 

Close 

This will remove the currently selected dictionary, (ENGLISH.DIC in the 
example above) from memory; it will no longer be searched by the 
spellchecker. To select another directory just click on its name in the list. 

If you have made changes to the dictionary then you will be asked 
whether you wish to save the changes you have made. 

The Save button will save the currently selected dictionary to disk. You 
don't have to save directories in this way, as Papyrus will prompt you 
whether you wish to save them when you quit; but of course, this won't 
help if you have just spellchecked your novel and there's a power cut. 

Spellcheclketr Dialog 
This part of the spellchecker options lets you configure the main 
Spellchecker dialog to work the way you like. 

Continue aHways 

When Continue always is selected, the spellchecker will look for 
another misspelling as soon as you click on Add, Replace or Ignore. 
Most people find this the most natural way to use the spellchecker. 

Page 212 Papyrus Gold The Menus 

r 

I 

I 

I 

I 

I 

l 

l. 



1 

If this option is not selected then you will need to explicitly press the 
Continue button after each Add, Replace or Ignore. 

A.lways similarity search 

This item controls how the Similarity Search button in the main 
Spellchecker dialog starts after a new word is found. If this is selected, each 
time the Spellchecker dialog appears, whether as a result of clicking on a 
word with the right mouse button or via the Spell checker command, 
Similari ty Search will be selected. This is generally the best setting for 
faster machines like the Falcon. 

If you are running on a slower machine you may want to disable this so 
that you'll obtain a faster response; you can always then switch to the 
Similari ty Search if you can't see what is wrong. 

Display dktucmatry lJ1J«Bmibers 

This option controls whether a number is shown before dictionary names 
and words in the Suggestions dialog box. When Display dictionary 
numbers is enabled, you can see which dictionary the suggestions come 
from and this may help in choosing the correct word. L: indicates that a 
word is one of the local exceptions (created via the Ignore button of the 
Spellchecker dialog). 

If you find the numbers distracting then disable this option. 

Spelkhedcer 
Spellchecker -------,r=::;::::::::====::::::;-i 
o Check CAPITALIZED ~ords Ignore area 
o Check Nords Ni th dig! ts 0 ss=P .!!on I t ignore 

Check CAP8fAUSlED words 

With Check CAPITALISED words selected, Papyrus will see whether 
words that are made up entirely of capital letters are in one of the 
currently loaded dictionaries. Using this has the following advantages: 

G 

As such words tend to be names, they won't be in the dictionary 
and using this option will save time. 

It is an easy way to ignore old fashioned computer listings. 
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On the other hand: 

o Misspellings of company initials and programming keywords are 
some of the worst mistakes that you can make in a document, so 
you want them checked! But the lower case equivalents of such 
words often do not make sense, so you don't want them in the 
dictionary anyway. 

Check words with digits 

r 

If this option is disabled then words containing digits will be ignored by r 
the spellchecker; often these will only be present in words that won't need 
checking (e.g. the road name A6). However, if you have Check words W 
wi th digits selected, 5he will be spotted as a typo for the. « 

ss=fB 

This option is for users of the German dictionary; when enabled the B is 
treated as the ss that it sounds like. The German dictionary is available at 
extra charge, please contact HiSoft for details. 

UgU1@f!'e area 

This command causes the currently marked block to be ignored by I 
subsequent spellchecker commands. It can be used to avoid checking 
sections written in foreign languages, program listings etc. Multiple blocks 
may be marked separately and this command used repeatedly. 

The Don't ignore command, causes the marked block to be included in 
further spellchecks. It thus un-does any previous Ignore area 
commands that were using within the marked block. 
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Miscellaneous Options 

ReflloIJe Unused Pictures -----------, 
o Au!ofllatically 0 ~on't refllOIJe @ frofllpt 

o .8utosaIJe eIJery lsi 1 f.l i !lutes 
SJ f..jith prof.lpt'·' 

~ Create ~ackup-files (*.PBK,*.RBK, *.BAK) 
o ~aIJe settings before Quitting 
o SaIJe Hork gnIJironfllent Hith settings 
o Expert ~ode (suppresses sOflle alert boxes) 
~ Mse OHn desktop 

~ancel 

This option lets you configure what happens when you delete the only 
occurrence of a picture in a document If you set this to Automatically, 
then the picture will be deleted from the document Should you wish to 
place the same picture somewhere else you will need to re-insert with the 
Insert command from the File menu, 

Choosing Don l t Remove will cause the picture to stay in the Papyrus file; 
you can see the picture in the Picture Window and re-insert it using the 
Insert Block button, However, if you don't re-use the picture, it will 
still remain in your Papyrus file, thus using more disk space and taking a 
little longer each time you load and save your document 

Prompt will ask you whether you wish to delete the picture or not when 
you delete its only occurrence. Most people will find this the most useful 
setting. 

Autosewe 
If enabled, this option will automatically save the current document at the 
intervals entered in the box, provided there have been changes to the 
document since it was last saved. 
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We recommend that you use this option, so that if for some reason the 
computer crashes, for example if there is an interruption to the power 
supply, some of the work will be saved. It is recommended that work is 
saved under the current filename at frequent intervals in addition to 
autosave. If Wi t h prompt is enabled, a dialog gives the option to save 
now, save later, or not at all during the current session. If n eve r is 
selected, the autosave option is effectively disabled for the rest of the 
session and will only become active on re-loading Papyrus. 

Create Backup Files 

If the option to Create Backup files is enabled, whenever the file is 
saved under its current name the previous version is given a new 
extension and retained. Papyrus (. PAP) files are saved with the extension 
.PBK, RTF files with the extension .RBK and ASCII files with the extension 
.BAK. 

Save settings before quitting 

If enabled, changes to all settings are saved when you exit Papyrus via the 
Qui t command; so the next time you load Papyrus the setting will be the 
same as when you last used it. 

If disabled, the settings that were explicitly saved with the Save Options 
command are used the next time that you load Papyrus. 

Many people find that it is easiest to enable this option, as you don't have 
to remember to save the settings yourself. If you set some options that you 
don't normally use, you can then disable this option explicitly so that the 
next time you load Papyrus it doesn't start up with these strange options. 

Save Work Environment with settings 
When enabled, the options file will remember which files and dialogs you 

r 

r 

I 

I 

Whalve open. It allsodrepmembers tlhe f~ol sitionds ad~dlsizes o.fllybour windowsd· I 
1en you re- oa apyrus t 1e I es an Ia ogs WI e re-opene l 

allowing you to continue from the precise point that you left off. If this 
option is disabled then Papyrus will display its open document file [ 
selector when it is loaded. 

This option is almost always used in conjunction with the S a v e 
settings before qui tting option; otherwise the environment that 1 
was opened when last saved the options with the Save Options 
command is used. 

L 
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Expert M.ode 

When expert mode is enabled, some alert boxes will be suppressed. These 
are those for copying and deleting master pages, adding all unknown 
words to the dictionary and using the current wrap around and size 
settings for newly inserted pictures. Use this setting if you find these alerts 
annoying but don't blame us if you add misspelt words to your dictionary 
by mistake. 

Use own Desktop 

This option controls whether Papyrus uses its own Desktop (containing 
the Shredder). This lets you delete pieces of text without using the Cut 
and Delete commands from the Edit menu. 

In a multi-tasking environment you may find it preferable to leave the 
desktop alone, so that you have access to the 'real' desktop at any time; to 
do this, de-select the Use own Desktop item. You will then need to use 
the menu commands (or their keyboard shortcuts) to delete text. 

Memory 

The memory dialog is very important to Papyrus, the values entered into 
this dialog determine how much memory Papyrus uses. 

The Me11lls 

papyrus currently occupies", 
Free for docuMents", "'" '" 
Free systeM MeMory", '" "'" 
papyrus' Speedo cache"" "" 

1003 kB 
158 kB 
118 kB ..."..... __ .,.--, 

62:1. fu 11 I.s.ave cache I 

MaxiMUM for papyrus""""""", ~kB 
(Papyrus Hill never occupy More tha~ 
MiniMUM left for the OS""""", I"iIJI kB 
(The aMount that is left for the Sy~ 
Printer bitMap buffer"""""", 116 IkB 
(MiniMuM 16 kB) 
papyrus' Speedo character cache", 116 1 kB 
(MiniMuM 4 kB) 

iUse neH settingS~ Cancel 
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This dialog will also tell you other useful information including the 
memory available for documents, Papyrus' current memory usage, system 
memory available and how much of Papyrus' own Speedo cache is used. If 
this figure isn't nearing 100% in general use, then you can decrease the 
size the cache using the bottom editable item. 

Papyrus'Speedo cache 
When SpeedoGOOS scales font characters it stores them in an area of 
memory called the font cache; then if it needs to draw the same character 
again in the same font, style and size, it does not need to re-calculate the 
pixels it needs, it can use them straight from the font cache. Thus with a 
larger font cache, documents with many fonts will be displayed on the 
screen more quickly. There will still be a slight pause when a particular 
font is first displayed as Papyrus will need to scale it the first time. 

The Save cache item will store the current contents of the font cache and 
this will be re-Ioaded when you reload Papyrus; thus avoiding that delay 
when first displaying a font. The cache is stored in the file PAPCACHE. 

Maximum for papyrus 

This entry tells Papyrus how much memory it is allowed to use. If you set 
this too high and are running a multi-tasking environment such as 
MultiTOS, you won't be able to load other programs. Alternatively if you 
set this entry too low, then you may run out of memory when editing 
large documents or using the spellchecker. 

The minimum amount of memory you should give Papyrus on a 2 
Megabyte machine is 1500Kb if you want to use all the features -
spellchecker etc. This still gives room for the Papyrus' printer buffer and 
Speedo cache. 

Minimum for the OS 
This setting tells Papyrus how much of the remaining memory Papyrus 
should give back to the system, again this is very important when running 
under a MultiTOS style environment. This amount of memory will always 
be left to the operating system regardless of the setting of Maximum for 
papyrus. 
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PJrinter buffer 

Papyrus users the printer buffer for both preparing the image that it will 
send to the printer and for storing the characters that it will send to the 
printer when printing in background mode. 

You may see an alert when printing saying that the buffer is too small; this 
is the place to increase it. 

Increasing the size of this buffer will speed up printing in the background. 
It can also have a dramatic affect on the speed of printing large GEM 
metafiles (.GEM pictures) as Papyrus can play the metafile once rather 
than the many times required if the buffer is small. 

This entry sets the size of the buffer that Papyrus uses for scaling Speedo 
characters; if you aren't using any Speedo fonts you can set this to the 
minimum (4Kb). 

Plrintetr 

Most people will not need to use this dialog, just use the Print e rand 
Res 0 1 uti 0 n items from the main P r i n t dialog. If your printer isn't 
mentioned, use one that it emulates (see your printer's manual for details). 
Alternatively, if there is no Papyrus printer driver for your printer, but 
there is a SpeedoGOOS driver then you should select the driver with the 
SpeedoGOOS Printer Drivers accessory and choose GOOS Printer 21 
from the Printer pop-up in the Print menu. 

However, if you decide that you need more control over the printing 
process or if you own an obscure printer then Papyrus can help through 
the use of this dialog. 

The actual printer setup dialog is quite complex and for many users, the 
most you may ever want to do is simply add or remove a printer driver, or 
alter a driver to correct a minor positioning problem. For the more expert 
users however, we would suggest that you tread carefully, since a wrong 
entry can lead to at best printing problems, at worst no printing at all. If 
you do want to attempt to build a new driver, we would suggest that you 
try and use one of the supplied drivers as a starting point, as this will give 
you a much better chance of succeeding. 
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The Printer Configuration box is meant for experts only and you can 
change a printer configuration or set a completely new one if it doesn't 
work the way you want it to. Sometimes it is necessary to set the paper 
feed to a specific slot or to set printer specific margins . 

t!41;:,:··;;:' :)::H:":H:: •.•.••.•..• Printer Setup .,g;.".g ••.• ;;:; •••• ".;[~; •• ,;.; .••.•. ·u.· ...•••.•. ·.;·. 
Printer: [ HP Deskjet 500 Color I 
Duality: [ 300 DPI I Dialogue: [ 6eneral I 

NaMe [HP Deskjet 500 Color [ 

Duality Specification [300 DPI I 
Rel'larks I~i th cOl'lpressionl I 

Resolution: ~ DPI *~ DPI 
Font type: [ Laser Printer (300 DPIl .. 1 

Output port: [ Parallel It 
Colour: [ Black & Whi te I 

Fanfold Margins: Left I[:=:JI'IM Right IC]I'IM 
(Rei.:., Ive to the 

I[:=:JI'II'I Bottol'l I[:=:J MI'I top left .;:orner) Top 

C]LJ I !;ancel I I Delete I I Load •.• I I Save ... I 
I fipp ly I I Revert I 

Note that you can also reach this dialog via the Setup ... button in the 
Print dialog. 

The pop-ups Printer and Quality show the values for the current 
printer driver. A printer driver is determined by its Name and its Quality. 
Drivers with the same name and different quality status are summarised 
so you can choose between the qualities when you call up a printer in 
Print Document. For some drivers, the resolution also lets you choose 
between paper sources. 

The pop up Printer always contains the entry New printer driver. 
This creates a copy of the current driver which can be changed from there. 
After you changed the settings (at least name or quality) you can create the 
new driver with Apply. 

The three buttons in the bottom right control individual drivers: 

Delete removes the current printer driver; thus freeing the small amount 
of memory used by it. 

Load ... loads an individual driver, these have extension .DRI. 

Save ... saves the current driver in a file; using the. DRI extension. 

All printer drivers in the pop up are saved in the standard PAPYRUS.INF 
file that is saved via the Save settings item on the Option menu, or 
automatically if you have Save settings before quitting selected. 
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1 The Dialog pop-up chooses which part of the driver is to be edited. 

1 General sub-dialog 

] 

J 

J 

This sub-dialog is shown in the previous picture. 

Name 

This is the name that Papyrus will show in the Printer popup; you can 
edit this if you wish, it must not be completely empty. 

This is the string that Papyrus will specify in the Quality pop-up. This 
can be changed to any text string but must not be empty. 

If you are using a high quality printer (like the 600 dpi Laser Jet 4 and 
compatibles), use Speedo fonts as these are scalable to any resolution. If 
you use a 300 dpi font at 600 dpi you'll just get four 600 dpi dots instead of 
one 300 dpi dot giving no difference from printing at 300 dpi apart from 
the extra time to print. 

Remarks 

The Remarks field is for comments; it is generally used for indicating the 
capabilities of the driver such as whether it supports compression. 

Specifies the printer resolution; horizontal first (in dots per inch) and 
vertical (also in dots per inch). These are the values that will be given to 
SpeedoGOOS for scaling characters and graphics. 

!Font type 

The Mellus 

Screen MediuM Resolution (90*45 DPIl 
Screen high Resolution ('0 DPIl 
SignuMZ-Screen forMat ('0*108 DPIl 
'-Pin Printer (1Z0*144 DPIl 
Laser Printer (150 DPIl 

.; Z4-Pin Printer (180 DPIl 
fax (ZOO DPI) 
SignuMZ P' forMat (Z40*Z16) 
Laser Printer (300 DPIl 
SlgnUMZ PZ4 fOrMat (360 DPIl 
Laser Printer (400 DPIl 
Laser Pr inter (600 DPIl 
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This pop-up lets you choose the favourite font type of the printer. This 
only affects GDOS 1.1 and Signum fonts; Speedo fonts are always scaled to 
the appropriate resolution. 

This helps Papyrus choose the best alternative if a font is available in 
different resolutions; using a screen font on a laser printer would give very 
poor quality output. Conversely if outputting to an . IMG file for use on the 
screen, Papyrus would have to scale down a laser printer font, giving a 
worse result than the hand tailored screen font. 

Output pOtrl 

--- Externa I Dr I ver ---) 
Parallel 
Serial 
AlARI Laser 
AlARI Laser 688x388 DPI 

v'Disk fi Ie 
IM6 Picture 
ISS Picture 

This specifies where the printer is attached. The parallel port is the usual 
printer port, but some printers are attached via the serial port. Atari Laser 
printers are connected to the DMA port and so have their own special 
item. 

Selecting Disk File will prompt you for the output file name (with 
extension .PRN) and produce a file containing precisely the same 
characters that would be sent to the printer. Thus you can use the Desktop 
to print such files by just double-clicking on the file (assuming you haven't 
installed an application to use .PRN files). This can be useful if you have 
leaflets that often need to be printed but that are complex and so take 
Papyrus a while to print. 

Perhaps more importantly this lets you take the disk file to another 
machine without Papyrus (and perhaps not even an Atari) and print it 
there. For example, if you know someone with an HP LaserJet 4 you can 
change the output port to Disk File. 

Especially at high resolutions (like 600 dpi) the files produced can be very 
large, so you may need to print only a page at a time, so that they will fit 
on a floppy disk! This output is ideal for making masters for photocopying 
or even offset litho printing if the highest quality isn't required. 

IMG picture is used to output to a standard GEM image file that can 
then be read by most Atari graphics packages. 
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ISS pic t u r e can be used for output to specialised high quality 
phototypesetters all the way up to 2400 dpi, at the expense of enormous 
files. 

CoDO!I.D1f 

If the printer driver contains colour control characters you can set it to 
colour print here. Usually the drivers are set to Black and white initially. 
In this case all colours except white are printed black. 

For printers with a restricted printing area you can set the maximum area 
to be printed on for continuous paper. These margins are given relative to 
the top left of the page in the current units. When you choose the driver 
these edges appear on the screen in thin dotted lines. 

III liii!I!:I!i!!:iii!iiii:i:!!!I!liiiiiiiiiiiii !!iii:iiiiii!::iiiii!i!iiiiii!iiii!i:! W!lii!iiiiillr"'p'r'1"ii't"e"r ,. 'Se"itiii :!!ii!il!ililii!!iiiiiiii:!!!ii!i!!!ii:ii!I!llii!lii!!::!iiiiiii:ii!liii!iJli!!llli!il!lill!iillilliii 

Printer: I HP Deskjet 500 Color 
Duality: I 300 DPI Dialogue: I Cut Sheet 

Pr inter paper: 0 F anfo I d 
!ZI Single-sheet auto fed 
!ZI Single-sheet Manually fed 
The select .. d ~~~el' ':::I.,C=-S e.,n ce chosen fl'o", 1n 
the crlnt c::.noe.l If ... Ore th.:.n one IS selec:ted 

Specially for Single Sheet ------------, 
Margins: Left ~MM Right ~MM 

:~~'~;:~·<~~o;~; Top ~ 1'11'1 BottOM ~ 1'11'1 

BottoI'! Margin: ® Calculate frOM top 0 Calculate frOM bOttOM 
Start of page IESC E ESC "'IOoOIOE" ESC "*rbC" ESC "*r-3U" ESC I 

End of page IESC "*rbC" FF ESC E I 

L:]C] l.caml I 
[]!iliJ I Revert I 

Delete Load" • I I Save" • 

Here you can set the kinds of paper that the printer supports. If more than 
one a pop-up with the possible kinds of paper appears in the dialog Print 
Document. You can also set the print margins for single sheets (which are 
often different from continuous fanfold paper) and the control characters 
for page beginning and page end. The control characters set here are only 
used for single sheet printing and override those set in the Escape Codes 
dialog. The format of escape codes is shown at the end of this section. 
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The rest of the control characters are set in the following dialog. 

Escape Codes sub-dialog 

[][J I Cancel I 
I Apply I I Reyert I 

Line transmission 

Delete Load... I I s.ave ... 

" Lines 
Li nes Packb i ts-COApressed 
Lines CHY 
Lines CHY & Packbits 
Lines CHYB 
Lines CHYB & Packbits 
8 Pins 

16 Pins 
24 Pins 

The graphics data that Papyrus sends to the printer can be transferred by 
line or as vertical bitcolumns of 8, 16 or 24 bits, according to the number of 
pins on the printer head. 

You can also use Packbits compressed lines as supported by HP compatible 
printers. Using compressed data can dramatically reduce the time needed 
to send the page to the printer. 

The CMY option is for colour printers with 3 colour inks (Cyan,Magenta 
and Yellow). The HP Deskjet 500 is an example of such a printer. 

The CMYB option (also known in the printing industry as CMYK) is for 
printers with 4 colour inks (Cyan, Magenta, Yellow and Black) as used by 
the DeskJet 550, for example. 
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Passes per line 

Most dot matrix printers run over a line several times to achieve the best 
quality. Every line is shifted by a micro step; e.g. 24 pin printers normally 
in 180 dpi, but shifted two times by 1/360 inch. In this case you would have 
to set this option to 2. 

Start of page 

This is the sequence sent at the start of each page for initialising the printer 
and is only used when Fanfold Paper is chosen. The format of escape 
codes is shown at the end of this section. 

This sequence is sent at the end of each page when using continuous 
paper. 

This is used at the beginning of each graphics 'line' just before the data. 
Papyrus supplies the number of columns to be printed as #n or (n 1), (n2). 
See the section below for details of how these numbers are sent. 

The relative horizontal position of the printer head. Papyrus uses this to 
skip over large white areas efficiently. The amount to skip horizontally can 
be inserted using the #n or (n 1) and (n2) codes. 

If the sequence contains a constant character (space makes sense) it is 
repeated as often as necessary to cover the gap. If the sequence is empty 
the print isn't optimised here: gaps are transferred as graphics data as a 
row of zeros (not very efficient, but it works on all printers). 

The resolution of the number to be inserted by Papyrus in dpi is specified 
here, because it can be different from the graphics resolution; the given 
value is recalculated accordingly. 

Control sequence for vertical paper feed, this is the vertical equivalent of 
Posi tioning; again this has its own resolution setting for maximum 
flexibility. 
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Colour sub-dialog 

The codes in this sub-dialog are only used when printing in colour (not 
black and white) mode. However the Brightening field for Black is 
used in all modes. 

Printer: ~~§!~,;;:;,;,,,;;;,;;,;;,,,~ 
Quality: Dialogue: 

Carriage Return 1,,:-1 -:::---:-r============r 
Brightening ~ 1. Blatk I 
Brightening ~ 1. Magenta EIES=C=:'II=lIb'7.II=(=II):=::=U =======1 
Brightening ~ 1. Cyan IESC Il1b21'1" (II) U 

Uiolet'l 
YelloH EIES=C=:'II=lIb'7.II=(=II):==:':'W =======1 Brightening ~ 1. 

Orange I 
~=========~ 

Green I 
BrOHn ~I ===========i 

C][:] I Cancel I Delete Load... I I Save ... 

I Revert I 

Cartriage Return 

This is the code to reset the printer head of colour pin printers to the 
beginning of the line, without advancing a line (normally CR), so the 
colours can be put' on top of each other'. 

IBladk, Magenta Cyan, VooKet, YeUDow, Otrange, Green, 
fBJl'@wn 

These switch the printer to use the appropriate ribbon or ink. 

This figure lets you allow for the fact that most printer dots are oversize; as 
a result images appear darker than they should. 

0% means that Papyrus will assume the dots at the standard size. 10% 
gives a small amount of brightening and larger values more brightening. 
See the supplied drivers for recommended initial values. 

To calibrate it correctly, print out the file GREYTEST.PAP and adjust the 
figure for your combination of printer, paper and ink (in this context, 
printer toner is ink). 
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Note that the brightening can be set independently for Cyan, Magenta 
and Yellow for colour printers. 

After the adjustment remember to save the figures with the S a v e 
options entry of the Options menu. 

Syntax of printer contr@1 sequen«:es 
We have tried to make the control characters similar or the same as in 
printer manuals. You will probably understand them best if you look at a 
few printer drivers. Now the syntax: 

o 

o 

o 

o 

c 

o 

Spaces are only separation characters; they are not sent to the 
printer. 

Every single character between separation characters is sent in 
ASCII code to the printer. 

Character strings in quotation marks (" or ') are sent to the 
printer without change. 

& precedes a decimal number; & 12 sends the ASCII character 12 to 
the printer. 

$ precedes a hexadecimal number; $C also sends the ASCII 
character 12 to the printer. 

The following control characters are predefined (the ASCII code is 
in brackets): NUL (0), BEL (7), BS (8), LF (10), FF (12), CR (13), 
SO (14), SI (15), DC1 (17), DC2 (18), DC3 (19), DC4 (20), CAN (24), 
EM (25), ESC (27), FS (28), SP (32), DEL (127). 

(n) or (n 1) gives the position of the low byte of a value Papyrus 
provides, so it is value MOD 256. 

(n2) gives the position of the high byte of a value Papyrus 
provides for, so it is value DIV 256. 

(#) tells Papyrus to put in the value as a decimal number in ASCII 
numbers, as e.g. HP compatible printers expect. 

Everything between curly brackets, { and }, is a comment and 
therefore ignored. 
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font Paths ... 

List of font Paths ---------------------, 
0:\ 
C:\liEI1SVS\ 
.\ . \ 
.\ 
.\ 

.!!.K ~ancel 

This dialog is used to set the paths for bitmap fonts. If you have GOOS 1.1 
and Signum!2 bitmap fonts in different folders, you must add the paths so 
that Papyrus will find the fonts when it runs. 

To add a new path click on one of the unused paths; this will display the 
File Selector so that you can enter the path. Similarly, to change an existing 
path double-click on the existing entry and enter it there. 

The paths for SpeedoGOOS are set within the SpeedoGOOS Outline 
program and do not require adding to the list of font paths. 

Compatibility 

Only change these settings if the print function doesn't Hork properly. 
Ensure that you understand the i~plications of changing any setting. 

Printer liraphic Output ------, 
~ Use ~creen drivers 
() Use yDOS driver MEI10RY.SYS 

(Necess.:Ir'!:;I fol" SpeedoCiOOS up to 4.11) 

L-____________________ ~ ()Off 

Parallel Port Output ----...., @ On 
[

Error Handling 

@ Directly (in !l.ackground) '---------------' 
() Via IDS 

!!.K ~an(el 
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As indicated at the top of this dialog, these settings should not be changed 
unless printer problems are experienced. 

!Printer Graphic Output 
The Use screen drivers option gives better output than the alternative 
Use GDOS driver MEMORY.SYS. However SpeedoGOOS 4.2 is required to 
use the screen drivers for graphic output. If you have an earlier version 
you will need to select Use GDOS driver MEMORY.SYS or purchase an 
upgrade to SpeedoGOOS from your SpeedoGOOS supplier. 

Parallel Port Output 

The Directly (in background) option enables Papyrus' built-in 
printer spooling. This means that printing can continue whilst you are 
editing your document. To do this, Papyrus accesses the printer port 
hardware directly. If you are using a multi-taking system you will need to 
disable this and use the Via TOS option. 

You will also need to use the Via TOS option if you are using a separate 
software printer buffer, or a printer that uses a special driver program that 
patches the operating system to fool it into thinking that a non-standard 
printer is connected to the parallel port. 

Error handling 

This controls whether SpeedoGOOS errors are reported to the user. By 
default this is on, so that you can see any messages that are reported. 
Under some circumstances, Speedo drivers may give spurious errors and 
switching error reporting Off will ignore these; of course, it will also 
ignore 'real' errors as well. 

Save Options 

Save Options saves the current settings in the file PAPYRUS.INF. This 
will be re-loaded when you next run Papyrus. If you find that you often 
forget to use this command, then check the Save Settings before 
Qui tting option of the Miscellaneous item of the Options menu. 
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Append;xA 
Keyboard Shortcuts 

Menu Keyboard Shortcuts 

These are the keyboard alternatives to the various commands available 
directly from the various menus. Not all entries have shortcuts. 

file 

New Document 
Open ... 
Close 
Save 
Save as ... 
Revert to saved 
Insert ... 
Export ... 
Delete ... 
Page Layout ... 
Paper Format ... 
Print ... 
Quit 

Edit 

Undo 
Cut 
Copy 
Paste 

Keyboard Shortcuts Papyrus Gold 

Ctrl-N 
Ctrl-O 
Ctrl-U 
Ctrl-S 
Shift Ctrl-S 

Shift Ctrl-V 
Ctrl-E 

Ctrl-L 
Shift Ctrl-P 
Ctrl-P 
Ctrl-Q 

Undo 
Ctrl-X 
Ctrl-C 
Ctrl-V 
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Delete 
Copy style 
Paste style 
Copy ruler 
Paste ruler 
Select all 
Why the beep 

Text 

Font Panel ... 
Font Layout ... 
Search & Replace_ 
Find next 
Spellchecker ... 
Spellcheck next 
Page break 
Column break 
Group lines 
Ungroup lines 

Style 

Normal 
Bold 
Underline 
Italic 
Outline 
Light 
Superscript 
Subscript 
Function keys ... 
Colour ... 
Get style 
Always get style 

Page 232 Papyrus Gold 

Backspace 
Ctrl-1 
Ctrl-2 
Ctrl-3 
Ctrl-4 
Ctrl-A 
Ctrl-? 

Ctrl-Z 
Shift Ctrl-Z 
Ctrl-F 
Ctrl-G 
Shift Ctrl-; 
Ctrl-; 
Ctrl-Return 
Shift Ctrl-Return 
Ctrl- ( 
Ctrl- ) 

Ctrl-O 
Ctrl-B 
Ctrl-J 
Ctrl-I 

Ctrl-6 
Ctrl-7 

Shift Ctrl-G 

Keyboard Shortcuts 

r 
r 
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Special 

Page Offsets ... 
Master Offsets ... 
Paragraph Offsets_ 
Spacing ... 
Microspacing ... 
Hyphenation ... 
Soft hyphen 
Footnote 
Special chars ... 

] Document Type_ 
Data Field ... 

1.·.·.·.·. j 

] 

Index Entry ... 
Table ... 
Cell Type ... 
Calculation ... 

Object 

Tools 
Line style ... 
Fill pattern ... 
Colour ... 
Orientation ... 
Attributes ... 
Picture Size ... 
Picture Window ... 
Put to back 
Bring to front 

Keyboard Shortcuts Papyrus Gold 

Shift Ctrl-M 
Ctrl-H 

Shift Ctrl-F 
Ctrl-# 

Shift Ctrl-I 
Ctrl- T 
Shift Ctrl-T 
Ctrl- * 

Ctrl- , 
Ctrl- / 
Shift Ctrl-B 
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Zoom 
[ 

25% Ctrl-F1 r 
33% Ctrl-F2 r 50% Ctrl-F3 
67% Ctrl-F4 
86% Ctrl-F5 r 
100% Ctrl-F6 
117% Ctrl-F7 I 200% Ctrl-F8 
Full page Ctrl-< 
Normal Ctrl-Esc 
Print resolution Ctrl-> 
Setup ... 

Options 
I 

Ruler Ctrl-R 
Vertical ruler I 
Cycle window Ctrl-W 
Cycle dialogue Shift Ctrl-Y I Screen Display ... Shi ft Ctrl-D 
Mouse Actions ... 
Dialogues ... I 
Import/Export ... 
Spellchecker ... I 
Miscellaneous ... 
Memory ... 

I Printer ... 
Font Paths ... 
Compatibili ty ... L 
Save options Shift Ctrl-E 

t 
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Other Keyboard Shortcuts 

Delete line 
Delete paragraph 
Move to top of document 
Move to bottom of document 
Delete word to left 
Delete word to right 

Mark character forward 
Mark character backward 
Mark word forward 
Mark word backward 
Mark sentence forward 
Mark sentence backward 
Mark paragraph forward 
Mark paragraph backward 
Mark page forward 
Mark page backward 

Exchange characters around cursor 
Exchange characters left of cursor 
Mark block start 
Mark block start 
Goto block start mark 
Goto block end mark 
Lower-case first letter of word 
Upper-case first letter of word 

Keyboard Shortcuts Papyrus Gold 

Ctrl-Y 
Shift Ctrl-Y 
Home 
Ctrl-Home 
Ctrl-Backspace 
Ctrl-Delete 

Alt-C 
Shift -Alt-C 
Alt-W 
Shift-Alt-W 
Alt-S 
Shift-Alt-S 
Alt-A 
Shift -Alt-A 
Alt-Y 
Shift -Alt -Y 

Alt-T 
Alt-Z 
Alt-B 
Alt-K 
Shift-Alt-B 
Shift-Alt-K 
Alt-L 
Alt-G 

Page 235 



Keyboard shortcuts for text windows 
(a// modes) 

Scroll screen up Shift-", 
Scroll screen down Shift -0 
Scroll page up Ctrl-", 
Scroll page down Ctrl-0 
Delete selected object Ctrl-Delete 

Set text mark 1 ... 6 Shift-Alt-1 ... 6 
Goto text mark 1_6 Alt-1...6 
Select Frame Edit tool Alt - F1 
Select Text Mode tool Alt-F2 
Select Text Frame tool Alt-F3 
Select Object tool Alt -F4 
Select Line tool Alt -F5 
Switch to Object mode Esc 
Send form-feed to printer Shift Ctrl-+ 

r 
r 

I 
Keyboard shortcuts for text windows i 

(text mode) ~ 

Delete previous character 
Delete next character 
Delete block (when block selected) 

Delete line 
Move to beginning of line 
Move to end of line 
Move to previous word 
Move to next word 
Hard space 
Undo 
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Backspace 
Delete 
Backspace, Delete 
Ctrl-Delete, F8 
Shift-" 
Shift -JE 
Ctrl- " 
Ctrl-JE 
Ctrl-Space 
Undo 

Keyboard Shortcuts 
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Page break 
Define style 1_10 
Apply style 1_10 

Ctrl-Return 
Shift Ctrl-F1_F10 
Shift-F1 ... F10 

] Keyboard shorlcuts fOff Microspacing 

J 

j 

j 

] 

J 

J 

Move text left 
Move text up 
Move text right 
Move text down 
Increase space after character 
Increase space before character 
Decrease space after character 
Decrease space before character 
Reset microspacing in block 
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Shift Ctrl- .. 
Shift Ctrl-;o! 
Shift Ctrl-JE 
Shift Ctrl-0 
Shift Ctrl-Ins 
Shift Ctrl-Space 
Shift Ctrl-Delete 
Shift Ctrl-Backspace 
Shift Ctrl-ClrHome 
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AppendixB 
Technical Support 

Papyrus Gold comes with 30 days free technical support, starting from the 
date of registration; therefore you should send in your registration card 
quickly. Technical support is available by telephone during our Technical 
Support Hour, by letter or by fax. 

Should you wish to receive extended technical support, please complete 
the relevant sections on the registration card, indicating whether you 
would like to take up the Silver or the Gold service. 

In addition to your name, address and postcode (very important for UK 
customers), we need payment details before we can accept your extended 
registration. You can pay by credit card (Mastercard, Eurocard, Access, 
Visa etc.), UK debit card (Switch, Connect etc.), Eurocheque, UK cheque or 
Postal Order. 

You may have already registered another HiSoft product under our Gold 
or Silver service; in this case, there is no need to fill out the payment 
section. 
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1-1 Index 

] .A biggest character 148 
I binding, sort pages for 108 

about papyrus 95 bit image 194 
active bitmap fonts 18, 29 

] dialog 200 
I window 200 block 

always get style 139 hide 111 

amending index entries 171 into srch/rplc string 129 

1 
mark font 122 

anchor 193 mark search string 130 
for new pictures 193 marking 111 
movement 72 block mark 118 

j 
object in text 193 block pointer 43 
position 72 
tables 74 block, of text 111 
text wrap 73 bold 92 

1 
anchors 70 bring to front, object 197 
anonymous display of fields 166 
apply font 123 .C 

) 
apply text style 81 

cache size 218, 219 Arabic 91 
arrow pointer 43 Calamus fonts 19 

ascii calculation 186 

j export 100 form 161 
, 

file 114 capitalisation check 213 
load 96 cell 
save 97 calculation, See calculation 

j text export 208 colour 182 
text import 207 fill 182 

aspect ratio (font) 32 joining 183 

assign master page 146 offsets 182 

1 orienta tion 183 asterisk (in title bar) 27 selection 180 
attributes 46,60,70 splitting 184 

position 192 style 182 

j text flow 192 type 185 
auto scroll 204 centre justification 88 
autosave 97, 215 centre tab 90 

) 
character .8 baseline, on/off 203 

special, See special characters 
backup 216 clipboard 112, 195 

J backward lines 91 disk based 113, 114 
baseline gem 113,114 

on/off 203 memory resident 113 

beep, why? 118 papyrus 113 

J papyrus/gem selection 206, 209 
beginning of line 25 pro's & con's 115 
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desktop 39, 217 r text 112 
close document 27, 97 desktop preferences 11 
colour 190 dialog r cell 182 activation 200 

printer 223 activation display 205 
setup 226 button options 205 r text 82,139 cycle 200 

column left/right mouse use 205 
deleting 145 options 204 
number of 103 show keyboard shortcuts 204 

r table 178 dictionary 
width 181 close 212 

column break 135 control 210 
comma separated 165 creation 211 

I compatibility 228 list 210 
open 212 CONTENT.PAP86,157 
save 212 ~onverse index entry 171 dictionary, language 133 

I copying DIF file 167 
master page 146 document 88 picture 196 

asterisk 27 table 184 
autosave 215 I text 116 
backup 216 creating a tag 76 
close 27 

cropping, picture 196 creation 21, 40, 167 
current date 64 end (go to) 25 I cursor 21 form 157 
cursor keys 23 index 172 

master page, See master page 
cut text 116 navigation 22, 91 I cycle window 200 open 28 

plain 155 .D print 167 

i register new name 26 
data file 164 report 167 

data file organisation 165 save 26, 51 
serial 166 

data format 164 tags 86 
J date 154 template 156 

dBase file 167 top (go to) 25 

decimal tab 90 type 155 

I default index option 172 draw pointer 44 

default template 156 .E defining a tag 76 

1 deleting edit menu 110 
document 100 column break 135 
frames 70 concepts 111, 112 
line 92 copy ruler 117 

l master page 146 copy style 117 
picture 196 copy text 116 
text 117 cut text 116 

deleting column 145 delete text 117 

L designing a form 158 find next 132 
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font layout 126 multiple 85 
font panel 119 name 164 

I 1 
group lines 136 organisation 165 
page break 135 file importing 98 
paste ruler 118 
paste style 117 

file menu 95 

1 
paste text 116 

close document 97,102 

, search and replace 128 
delete document 100 

select all 118 
export 100 

spellcheck next 135 
insert 98 

] spelling checker 133 
new document 96 

I undo/redo 115 
open document 96 

ungroup lines 136 
page layout 101 

why the beep 118 
paper format 103 

] editting frames 69 
print 105 

effects, text 82 
quit 110 
revert to saved 98 

end of document 25 save document 97 

] 
end of line 25 save document as ... 98 

error diagnosis 118 fill 65 

error reporting 
cell 182 

speedo229 
colour 190 

] escape codes 224 
pattern 189 

exceptions, text style 81 
style 189 
transparent 190 

expert mode 217 fill justification 88 

] export film output 107 
document 100 find 54 
formats 100 find next 132 
picture 100 

] text formats 100 
finger pointer 44 
flow order 145 .F folio, See page 
font 18, 29, 119 

] family (font) 29 add a 124, 126 

family management 33 apply 123 

field 
aspect 121 

3 anonymous display 166 
aspect ratio 32 

data 163 
bitmap 18 

format 164 
Calamus 19 

inserting 165 
character set 126 
control buttons 121 

] name 165, 166 
named 166 

example 120 

navigation 166 
families 29, 123, 124, 125, 126 

next 166 
adding 34 

J 
number 166 

management 33 

order 157 
naming 35 

figures, table of 87 
removing 34 

identities 123, 126 

file layout 126 

] data 164 
load 123, 124, 126 

export formats 100 
management 30, 33 

exporting 100 
marking 122 

J 
import formats 98 

organisation 123 

importing 99 
panel 29 

index 172 
show checkbox 31 
styles 31 
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paths 228 customising 92 r 
point size 31 delete line 92 
removal 125 italic 92 r selection 120 light 92 
Signum! 18 outline 92 
size 31, 121 redraw screen 92 
Speedo 18 subscript 92 r style 121 superscript 92 
styles 31 underline 92 
tag 82 
widthlheight 121 .G I widthlheight ratio 32 

FontGDOS 19 GDOS19 
footer 62, 102 GEM fonts 18, 201 

master page 146 generate a new page for each record I suppress 141 167 
footnote 153 

get style 139 
numbering 141 
separator 142 getting started 1 I for new pictures 193 grabber pointer 44 

foreign database formats 167 graphic 

form auto removal 215 

I calculations 161 graphics importing 99 
design 158 group lines 136 
document 157 group objects 118 
editing 158 I field order 157 .H filling 159 
open 159 hard hyphen 152 preset text 158 I printing 160 hard space 151 
processing 160 header 62, 102 
reset 161 master page 146 
saving 160 suppress 141 I tables 161 Hebrew 91 
text entry 159 horizontal microspacing 149 

formatting 52 hyphen 
cell 185 I data 164 hard 152 

frame 
soft 151, 153 

creating 45 
hyphenation 83, 150 

edit 69 hard space 151 I justification 88 language 150 

master page 144 special text control 150 

moving 69 .1 I object 74 
resizing 69 
selection 70 I-beam pointer 43 
text 74 icons 69 
text creation 45 icons on ruler 21 t free object 70 img export 100 

full justification 88 import 44 
function keys 10, 92, 138 picture 59 L bold 92 tags 77 

Page ill Papyrus Gold Index L 



1 text control 206 beginning of line 25 
import formats 98, 99 bold 92 

import, See insert close document 27 

] column 181 
indent, ruler 75 customising, function keys 92 
index 169 delete 70 

amended 171 delete line 92 

1 converse 171 document 167 
creation 172 end of document 25 
default 157,172 end of line 25 
entry 170 font panel 29 

j include text style 171 footnote 153 
level 170 form 159 
marking entries 170 function keys 92 
options 171 index 172 

] page numbering 171 index entry 170 , 
principa1170,171 italic 92 
range 175 light 92 
sort order 170 microspacing 149 

J style 174 moving the cursor 24 
sub-entry 170, 174 open document 28 
tabbed 175 outline 92 
tag 175 page down (cursor) 24 

J tags 175 page down (view) 25 
title 171 page up (cursor) 24 

- INDEX.PAP 157, 175 page up (view) 25 
insert shortcuts 9, 14, 24 

] document 98 style 92 

field 165 subscript 92 

graphic formats 99 superscript 92 

picture 98, 195 table 177, 179 

j text formats 98 top of document 25 

installation underline 92 
word left 25 

floppy disk 4 word right 25 

j getting started 1 zoom 198 
hard disk 3 

keyboard shortcuts 231 introduction 7 
system requirements 2 edit menu 231 

file menu 231 

j invisible character display 203 
microspacing 237 

italic 92, 138 miscellaneous 235 
object menu 233 

j .J options menu 234 
special menu 233 

joining cells 183 style menu 232 

joker 55 text menu 232 
text windows 

j about 131 
all modes 236 

example uses 131 text mode 236 
justification 88 underline on/off 204 
justification, last line 148 zoom menu 234 

j .K 
J 

keyboard 
basics 22, 23 
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.L menu 95 r 
language, hyphenation 150 

always style 
get style 139 

last line justification 148 edit 110 r-
laterally inverted writing 91 column break 135 

copy ruler 117 
left justification 88 copy style 117 
left tab 90 copy text 116 r left, microspacing 149 cut text 116 

delete text 117 
light 92, 138 find next 132 

line font layout 126 

r beginning (go to) 25 
font panel 119 
group lines 136 

creation 74 page break 135 
delete 92 paste ruler 118 
end (go to) 25 paste style 117 

I endings 189 paste text 116 
footnote 142 search and replace 128 

laterally inverted 91 select all 118 

reversed 91 spellcheck next 135 

I spacing 91,147 
spelling checker 133 
undo/redo 115 

style 181, 188 ungroup lines 136 
tool 74 why the beep 118 

file 95 

J .M close document 97, 102 
delete document 100 

mail merge 163 export 100 
insert 98 

managing fonts 30, 33 new document 96 I margin open document 96 
page layout 101 

display 202 paper format 103 
ruler 75 print 105 I table 178 quit 110 
text 101 revert to saved 98 
text in paragraphs 22 save document 97 

mark save document as ... 98 

block 130 options 199 I compatibility 228 
font 122 cycle dialog 200 
search string 130 cycle window ZOO 
whole document 118 dialogZ04 

J master page 101,143 font paths 228 

assigning 146 import/export Z06 

columns 145 memory 217 
miscellaneous 215 

copy 146 mouse action 203 I delete 146 printer 219 
edit 144 ruler199 
footer 146 save options 229 
frames 144 screen display 200 I header 146 spellchecker 209 

new 144 vertical ruler 199 

text flow 145 style 137 
colour 139 

L memory function keys 138 
configuration 217 get style 139 
maximum 218 italic 138 
operating system 218 light 138 
printer buffer 219 normal 137, 138 1. outline 138 
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] 

] 

J 

J 

subscript 138 
underline 138 

text 119 
menu bar 95 
metafile 194 
metafile export 100 
microspacing 

absolute 150 
horizontal 149 
keyboard 149 
relative 150 
vertical 149 

mirror left pages 102 
miscellaneous 

options 215 
mouse 43 

actions 203 
auto scroll document 204 
basics 23 
position on rulers 204 

mouse options 203 
multiple frame selection 70 

name file 164 
named display of fields 166 
naming a field 166 
naming font families 35 
navigating the document 22 
new document 96 
_NEW.PAP 156 
normal 137, 138 
numbering 

field 166 
footnote 141 
index 171 
page 154 
pages 141 .0 

object 69 
anchor 70 
anchor, See al/chor 
anchor/symbol display 203 
attributes, See attribl/tes 
bring to front 197 
colour 190 
coordinates 144 
fill pa ttem 189 
frame 74 

Index 

frame display 202 
line style 188 
linking 70 
orientation 191 
position 192 
put to back 197 
redraws 202 
selection 118 
show only on screen 193 
wrap around 192 

object height grows with text 193 
object menu 188 
offset 

above 147 
below 147 
biggest character 148 
cell 182 
footnote 142, 153 
page 140 
paragraph 57, 147 

one entry per line 164 
open document 28, 96 
opening a form 159 
options menu 199 

compatibility 228 
cycle dialog 200 
cycle window 200 
c1ialog 204 
font paths 228 
import/export 206 
memory 217 
miscellaneous 215 
mouse actions 203 
printer 219 
ruler 199 
save options 229 
screen display 200 
spellchecker 209 
vertical ruler 199 

orientation 191 
cells 183 

outline 92, 138 
outline fonts 29 

page 
break 135 
current 64 
footer 141 
header 141 
index 171 
layout 41, 101, 144 
master 143 
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move down (cursor) 24 margins 223 r 
move down (view) 25 mirror page 107 
move up (cursor) 24 output queue 109 
move up (view) 25 pages per sheet 108 r new page per record 166 paper type 223 
number 83,84,86,91,154 quality 106, 221 
numbering 141 resolution 221 
offsets 140 sort for binding 108 r paper format 40, 103 printer 
adjustment 104 background selection 229 
borders 104 buffer size 219 
delete 104 colour 223 r label spacing 104 colour setup 226 
new 103 configuration 219 

paper type 106 control sequences 227 

I papyrus driver 
colour codes 223, 226 environment 216 control 220 

memory 218 control codes 224 
settings 216 control sequences 227 i P APYRUS.IMG 93 escape codes 224 

paragraph 22, 46, 75 margin control 223 
quality 221 

end 22 remarks 221 
footnote 153 resolu lion 221 I justification 88 feed 106 
offset 147 file output 222 
offsets 57 film output 223 
ruler 199 font 222 I tag, See tag form feed 107 

paste text 116 graphic output mode 229 
pattern, fill 189 high resolution 223 

I picture installation 219 
margins 223 auto removal 215 memory 219 copy 196 paper 106 crop 196 paper control 223 I delete 196 port 222 import 195 port control 229 

importing 59 quality 106 screen options 202 selection 106 ! size 194 setup 219 
window 194 special controls 107 

place, picture 196 printing 66, 105 
plain document 155 controls 105 I point size 31, 82 copies, number of 105 
preferences document 167 

desktop 11 form 160 

I ruler 75 output selection 106 
screen display 47, 75 pages, which 105 

principal index entry 171 resolution 198 
to file 106 

print processing a form 160 1 as gem image file 222 
proportional resizing 60,193 invert page 108 

job 109 put to back 197 
magnification 108 [ 
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1 .0 saving a form 160 

quit papyrus 110 
scrap files 114 

1 
screen display 200 .R display units 201 

font mode 201 

range, index 175 
object handles 201 

1 
optimisation 201 

record, new page per 166 options 202 

redo operation 115 screen redraw 92 
redraw screen 92 search and replace 128 

) register new name 26 control codes 131 
i home 130 registration card 2 

replace string 129 
ignore case 130 
joker 131 

j report document 167 replace 132 
I I resetting a form 161 replace all 132 

resizing, proportional 60, 193 replace and continue 132 

restore old document 98 
search 132 

J special characters 131 
revert to saved 98 to start of document 130 
rich text format 77 whole word 130 

1 
right justification 88 search string 
right tab 90 joker 129 

row, table 178 special characters 129 

rtf 
select 

I export 100 
frames 70 

file 114 
multiple 70 

load 96 select all 118 

save 97 objects 118 

] ruler 21, 75, 199 serial letter 166 

" copy 117 set master page 146 
icons 21 setup, zoom 198 
indents 75 show only on screen 193 

, ] margins 75 shredder 10 
paste 118 
preferences 75 Signum! fonts 18 
units 201 signum2! fonts 201 

] size, pictures 194 .S soft hyphen 151, 153 
sort order, index 170 

save 

~ options 229 
spacing 148 

above 147 
settings 216 below 147 
work environment 216 
work settings 229 

hard 151 

~ line 91 
save as 26 micro, See microspacillg 
save document 26, 97 paragraph 147 
save document as ... 98 reset 91 

J save text tags 83 

autosave 215 special characters 154 
file backup 216 ascii map 127 

j save, automatic 97 date 64, 154 
hard hyphen 152 
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hard space 151 
hypenation 150 
insertion into text 126 
keyboard map 127 
page 154 
page number 64 
soft hyphen 151, 153 
time 154 

special menu 140 
special text control 150 
speedo 

cache 218, 219 
error reports on/off 229 

Speedo fonts 18 
SpeedoGDOS 20,29 
spellcheck next 135 
spellchecker 

dictionaries 210 
intelliview 209 
mode 209 

audible notice 210 
mouse mode 210 
permanent check 210 
show suspicious words 210 

options 209, 212 
spelling checker 133 

dictionary 133 
example use 133 
similarity search 134 

splitting cells 184 
start of line 25 
stationery, See template 
style 

bold 92 
colour 190 
copy 117 
fill 189 
font 31 
index 174 
index entry 171 
italic 92 
keyboard 92 
light 92 
line 181, 188 
outline 92 
paste 117 
subscript 92 
superscript 92 
table of contents 86 
underline 92 

style menu 137 
always get style 139 
colour 139 
function keys 138 

Page x 

get style 139 
italic 138 
light 138 
normal 137, 138 
outline 138 
subSCript 138 
underline 138 

sub-entry, index 174 
subscript 92, 138 
Superbase 168 
superscript 92 
suppressing headers and footers 141 
switches, text style 82 
system requirements 2 .1 
tab 89 

centre 90 
decimal 90 
index 175 
left 90 
right 90 
text 178 

table 56,176 
cell, See cell 
copy 184 
generation 177 
margins 178 
style 181 
tabbed 178 
text en try 179 
to text 184 
type 177 

table of contents 
default 157 
entry 84 
generating 84 
multiple file 85 
overview 83 
page number 83, 84 
page numbers 86 
style 86 
tag 83 

table of figures 87 
tables 

form 161 
tag 46, 50, 75 

apply style 81 
colour 82 
defining 76, 81 
delete 81 
document 86 
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1 effects 82 text edit 74 
hyphenation 83 text frame 74 
import 77 top of document 25 

1 include font 82 turtles, See shredder 
index 175 
mark 81 tutorial 37 

name 81 Twist 168 

,1 point size 82 
selection 77 .Ul spacing 83 
table of contents 83, 87 underline 92, 138 

] text style exceptions 81 
! text switches 82 

undo operation 115 

technical support 95, 239 ungroup lines 136 

template unite cells 183 

] creation 156 units 201 
default 156 user defined format 165 
document 156 vector graphic 194 

text 
j alignment 199 

vertical microspacing 149 

block 111 
vertical ruler 75, 199 

colour 82 

J 
effects 82 .V, W, X, Y, Z 

\ frame 45, 74 
style 53 view 

text cursor 21 move down 25 

J text entry in form 159 move up 25 

text flow 145,192 
widthlheight ratio 32 

object height grows with text 193 wildcard 55 

) 
proportional resizing 193 window 
show only on screen 193 activation 200 
text ignores wraparound 193 cycle 200 
wrap around 192 gadgets 23 

, 
1 

text ignores wraparound 193 picture 194 
, text importing 98 word 

text margins 101 move left 25 

text menu 119 
move right 25 

] text style 
wrap around 192 

italic 138 
wrap-around 60 

light 138 zoom 42,194,197 

] 
normal 137, 138 printer resolution 198 

outline 138 setup 198 

subscript 138 
underline 138 

] 
text style exceptions 81 

i text style switches 82 
text wrap 70 
text-to-table 177 

J time 154 
toolbox 9, 42, 69 

frame edit 69 

J 
line 74 
object frame 74 
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